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Chapter 1:

Installation and Configuration

Files and Directories

File Naming Conventions

The following file naming conventions have been adopted for the various files dis-
tributed with and used by Dyalog APL/W.

Extension

Description

.DWS

Dyalog APL Workspace

.DSE

Dyalog APL Session

DCF!

Dyalog APL Component File

DXV

Dyalog APL External Variable

.DIN

Dyalog APL Input Table

.DOT

Dyalog APL Output Table

.DFT

Dyalog APL Format File

.DXF

Dyalog APL Transfer File

.DLF

Dyalog APL Session Log File

.dyalog

Dyalog APL SALT file

dyapp

Dyalog APL SALT application file

INote that DCF has become associated with a certain type of media file and is recognised as such

by Windows.
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Unicode and Classic Editions

Dyalog APL continues to be available in two separate editions; Unicode and
Classic.

e The Unicode edition is intended for users who need to develop Unicode
applications now, and are prepared to make the necessary (usually small)
changes to existing applications in order to support new Unicode character
types.

e The Classic edition is intended for customers who want to take advantage
of other product enhancements, but do not wish to use Unicode at this time.

The two different editions are maintained from the same source code, and every effort
will be made to ensure that they are identical except for the handling of character
arrays, and the transfer of data into and out of the workspace.
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APL Fonts

Unicode Edition

The default font for the Unicode Edition is APL385 Unicode! which is a TrueType
font and is installed as part of Dyalog APL. APL385 Unicode is the font used to print
APL characters in this manual. In principle, you may use any other Unicode font that
includes the APL symbols, such as Arial Unicode MS (available from Microsoft).

Classic Edition

In the Classic Edition, there are two types of APL font provided; bitmap (screen) and
TrueType. There are also two different layouts, which referred to as Std and A!/z.

The bitmap fonts are designed for the screen alone and are named Dyalog Std and
Dyalog Alt. The TrueType fonts have a traditional 274 1-style italic appearance and
are named Dyalog Std TT and Dyalog Alt TT!.

The Std layout, which was the standard layout for Versions of Dyalog APL up to Ver-
sion 10.1 contains the APL underscored alphabet A-Z. The underscored alphabet is
a deprecated feature and is only supported in this Version of Dyalog APL for
backwards compatibility.

The Alt layout, which replaced the Std layout as the standard layout for Version 12.0
Classic Edition onwards, does not have the underscored alphabet, but contains addi-
tional National Language characters in their place. Note that the extra National Lan-
guage symbols share the same [JAV positions with the underscored alphabet. If, for
example, you switch from the Std font layout to the alternative one, you will see the
symbol A (A-acute) instead of the symbol A (A-underscore).

You may use either a bitmap font or a TrueType font in your APL session (see "Ses-
sion Operations " on page 124 for details). You MUST use a TrueType font for print-
ing APL functions.

IThe Dyalog Std TT, Dyalog Alt TT, and APL385 Unicode fonts are the copyright
of Adrian Smith.
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Interoperability

Introduction

Workspaces and component files are stored on disk in a binary format (illegible to
text editors). This format differs between machine architectures and among versions
of Dyalog. For example a file component written by a PC may well have an internal
format that is different from one written by a UNIX machine. Similarly, a workspace
saved from Dyalog Version 13.2 will differ internally from one saved by a previous
version of Dyalog APL.

It is convenient for versions of Dyalog APL running on different platforms to be able
to interoperate by sharing workspaces and component files. From Version 11.0, com-
ponent files and workspaces can generally be shared between Dyalog interpreters run-
ning on different platforms. However, this is not always possible, for example:

e Component files created by Version 10.1 can often not be shared across plat-
forms, even when used by later versions.

e Small-span (32-bit) component files become read-only when opened on a
different architecture from that on which they were created.

Note however that the system function JF COPY can be used to make a logically iden-
tical copy of an old file, which is fully inter-operable.

The following sections describe other limitations in inter-operability:

Code

Code which is saved in workspaces, or embedded within [JORs stored in component
files, can generally only be read by the version which saved them and later versions
of the interpreter. In the case of workspaces, a load (or copy) into an older version
would fail with the message:

this WS requires a later version of the interpreter.

Every time a [JOR object is read by a Version later than that which created it, time
may be spent in converting the internal representation into the latest form. Dyalog
recommends that [JOR should not be used as a mechanism for sharing code or objects
between different versions of APL

"Ordinary" Arrays

With the exception of the Unicode restrictions described in the following par-
agraphs, Dyalog APL provides inter-operability for arrays which only contain
(nested) character and numeric data. Such arrays can be stored in component files - or
transmitted using TCPSocket objects and Conga connections, and shared between
all versions and across all platforms.
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As mentioned in the introduction, full cross-platform interoperability of component
files is only available for large-span component files (see the following section), and
for small-span component files created by Version 11.0 or later.

32 vs. 64-bit Component Files

Large-span (64-bit-addressing) component files are inaccessible to versions of the
interpreter that pre-dated their introduction (versions earlier than 10.1).

The second item in the right argument of JF CREATE determines the addressing type
ofthe file.

‘small'fcreate 1 32 A create small-span file.
‘large'[dfcreate 1 64 A create large-span file.

If the second item is missing, the file type defaults to 64-bit-addressing. In versions
prior to 12.0, the default was 32-bit-addressing.

Note that small-span (32-bit-addressing) component files cannot contain Unicode
data. Unicode editions of Dyalog APL can only write character data which would be
readable by a Classic edition (consisting of elements of [JAV).

External Variables

External variables are implemented as small-span (32-bit-addressing) component
files, and subject to the same restrictions as these files. External variables are unlikely
to be developed further; Dyalog recommends that applications which use them
should switch to using mapped files or traditional component files. Please contact
Dyalog if you need further advice on this topic.

32 vs. 64-bit Interpreters

From Dyalog APL Version 11.0 onwards, there are two separate versions of programs
for 32-bit and 64-bit machine architectures (the 32-bit versions will also run on 64-
bit machines running 64-bit operating systems). There is complete inter-operability
between 32- and 64-bit interpreters, except that 32-bit interpreters are unable to work
with arrays or workspaces greater than 2GB in size.

Unicode vs. Classic Editions

From Version 12.0 onwards, a Unicode edition is available, which is able to work
with the entire Unicode character set. Classic editions (a term which includes ver-
sions prior to 12.0) are limited to the 256 characters defined in the atomic vector,

OAV).
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Component files have a Unicode property. When this is enabled, all characters will
be written as Unicode data to the file. The Unicode property is always off for small-
span (32-bit addressing) files, which may not contain Unicode data. For large-span
(64-bit addressing) component files, the Unicode property is set on by Unicode Edi-
tions and off by Classic Editions, by default. The Unicode property can subsequently
be toggled on and off using JF PROPS.

When a Unicode edition writes to a component file which may not contain Unicode
data, character data is mapped using [JAVU, and can therefore be read without prob-
lems by Classic editions.

A TRANSLATION ERROR will occurifa Unicode edition writes to a non-Unicode
component (that is either a 32-bit file, or a 64-bit file when the Unicode property is
currently off) if the data being written contains characters which are not in JAVU.

Likewise, a Classic edition (Version 12.0 or later) will issue a TRANSLATION
ERROR ifit attempts to read a component containing Unicode data not in JAVU from
a component file. Version 11.0 cannot read components containing Unicode data
and issues a NONCE ERROR.

A TRANSLATION ERROR will also be issued when a Classic edition ) LOADs or )
COPYs a workspace containing Unicode data which cannot be mapped to [JAV using
the JAVU in the recipient workspace.

TCPSocket objects have an APL property which corresponds to the Unicode prop-
erty of a file, if this is set to Class i c (the default) the data in the socket will be
restricted to [JAV, if Unicode it will contain Unicode character data. As a result,
TRANSLATION ERRORSs can occur on transmission or reception in the same way as
when updating or reading a file component.

AVU changes

The implementation of the function Right in Version 13.0 led to the discovery that
0AVU incorrectly defined JAV[59+0I0] as x (QUCS 164)rather than + (Right
Tack,[JUCS 8866). This error has been corrected in the default JAVU and in work-
space AVU. dws. If you are operating in a mixed Unicode/Classic environment, this
error will have caused earlier Classic editions to map JAV[59+0I0] to the wrong
Unicode character (x). This may cause TRANSLATION ERRORs when a Version
13.0 Classic system attempts to read the data, as it will not be able to represent x in
the Atomic Vector.
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DECFs and Complex numbers

Version 13.0 introduced two new data types; DECFs and Complex numbers.
Attempts to read components of these types in earlier interpreters will result in a
DOMAIN ERROR.

Very large array components

The maximum size (in bytes) of a component written by Version 12.1 and prior is
2GB. This is the size of the component as held on disk which may be different than
the size reported by JSIZE. In Version 13.0 the maximum size of a component
written by a 64-bit interpreter is 4GB. From Version 13.2 onwards, the limit on the
size of arrays or components is so large that for most practical purposes, there is effec-
tively no limit.

An attempt to read a component greater than 2GB in 32-bit interpreters will result in
aWS FULL. An attempt to read such a component in 64-bit Versions 12.0 and 12.1
patched after 1st April 2011 will result in a NONCE ERROR; earlier patches generate
aFILE COMPONENT DAMAGED error.

File Journaling

Version 12.0 introduced File Journaling (level 1), and 12.1 added journaling levels 2
and 3 and checksumming. Versions earlier than 12.0 cannot tie files which have any
form of journaling or checksumming enabled. Version 12.0 cannot tie files with jour-
naling levels greater than 1, or checksumming enabled. Attempting to tie such files
will resultina FILE NAME ERROR. Files can be shared with earlier versions by
using JFPROPS to amend the journaling and checksumming levels.

TCPSockets

TCPSockets used to communicate between differing versions of Dyalog APL are sub-
ject to similar limitations to those described above for component files. In particular
TCPSockets with 'Style' 'APL' will only be able to pass arrays that are sup-
ported by both versions.

Auxiliary Processors

A Dyalog APL process is restricted to starting an AP of exactly the same architecture.
In other words, the AP must share the same word-width and byte-ordering as its inter-
preter process.

Session Files

Session (.dse) files may only be used on the platform on which they were created and
saved.
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The APL Command Line

The command line for Dyalog APL is as follows:

dyalog [ options | [ debug ][ file ] [param] [param] [param]...

where:
[options]
-X No [LX execution on workspace loads.
-a Start in USER mode.
-b Suppress the banner in the Session..
-Fxx Default to creating xx-bit files (where xx is 32 or 64).
¢ Disable the Session. This option is ignored in Windows
versions.
Don't quit APL on error (used when piping input into
4 ApL).
. Signifies a command-line comment. All characters to the
right are ignored.
[debug]
-Dc  Check workspace integrity after every callback function.
-Dw  Check workspace integrity on return to session input.
D Check workspace integrity after every line of APL
(application will run slowly as a result)
-DK  Log session keystrokes in (binary) file APLLOG.
[file]
The name of a Dyalog APL workspace to be loaded. Unless
specified, the file extension .DWS is assumed.
[param]
A parameter name followed by an equals sign (=) and a value.
Note that the parameter name may be one of the standard APL
parameters described below, or a name and value of your own
choosing (see Object Reference, GetEnvironment method).
Examples:

c:\program files\..\dyalog.exe myapp maxws=64000
c:\program files\..\dyalog.exe session file=special.dse

c:\program files\..\dyalog.exe myapp aplt=mytrans.dot myparam=42
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APL Exit Codes

When APL or a bound .EXE terminates, it returns an exit code to the calling envi-
ronment. If APL is started from a desktop icon, the return code is ignored. However,
if APL is started from a script (UNIX) or a command processor, the exit code is avail-
able and may be used to determine whether or not to continue with other processing
tasks. The return codes are:

0 successful JOFF, )OFF, )CONTINUE, graphical exit from GUI

APL failed tostart. This will occur if there was a failure to read a
1 translate file, there is insufficient memory, or a critical parameter is
incorrectly specified or missing.

APL was terminated by SIGHUP or SIGTERM (UNIX) or in response
to a QUIT WINDOWS request. APL has done a clean exit.

3 APL issued a syserror.

Runtime violation. This occurs if a runtime application attempts to
4 read input from the Session. Only a development version has a
Session.

Notes:

Under UNIX exit codes greater than 127 indicates (127+signal number) of the
untrapped signal which caused the process to terminate.

APL applications can generate a custom return code by specifying an integer value
to the right of JOF F. Dyalog recommends using values greater than 10 for this pur-
pose.

Configuration Parameters

Introduction

Dyalog APL/W is customised using a set of configuration parameters which are
defined in a registry folder.

In addition, parameters may be specified as environment variables or may be spec-
ified on the APL command line.

Furthermore, you are not limited to the set of parameters employed by APL itselfas
you may add parameters of your own choosing.

Although for clarity parameter names are given here in mixed case, they are case-inde-
pendent under Windows. Under Unix and Linux, Dyalog parameters must be spec-
ified as environment variables and must be named entirely in upper-case.
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Setting Parameter Values
You can change the parameters in 4 ways:

e Using the Configuration dialog box that is obtained by selecting Configure
from the Options menu on the Dyalog APL/W session. See "The Con-
figuration Dialog Box" on page 127 for details.

e By directly editing the Windows Registry using REGEDIT.EXE or
REGEDIT32.EXE.

e By defining the parameters as environment variables.

¢ By defining the parameters on the APL command line.

This scheme provides a great deal of flexibility, and a system whereby you can over-
ride one setting with another. For example, you can define your normal workspace
size (maxws) in your . INT file or Registry, but override it with a new value specified
on the APL command line. The way this is done is described in the following sec-
tion.

How APL Obtains Parameter Values
When Dyalog APL/W requires the value of a parameter, it uses the following rules.

1. If the parameter is defined on the APL command line, this value is used.

2. Otherwise, APL looks for an environment variable of the same name and
uses this value.

3. Otherwise, if the parameter in question is inifile, the default value of
Software\Dyalog\Dyalog APL/W 13.0 Unicode (Unicode Edi-
tion) or Software\Dyalog\Dyalog APL/W 13.0 Classic (Classic
Edition) is assumed.

4. Otherwise, if the parameter in question is dyalog, the name of the directory
from which the Dyalog APL program was loaded is assumed.

5. The value of any other parameter is obtained from the registry folder
defined by the value of inifile.

Note that the value of a parameter obtained by the GetEnvironment method (see
Object Reference) uses exactly the same set of rules.

The following section details those parameters that are implemented by Registry
Values in the top-level folder identified by inifile. Values that are implemented in
sub-folders are mainly internal and are not described in detail here. However, any
Value that is maintained via a configuration dialog box will be named and
described in the documentation for that dialog box in Chapter 2.
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APL_CODE_E_MAGNITUDE

Version 13.0 introduced decimal floating point numbers which have greater pre-
cision than IEEE floating point numbers. This increased the maximum allowable
print precision from 17 to 34 and this had the side effect of changing the way
numbers in function bodies are descanned!. For example, the number one sextillion
(1021) in a function is descanned by Version 12.1 as 1E21 and by Version 13.0 as
1000000000000000000000.

Note that only numbers X in the range (10%x17) < X <(10*34) are affected.

Whilst this change has no other deleterious effect, it means that code that contains
such numbers is harder to read, and the result of JCR (and other character rep-
resentations) of the same function may have changed between Version 12.1 and Ver-
sion 13.0 causing undesired affects in code management systems.

The APL_CODE_E_MAGNITUDE parameter allows the user to choose between
current (Version 13.0 and onwards) and earlier behaviour.

Ifthe APL_CODE_E MAGNITUDE parameter is undefined or set to 0 (the
default), numbers are descanned and displayed as normal.

IfAPL_CODE_E_MAGNITUDE is ~1, numbers greater than or equal to 1017 will
be displayed using exponential format, as in Version 12.1.

The effect of setting this parameter to any other value is undefined.

1Descanning refers to the internal process used to convert the internal representation of APL code
into a character array. For numbers in function statements, this process uses the maximum value of

Print Precision.
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APL_COMPLEX_AS_V12

Support for Complex Numbers means that some functions produce different results
from previous Versions of Dyalog APL. fAPL_COMPLEX_AS V12issetto I the
behaviour of code developed using Version 12.1 or earlier will be unchanged; in par-
ticular:

e Power (*) and logarithm (®) do not produce Complex Numbers as results
from non-complex arguments.

e [VFI will not honour "J" or "j" as part of a number.

e ~4oY will be evaluated as (~ 1+Y*2)%0.5, which is positive for negative
real arguments.

IfAPL_COMPLEX_AS V12 is set to any other value or is not set at all then code
developed using version 12.1 or earlier may now generate Complex Numbers.

Note that this feature is provided to simplify the transition of older code to Version

13.0. It does not prevent the generation and use of Complex Numbers using features
new to 13.0 (such as explicitly specifying a Complex Number literal), and it will be
removed in a future release of Dyalog APL.

APL_FCREATE_PROPS_C

This parameter specifies the default chksum level for newly-created component files.
Ifunspecified, the default checksum level is 1.

APL_FCREATE_PROPS_J

This parameter specifies the default journaling level for newly-created component
files. If unspecified, the default journaling level is 1.
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APL_FAST_FCHK

This parameter specifies whether Dyalog APL should optimise [JF CHK by allowing
it to reliably determine whether a component file had been properly untied and there-
fore does not need to be checked (this is overridable using the [JF CHK option 'force').

Optimising [JF CHK in this way has a performance impact on JFUNTIE and it is rec-
ommended this optimisation is switched off if your application frequently ties and
unties files.

Note: this only affects component files with journaling enabled.

The values of the parameter are:

0 |Do not optimise OF CHK (optimise OFUNTIE instead)
1 |Optimise OF CHK

The default values of the parameter reflect the existing behaviour in Version 12.1: 0
on Windows and 1 on Linux / AIX. On Windows, setting the value 1 has no effect.

APL_EXTERN_DECF

By default, arrays of type DECF (128-bit decimal) will be passed unchanged to Aux-
iliary Processors, and to DLLs using A or Z argument types. However, if APL_
EXTERN_DECEF is set to 0, DECF arrays will be converted to DOUBLE before
they are passed to AP's and DLL's. This will allow user-written Auxiliary Processors
and DLLs to continue to work at least temporarily while users determine how to
change their code to cater for the new data type. This parameter will not be supported
beyond Version 13.0.
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AplCoreName

This parameter may be a string or a Boolean value. Ifit is a string, it specifies the

directory and name of the file in which the aplcore should be saved. The optional
wild-card character (*) is replaced by a unique string when the file is written. For
example:

APLCORENAME=C:\mycores\aplcore*.dat

If AplCoreName is set to Boolean 0, the generation of an aplcore file is suppressed
and the application simply terminates with an exit code of 3.

aplk

(Classic Edition Only)

This parameter specifies the name of your Input Translate Table, which defines your
keyboard layout. The keyboard combo in the Configure dialog box displays all the
files with the .DIN extension in the APLKEY S sub-directory. You may choose any
one of the supplied tables, and you may add your own to the directory. Note that the
FILE.DIN table is intended for input from file, and should not normally be chosen as
a keyboard table. Classic Edition only

aplkeys

(Classic Edition Only)

This parameter specifies a search path for the Input Translate Table and is useful for
configuring a run-time application. It consists of a string of directories separated by
the semicolon (;) character. Its default value is the APLKEYS sub-directory of the
directory in which Dyalog APL/W is installed (defined by dyalog)

aplnid

Under Windows, this parameter specifies the user number that is used by the com-
ponent file system to control file sharing and security. If you wish to share com-
ponent files and/or external variables in a network it is essential that each user has a
unique aplnid parameter. It may be any integer in the range 0 to 65535. Note that an
aplnid value of 0 causes the user to bypass APL’s access control matrix mechanism.

Under UNIX, the user number is obtained from the Operating System (UID) and
aplnid is not used. If the user is "root", APL's access control mechanism is ignored.

When a user creates a component file, his user number is recorded in the file to iden-
tify him as its owner.
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aplt

This parameter specifies the name of the Output Translate Table. The default is
WIN.DOT and there is rarely a need to alter it.

apltrans

This parameter specifies a search path for the Output Translate Table and is useful for
configuring a run-time application. It consists of a string of directories separated by
the semicolon (;) character. Its default value is the sub-directory APLTRANS in the
directory in which Dyalog APL/W is installed.

auto_pw

This parameter specifies whether or not the value of JPW is derived automatically
from the current width of the Session Window. If auto_pw is 1, the value of JPW
changes whenever the Session Window is resized and reflects the number of char-
acters that can be displayed on a single line. If auto_pw is 0 (the default) JPW is inde-
pendent of the Session Window size.

AutoFormat

This parameter specifies whether or not you want automatic formatting of Control
Structures in functions. The default value is 1 which means that formatting is done
automatically for you when a function is opened for editing or converted to text by
0CR,[NR and (JVR. Automatic formatting first discards all leading spaces in the func-
tion body. It then prefixes all lines with a single space except those beginning with a
label or a comment symbol (this has the effect of making labels and comments stand
out). The third step is to indent Control Structures. The size of the indent depends
upon the TabStops parameter. To turn off automatic formatting, set AutoFormat to

0.

Autolndent

This parameter specifies whether or not you want semi-automatic indenting during
editing. The default value is 1. This means that when you enter a new line in a func-
tion, it is automatically indented by the same amount as the previous line. This
option simplifies the entry of indented Control Structures.
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ClassicMode

This parameter specifies whether or not the Session operates in Dyalog Classic mode.
The default is 0. If this parameter is set to 1, the Editor and Tracer behave in a manner
that is consistent with previous versions of Dyalog APL.

CMD_PREFIX and CMD_POSTFIX

These parameters defines strings within which operating system commands specified
as the arguments to [JCMD and [JSH, and ) CMD and ) SH, are wrapped. Its purpose is
to run the command arguments under a non-standard command shell.

See Language Reference for implementation details.

confirm_abort

This parameter specifies whether or not you will be prompted for confirmation when
you attempt to abort an edit session after making changes to the object being edited.
Its value is either 1 (confirmation is required) or 0. The default is 0.

confirm_close

This parameter specifies whether or not you will be prompted for confirmation when
you close an edit window after making changes to the object being edited. Its value
is either 1 (confirmation is required) or 0. The default is 0.

confirm_fix

This parameter specifies whether or not you will be prompted for confirmation when
you attempt to fix an object in the workspace after making changes in the editor. Its
value is either 1 (confirmation is required) or 0. The default is 0.

confirm_session_delete

This parameter specifies whether or not you will be prompted for confirmation when
you attempt to delete lines from the Session Log. Its value is either 1 (confirmation is
required) or 0. The default is 1.




Chapter 1: Installation and Configuration 17

CreateAplCoreOnSyserror

This parameter specifies whether or not an aplcore file is generated when APL exits
with a system error.

default_div

This parameter specifies the value of DIV in a clear workspace. Its default value is
0.

DefaultHelpCollection

If UseDefaultHelpCollection is 1, Dyalog attempts to use the Microsoft Document
Explorer and online help, for example from Visual Studio (if installed), to display
help for external objects, such as Net Types. In most cases the default settings of
"ms-help://ms.mscc.v80" will be sufficient. On some configurations it may be nec-
essary to change this. See " UseDefaultHelpCollection" on page 28

default_io

This parameter specifies the value of JI0 in a clear workspace. Its default value is 1.

default_ml

This parameter specifies the value of DML in a clear workspace. Its default value is 0.

default_pp

This parameter specifies the value of PP in a clear workspace. Its default value is
10.
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default_pw

This parameter specifies the value of JPW in a clear workspace. Its default value is
76. Note that [JPW is a property of the Session and the value of default_pw is over-
ridden when a Session file is loaded.

default_rl

This parameter specifies the value of RL in a clear workspace. It must be a scalar
and its default value is 16807.

default_rtl

This parameter specifies the value of RTL in a clear workspace. Its default value is
0.

default_wx

This parameter specifies the value of WX in a clear workspace. This in turn deter-
mines whether or not the names of properties, methods and events of GUI objects are
exposed. If set (OWX is 1), you may query/set properties and invoke methods directly
as if they were variables and functions respectively. As a consequence, these names
may not be used for global variables in GUI objects.

DMXOUTPUTONERROR

This parameter specifies in which windows DMX error messages are displayed. It is
an integer whose value is the sum of the sspecified windows where 1 = Status Win-
dow and 2 = Session Window.

DockableEditWindows

This parameter specifies whether or not individual edit windows can be undocked
from (and docked back into) the (MDI) Editor window. Its default value is 0. This
parameter does not apply if ClassicMode is set to 1.

DoubleClickEdit

This parameter specifies whether or not double-clicking over a name invokes the
editor. Its default is 1. If DoubleClickEdit is set to 0, double-clicking selects a word
and triple-clicking selects the entire line.
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dyalog
This parameter specifies the name of the directory in which Dyalog APL/W is
installed.
DyalogEmailAddress
This parameter specifies the contact email address for Dyalog Limited.
DyalogHelpDir
This parameter specifies the full pathname of the directory that contains the Dyalog
APL help file (dyalog.chm).
DyaloginstallDir
This parameter specifies the full pathname of the directory in which Dyalog APL is
installed.
DyalogWebSite

This parameter specifies the URL for the Dyalog web site.

edit_cols, edit_rows

These parameters specify the initial size of an edit window in character units.

edit_first_x, edit_first_y

These parameters specify the initial position on the screen of the first edit window in
character units. Subsequent edit windows will be staggered. These parameters only
apply if ClassicMode is 1.
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edit_offset_x, edit_offset_y

These parameters specify the amount by which an edit window is staggered from the
previous one.

ErrorOnExternalException

This is a Boolean parameter that specifies the behaviour when a System Exception
occurs in an external DLL. If this parameter is set to 1, and an exception occurs in a
call on an external DLL. APL generates an EXTERNAL DLL EXCEPTION error
(91), instead of terminating with a System Error. This error may be trapped.

EditorState

This is an internal parameter that remembers the state of the last edit window (normal
or maximised). This is used to create the next edit window in the appropriate state.

greet_bitmap

This parameter specifies the filename of a bitmap to be displayed during initial-
isation of the Dyalog APL application. It is used typically to display a product logo
from a runtime application. The bitmap will remain until either an error occurs, or it
is removed using the GreetBitmap method of the Root object.

greet bitmap=c:\myapp\logo.bmp

history_size

This parameter specifies the size of the buffer in Kb used to store previously entered
(input) lines in the Session.
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inifile

This parameter specifies the name of the Windows Registry folder that contains the
configuration parameters described in this section. For example,

INIFILE=Software\Dyalog\mysettings

If the parameter is not defined, inifile defaults to the current directory.

InitialKeyboardLayout (Unicode Edition Only)

This parameter specifies the name of the keyboard to be selected on startup. When
you start an APL session, this layout will automatically be selected as the current key-
board layout if the value of InitialKeyboardLayoutInUse is 1.

InitialKeyboardLayoutinUse (Unicode Edition Only)

This Boolean parameter specifies whether or not the keyboard specified by Initial-
KeyboardLayout is selected as the current keyboard layout when you start an APL
session.

InitialKeyboardLayoutShowAll (Unicode Edition Only)

This Boolean parameter specifies whether or not all installed keyboards are listed in
the choice of keyboards in the Configuration dialog box (Unicode Input tab).

input_size

This parameter specifies the size of the buffer in Kb used to store marked lines (lines
awaiting execution) in the Session.
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KeyboardinputDelay

This parameter specifies the delay (in milliseconds) before the system reacts to a user
keystroke by:

e updating the name of the Current Object in the Session statusbar. See "The
Current Object" on page 65

e offering a list of names for auto-completion. See "Auto Complete Tab" on
page 149

lines_on_functions

This parameter specifies whether or not line numbers are displayed in edit and trace
windows. It is either O (the default) or 1.

Note that this parameter determines your overall preference for line numbering, and
this setting persists between APL sessions. You can however still toggle line num-
bering on and off dynamically as required by clicking Line Numbers in the Options
menu on the Session Window. These temporary settings are not saved between APL
sessions

localdyalogdir

This parameter specifies the name of the directory in which Dyalog APL/W is
installed on the client, in a client/server installation

log_file

This parameter specifies the full pathname of the Session log file.

log_file_inuse

This parameter specifies whether or not the Session log is saved in a session log file.

log_size

This parameter specifies the size of the Session log buffer in Kb.
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mapchars

(Classic Edition Only)

In previous versions of Dyalog APL, certain pairs of characters in JAV were mapped
to a single font glyph through the output translate table. For example, the ASCII pipe
l'and the APL style | were both mapped to the APL style |. From Version 7.0
onwards, it has been a requirement that the mapping between [JAV and the font is
strictly one-to-one (this is a consequence of the new native file system). Originally,
the mapping of the ASCII pipe and the APL style, the APL and ASCII quotes, and
the ASCII * and the APL ~ were hard-coded. The mapping is defined by the map-
chars parameter.

mapchars is a string containing pairs of hexadecimal values which refer to 0-origin
indices in [JAV. The first character in each pair is mapped to the second on output.
The default value of mapchars is DBODEBA7EECO00BEO which defines the fol-
lowing mappings.

From To

Hex Decimal Symbol Hex Decimal Symbol

0D 13 '
A7

DB 219 ¢

EB 235 A 167 A

EE 238 0 Co

0B 11 . EO

192

224

To clear all mappings, set MAPCHARS=0000.

maxws

This parameter determines your workspace size in kilobytes and is the amount of
Windows memory allocated to the workspace at APL start-up. MAXWS is specified
as an integer number followed optionally by the letter k, m or g (in upper or lower
case) to indicate kilobytes, megabytes or gigabytes. If omitted, the default is kil-
obytes.

The default value is 16384 (16 Mb). If you want a larger (or smaller) workspace you
must change this value. For example, to get a 64 MB workspace:

MAXWS=64m
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Dyalog APL places no implicit restriction on workspace size, and the virtual memory
capability of MS-Windows allows you to access more memory than you have phys-
ically installed. However if you use a workspace that greatly exceeds your physical
memory you will encounter excessive paging and your APL programs will run
slowly.

Note that the memory used for the workspace must be contiguous memory, and,
under Windows, this is typically limited to a maximum of 1.6GB. This is a Windows
restriction, and not one that is imposed by Dyalog APL.

OverstrikesPopup (Unicode Edition Only)

This is a Boolean parameter that specifies whether or not the Overstrikes popup is
enabled.

PassExceptionsToOpSys

This is a Boolean parameter that specifies the default state of the Pass Exception
check box in the System Error dialog box.

pfkey_size

This parameter specifies the size of the buffer in Kb that is used to store pro-
grammable function key definitions. See OPFKEY.

ProgramFolder

This parameter specifies the name of the folder in which the Dyalog APL program
icons are installed.

PropertyExposeRoot

This parameter specifies whether or the names of properties, methods and events of
the Root object are exposed. If set, you may query/set the properties of Root and
invoke the Root methods directly as if they were variables and functions respec-
tively. As a consequence, these names may not be used for global variables in your
workspace.
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PropertyExposeSE

This parameter specifies whether or the names of properties, methods and events of
the Session object are exposed. If set, you may query/set the properties of JSE and
invoke [JSE methods directly as if they were variables and functions respectively. As
a consequence, these names may not be used for global variables in the [JSE names-
pace.

gcmd_timeout

This parameter specifies the length of time in milliseconds that APL will wait for the
execution of a Windows command to start. Its default value is 5000 milliseconds.

ResolveOverstrikes (Unicode Edition Only)
Specifies whether or not the user may enter an APL composite symbol using over-
strikes.

RunAsService

When RunAsService is set to 1 (the default is 0) Dyalog APL will not prompt for con-
firmation when the user logs off, and the interpreter will continue to run across the
logofflogon process

SaveContinueOnExit

Specifies whether or not your current workspace is saved as CONTINUE . DWS before
APL terminates.

SaveLogOnExit

Specifies whether or not your Session log is saved before APL terminates.

SaveSessionOnExit

Specifies whether or not your current Session is saved in your Session file before
APL terminates.
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Serial

Specifies your Dyalog APL/W Serial Number.

session_file

This parameter specifies the name of the file from which the APL session (SE) is to
be loaded when APL starts. If not specified, a .DSE extension is assumed. This ses-
sion file contains the [JSE object that was last saved in it. This object defines the
appearance and behaviour of the Session menu bar, tool bar(s) and status bar,
together with any functions and variables stored in the [JSE namespace.

SessionOnTop

Specifies whether or not the Session may appear on top of Edit and Trace Windows
in Classic Dyalog mode. See " ClassicMode" on page 16.

ShowStatusOnError

Specifies whether or not the Status window is automatically displayed (if required)
when APL attempts to write output to it.

SingleTrace

Specifies whether there is a single Trace window, or one Trace window per function.
This applies only if ClassicMode is 1.

StatusOnEdit

Specifies whether or not a status bar is displayed at the bottom of an Edit window.

sm_cols, sm_rows

These parameters specify the size of the window used to display 0SM when it is used
stand-alone. They are not used if the window is specified using the SM object.

TabStops

This parameter specifies the number of spaces inserted by pressing the Tab key in the
editor. Its default value is 4.
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trace_cols, trace_rows

These parameters specify the initial size of a trace window in character units.

trace_first_x, trace_first_y

These parameters specify the initial position on the screen of the first trace window
in character units. Subsequent trace windows will be staggered. This applies only if
ClassicMode is 1.

trace_offset_x, trace_offset_y

These parameters specify the amount by which a trace window is staggered from the
previous one. These apply only if ClassicMode is 1 and SingleTrace is 0.

Trace_level_warn

This parameter specifies the maximum number of Trace windows that will be dis-
played when an error occurs and Trace_on_error is set to 1. Ifthere are a large
number of functions in the state indicator, the display of their Trace windows may
take several seconds. This parameter allows you to restrict the potential delay to a rea-
sonable value and its default is 16. If the number of Trace windows would exceed
this number, the system instead displays a warning message box. This parameter is
ignored if you invoke the Tracer explicitly. This parameter applies only if Clas-
sicMode is 1 and SingleTrace is 0.

Trace_on_error

This parameter is either 0 (the default) or 1. If set to 1, Trace_on_error specifies that
the Tracer is automatically deployed when execution of a defined function halts with
an error. A stack of Trace windows is immediately displayed, with the top Trace win-
dow receiving the input focus.
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TraceStopMonitor
This parameter specifies which of the J-TRACE (1),[JSTOP (2) and JMONITOR (4)
columns are displayed in Trace and Edit windows. Its value is the sum of the cor-
responding values.
UnicodeToClipboard

This parameter specifies whether or not text that is transferred to and from the Win-
dows clipboard is treated as Unicode text. If UnicodeToClipboard is 0 (the default),
the symbols in [JAV are mapped to ASCII text (0-255). In particular, the APL symbols
are mapped to ASCII symbols according to their positions in the Dyalog APL font. If
UnicodeToClipboard is 1, the symbols in JAV are mapped to Unicode text and the
APL symbols are mapped to their genuine Unicode equivalent values.

UseDefaultHelpCollection

This parameter specifies whether or not Dyalog attempts to use the Microsoft Doc-
ument Explorer and online help to display help for external objects, such as .Net
Types. See "DefaultHelpCollection " on page 17.

WantsSpecialKeys (Unicode Edition Only)

This parameter specifies a list of applications (e.g. "putty.exe") that use the command
strings in the Input Translate Tables.

wspath

This parameter defines the workspace path. This is a list of directories that are
searched in the order specified when you ) LOAD or ) COPY a workspace and when
you start an Auxiliary Processor. The directory paths are specified using Operating
System specific conventions and separated by ";" (Windows) or ":" (UNIX).

The following Windows example causes ) COPY, ) LOAD and ) LIB to look first in
the current directory, then in D: \MYWS, and then in the (normal) installation work-
space directory.

wspath=.;D:\MYWS;C:\Program Files\Dyalog\Dyalog APL 13.2
Unicode\ws

XPLookAndFeel

This parameter specifies whether or not Native Look and Feel is used. This affects the
appearance of user-interface controls such as Buttons. The default is 1. See "The Con-
figuration Dialog Box" on page 127.



Chapter 1: Installation and Configuration 29

XPLookAndFeelDocker

This parameter specifies whether or not the title bars in docked windows honour
Native Look and Feel, if this is enabled at the Windows level. If unspecified, the
default is 0.

yy_window

This parameter defines how Dyalog APL is to interpret a 2-digit year number. If yy
window is not set (the default) then under Windows, Version 13.2 onwards will
adhere to the rules specified in the Windows Region and Language 2-digit year set-
tings.

Dyalog allows a choice of input date formats for JSM and GUT edit fields. If you
have chosen a 2-digit year format such as MM/DD/YY, then an input 0f 02/01/00
will by default be interpreted as 15t February 1900 - not 15 February 2000.

If your application uses a 4-digit year format such as YYYY-MM-DD, the problem
will not arise.

You can use the yy_window parameter to cause your application to interpret 2-digit
dates in as required without changing any APL code.

Sliding versus Fixed Window
Two schemes are in common use within the industry: Sliding or Fixed date windows.

Use a Fixed window if there is a specific year, for example 1970, before which, dates
are meaningless to your application. Note that with a fixed window, this date (say
1970) will still be the limit if your application is running in a hundred years time.

Use a Sliding window if there is a time period, for example 30 years, before which
dates are considered too old for your application. With a sliding window, you will
always be able to enter dates up to (say) 30 years old, but after a while, specific years
in the past (for example 1970) will become inaccessible.

Setting a Fixed Window

To make a fixed window, set parameter yy_window to the 4-DIGIT year which is
the earliest acceptable date. For example:

YY_WINDOW=1970

This will cause the interpreter to convert any 2-digit input date into a year in the
range 1970, 1971 ... 2069
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Setting a Sliding Window

To make a sliding window, set parameter yy_window to the 1- or 2-DIGIT year
which determines the oldest acceptable date. This will typically be negative.

YY WINDOW=-30
Conversion of dates now depends on the current year:
Ifthe current year is 1999, the earliest accepted date is 1999-30 = 1969.

This will cause the interpreter to convert any 2-digit input date into a year in the
range 1969, 1970 ... 2068.

However if your application is still running in the year 2010, the earliest accepted
date then will be 2010-30 = 1980. So in the year 2010, a 2-digit year will be inter-
preted in the range 1980, 1981 ... 2079.

Advanced Settings
You can further restrict date windows by setting an upper as well as lower year limit.
YY WINDOW=1970,1999

This causes 2-digit years to be converted only into the range 1970, 1971 ... 1999.
Any 2-digit year (for example, 54) not convertible to a year in this range will cause a
DOMAIN ERROR.

The sliding window equivalent is:
YY WINDOW=-10,10

This would establish a valid date window, ten years either side of the current year.
For example, if the current year is 1998, the valid range would be (1998-10) —
(1998+10), in other words: 1988, 1989, ~2008.

One way of looking at the yy_window variable is that it specifies a 2-element vector.
If you supply only the first element, the second one defaults to the first element + 99.

Note that the system uses only the number of digits in the year specification to deter-
mine whether it refers to a fixed (4-digits) or sliding (1-, or 2-digits) window. In fact
you can have a fixed lower limit and a sliding upper limit, or vice versa.

YY WINDOW=1990,10
Allows dates as early as 1990, but not more than 10 years hence.
YY_WINDOW=0,1999

Allows dates from the current year to the end of the century.



Chapter 1: Installation and Configuration 31

Ifthe second date is before, or more that 99 years after the first date, then any date
conversion will result in a DOMAIN ERROR. This might be useful in an application
where the end-user has control over the input date format and you want to disallow
any 2-digit date input.

YY WINDOW=1,0

Registry Sub-Folders

A large amount of configuration information is maintained in the Windows Registry
in sub-folders of the main folder identified by inifile.

Many of'these values are dynamic, for example the position of the various Session
windows, is maintained in a Registry sub-folder so that their appearance is main-
tained from one invocation of APL to the next. These type of Registry values are con-
sidered to be internal and are therefore not described herein.

However, and Registry Value that is maintained via a configuration dialog box will
be named and described in the documentation for that dialog box in Chapter 2.

AutoComplete

This contains registry entries that describe your personal AutoComplete options. See
"Auto Complete Tab" on page 149.

Charts

This contains entries that control the way charts are produced and displayed when
you click one of the chart buttons. See " Object Operations" on page 122.

Colours

This contains entries that describe the colour schemes you have and your personal
preferences. See "Colour Selection Dialog" on page 157.

Event Viewer

This contains entries that describe your settings for the Event Viewer. See "The
Event Viewer" on page 258.

Explorer

This contains entries that describe your settings for the Workspace Explorer. See
"The Workspace Explorer Tool" on page 168.
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files

This contains the size of your recently used file list (see "General Tab" on page 127)
and the list of your most recently loaded workspaces.
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KeyboardShortcuts

This contains the definitions of your Keyboard Shortcuts (Unicode Edition only).
See "Keyboard Shortcuts Tab" on page 135.

LanguageBar

This contains the definitions of the symbols, tips, and help for the symbols in the Lan-
guageBar.

Printing

This contains the entries for your Printer Setup options. See "Print Configuration
Dialog Box" on page 160.

SALT

This contains entries for SALT. See "SALT" on page 151.

Search

This contains dynamic entries for the Find Objects Tool. See "Find Objects Tool" on
page 202.

Threads

This contains entries to remember your preferences for Threads. See "The Threads
Menu" on page 116.

UnicodelME

This contains entries for the Dyalog Unicode IME.

ValueTips

This contains entries for your Value Tips preferences. See "Value Tips" on page 93.

WindowRects

This contains entries to maintain the position of various Session tool windows so
that they remain consistent between successive invocations of APL.

Array Editor

The Array Editor stores its settings in the following registry sub-folder:

HKEY CURRENT USER\Software\DavidLiebtag.com\Array
Editor\1l.1\Options
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Workspace Management

Workspace Size and Compaction

The maximum amount of memory allocated to a Dyalog APL workspace is defined
by the maxws parameter.

Upon )LOAD and )CLEAR, APL allocates an amount of memory corresponding to
the size of the workspace being loaded (which is zero for a clear ws) plus the work-
space delta.

The workspace delta is 1/16™ of maxws, except if there is less than 1/16™ of maxws
in use, delta is 1/64™ of maxws. This may also be expressed as follows:

deltaemaxws{[a+>(w>a+16)d64 16}ws

where maxws is the value of the maxws parameter and ws is the currently allocated
amount of workspace. If maxws is 16384KB, the workspace delta is either 256KB or
1024 KB, and when you start with a c Lear ws the workspace occupies 256KB.

When you erase objects or release symbols, areas of memory become free. APL man-
ages these free areas, and tries to reuse them for new objects. If an operation requires a
contiguous amount of workspace larger than any of the available free areas, APL reor-
ganises the workspace and amalgamates all the free areas into one contiguous block
as follows:

1. Any un-referenced memory is discarded. This process, known as garbage
collection, is required because whole cycles of refs can become un-ref-
erenced.

2. Numeric arrays are demoted to their tightest form. For example, a simple
numeric array that happens to contain only values 0 or 1, is demoted or
squeezed to have a [IDR type of 11 (Boolean).

3. All remaining used memory blocks are copied to the low-address end of the
workspace, leaving a single free block at the high-address end. This process
is known as compaction.

4. In addition to any extra memory required to satisfy the original request, an
additional amount of memory, equal to the workspace delta, is allocated.
This will always cause the process size to increase (up to the maxws limit)
but means that an application will typically achieve its working process
size with at most 4+15 memory reorganisations.

5. However, if after compaction, the amount of used workspace is less than
1/16 of the Maximum workspace size (maxws), the amount reserved for
working memory is reduced to 1/64th maxws. This means that workspaces
that are operating within 1/16th of maxws will be more frugal with memory
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Note that if you try to create an object which is larger than free space, APL reports
WS FULL.

The following system function and commands force a workspace reorganisation as
described above:

OWA, )RESET, )SAVE, )LOAD, )CLEAR

However, in contrast to the above, any spare workspace above the workspace delta
is returned to the Operating System. On a Windows system, you can see the process
size changing by using Task Manager.

The system function WA may therefore be used judiciously (workspace reor-
ganisation takes time) to reduce the process size after a particularly memory-hungry
operation.

Note that in Dyalog APL, the SYMBOL TABLE is entirely dynamic and grows and
shrinks in size automatically. There isno SYMBOL TABLE FULL condition.

Interface with Windows

Windows Command Processor commands may be executed directly from APL using
the system command ) CMD or the system function JCMD. This system function is

also used to start other Windows programs. For further details, see the appropriate sec-
tions in Language Reference.

Auxiliary Processors

Introduction

Auxiliary Processors (APs) are non-APL programs which provide Dyalog APL users
with additional facilities. They run under the control of Dyalog APL.

Typically, APs are used where speed of execution is critical, for utility libraries, or as
interfaces to other products. APs may be written in any compiled language, although
C is preferred and is directly supported.
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Starting an AP

An Auxiliary Processor is invoked using the dyadic form of JCMD. The left argument
to JCMD is the name of the program to be executed; the value of the wspath param-
eter is used to find the named file. In Dyalog APL/W, the right argument to [JCMD is
ignored.

"xutils' [OCMD '

On locating the specified program, Dyalog APL starts the AP and initialises a mem-
ory segment for communication between the workspace and the AP. This com-
munication segment allows data to be passed from the workspace to the other
process, and for results to be passed back. The AP then sends APL some information
about its external functions (names, code numbers and calling syntax), which APL
enters in the symbol table. APL then continues processing while the AP waits for
instructions.

Using the AP

Once established, an AP is used by making a reference to one of its external func-
tions. An external function behaves as ifit was a locked defined function, but it is in
effect an entry point to the AP. When an external function is referenced, APL trans-
mits a code number to the AP, followed by any arguments. The AP then takes over
and performs the desired processing before posting the result back.

Terminating the AP

An AP is terminated when all of its external functions are expunged from the active
workspace. This could occur with the use of ) CLEAR, ) LOAD, )ERASE,[JEX, )OFF,
)CONTINUE or[JOFF.
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Example:

Start an Auxiliary Processor called EXAMPLE. This fixes two external functions
called DATE_TO_IDN and IDN_TO_DATE which deal with the conversion of Inter-
national Day Numbers to Julian Dates.

| )CLEAR |

|clear ws |

| | start AP .------------—- .
| "EXAMPLE' OCMD '' = |=-=--------- >| AP EXAMPLE |
| | | -ommmmm oo |
| | info about |Send info on |
| ¢ —- |lexternal fns |
[ | functions | |
| )FNS | | wait |
IDATE_TO_IDN IDN_TO_DATE | | I
| | function codel |
| IDN_TO_DATE 19407 R >|call relevant |
| | 19407 | subroutine |
| wait ... | | |
| |<-18 Feb 53--| send result |
|18 Feb 53 | | |
| | terminate | |
| )CLEAR |- ——- > | EXIT |
[clear ws | and stop emm e .
|

Access Control for External Variables

External variables may be EXCLUSIVE or SHARED. An exclusive variable can
only be accessed by the owner of the file. If you are on a Local Area Network (LAN)
a shared external variable may be accessed (concurrently) by other users. The exclu-
sive or shared status of an external variable is set by the XVAR function in the UTIL
workspace.

Access to an external variable is faster if it has exclusive status than if'it is shared.
This is because if several users are accessing the file data must always be read and
written directly to disk. If it has exclusive status, the system uses buffering and
avoids disk accesses where possible.
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Creating Executables

Dyalog APL provides the facility to package an APL workspace as a Windows
executable (EXE). This may be done by selecting Export ... from the File menu of
the APL Session window.

The system provides the following options:

¢ You may bind your EXE as a Dyalog APL run-time application, or as a
Dyalog APL developer application. The second option will allow you to
debug the application should it encounter an APL error.

e You may bind your EXE as a console-mode application. A console appli-
cation does not have a graphical user interface, but runs as a background
task using files or TCP/IP to perform input and output.

e You may specify whether or not your .EXE will honour Native Look and
Feel if this is enabled at the Windows level.

You can package the workspace as a stand-alone executable or as a .EXE file that
must be accompanied by the Dyalog APL Dynamic Link Library
(dyalogl32.dllordyalogl32rt.dll),in which case the DLL should be
installed in the same directory (as the EXE) or in the Windows System directory.

The following example illustrates how you can package the supplied workspace
calc.dws asan executable. Before making the executable, it is essential to set up
the latent expression to run the program using [JL X as shown. Notice that in this case
it is not necessary to execute [JOF F; the calc.exe program will terminate normally
when the user closes the calculator window and the system returns to Session input.
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S C:\Program Files\Dyalog\Dyalog APL 13.0 Unicode\ws\CALC - ... |- ||00/53
File Edit View ‘Windows Session Log Ackion Options Tools Threads Help

ws [ = 0% E &) | Object B B 85 ¥ lh BZ | Tool| Edit| | Session
Language Bar il =13 ﬂ

l||||||IEI||||||f|l|||||||¢||||||¢||||||l

Dvalog APL/W Yersion 13.0.8890
Serial Ho @ 000O0LZ
Unicode Edition
Hon-commercial License
Wed Mar 30 16:L2:LL4 2011
clear ws
JLOAD CALC
C:“Program Files“DyaloghDyalog APL 13.0 Unicodehwsi\CAL
For Dyalog AFL GUI Demonstration, trace:

CALC. RUM
vl
£ 2] |8
=
Debugger Slal=l W
Ready... Ins
CurOhbj: &l Opa:=o |OTRAP O5I:n |(OI0:=1 |(OML:D

Then, when you select Export... from the File menu, the following dialog box is dis-
played.
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= =4

Create bound file
Save jh: |L'f} w3 [V] € | ? ¥ -

E_ ﬁcalc.exe

iy Recent
Documents

&)

Desktop

£

My Documents

E,

tdy Computer

File name: |D&LE. ene [V] Save

by Metwark Save as type: | Standalone Executable (includes interprater e:-:s[v] [ Cancel ]

Buntime application [ ] Console application  [#]{Enable Mative Look and Feef

Command line;

In the example shown, the program is to be saved in ws, the (supplied workspaces)
directory from which the workspace was loaded (the default).

The Save as Type option has been set to Standalone Executable (includes interpreter
exe) which means that a single .EXE will be created containing the Dyalog APL
executable and the CALC workspace.

The Runtime application checkbox is checked, indicating that calc.exe isto
incorporate the runtime version of Dyalog APL..

As this is a GUI application, the Console application checkbox is left unset.

The Enable Native Look and Feel checkbox has been set so that calc.exe will
honour Native Look and Feel if it is enabled at the Windows level.
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Note that if you enter the name of a file containing an icon (use the Browse button to
browse for it) that icon will be bound with your executable and be use instead of the
standard Dyalog APL icon.

The Command Line box allows you to enter parameters and values that are to be
passed to your executable when it is invoked.

On clicking Save, the following message box is displayed to confirm success.

-,

Dyalog APL/W

L
\!I‘) File iZ:\Program Files\DyalogiDrwvalog APL 13,0 UnicodelwsyCALT  exe successfully created,

Version Information

You may embed version information into your .exe by clicking the Version button
and then completing the Version Informationn dialog box that is illustrated below.

__ Yersion Information
Indentifier | Yalue |
Comments | “'our comments here
CompanyM ame Yaur Compaty Mame
FileDrescription “our File Description
Filetdersian 1.0,0.0
Productyerzion 1,000
Praducth arme
InternalM arne rour Internal Filename
LegalCopyright Copyright [C] 2005
LegalTrademark.z “'our Legal Trademarks
PrireateB uild
SpecialBuild

ok | [ Cancel
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Run-Time Applications and Components

Using Dyalog APL you may create different types of run-time applications and com-
ponents. Note that the distribution of run-time applications and components requires
a Dyalog APL Run-Time Agreement. Please contact Dyalog or your distributor, or
see the Dyalog web page for more information.

The following table shows a list of distributable components for the two Editions.
These are referred to in the remainder of this Chapter by the name shown in the first
column of'the table. It is essential that you distribute the components that are appro-
priate for the Edition you are using.

Name

File

32-bit Unicode

Dyalog APL 13.2 Unicode\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl32rt unicode.dll

Bridge DLL bridgel32 unicode.dll
Dyalog DLL dyalog32 dl1l
DyalogProvider DLL dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc unicode-exe

32-bit Classic

Dyalog APL 13.2 Classic\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl32rt.dll

Bridge DLL bridgel32.dll
Dyalog DLL dyalog32 dl1l
DyalogProvider DLL dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc-exe
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Name

File

64-bit Unicode

Dyalog APL-64 13.2 Unicode\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl32 64rt unicode.dll

Bridge DLL bridgel32-64 unicode.dll
Dyalog DLL dyalog64 dll
DyalogProvider DLL dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc64 unicode-exe

64-bit Classic

Dyalog APL-64 13.2 Classic\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalogl32 64rt.dll

Bridge DLL bridgel32-64.d11
Dyalog DLL dyalog64 dll
DyalogProvider DLL dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogcbd-exe

Stand-alone run-time

This is the simplest type of run-time to install. Using the File/Export menu item on
the Session window, you can create a standard Windows executable program file
(EXE) which contains your workspace and the Run-Time version of the Dyalog APL
interpreter. To distribute your application, you need to supply and install:

1. Your bound executable (EXE)
2. whatever additional files that may be required by your application
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The command-line for your application should simply invoke your EXE, with what-
ever start-up parameters it may require. Note that your application icon and any start-
up parameters for the Run-Time Interpreter are specified and bound with the EXE
when you make it.

If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC)using the gacutil.exe utility program.

Bound run-time

This option requires the separate installation of the Run-Time DLL, but compared
with the stand-alone executable option, may save disk space and memory if your cus-
tomer installs and runs several different Dyalog applications. Using the File/Export
menu item on the Session window, you can create a standard Windows executable
program file (EXE) which contains your workspace bound to the Run-Time DLL. To
distribute your application, you need to supply and install:

1. Your bound executable (EXE)
2. The Run-Time DLL

whatever additional files that may be required by your application

The command-line for your application should simply invoke your EXE, with what-
ever start-up parameters it may require. Note that your application icon and any start-
up parameters for the Run-Time DLL are specified and bound with the EXE when
you make it.

If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC) using the gacutil . exe utility program.

Workspace based run-time

A workspace based run-time application consists of the Dyalog APL Run-Time Pro-
gram (Run-Time EXE) and a separate workspace. To distribute your application, you
need to supply and install:

1. Your workspace
2. The Run-Time EXE
3. whatever additional files that may be required by your application
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The command-line for your application invokes the Run-Time EXE, passing it start-
up parameters required for the Run-Time EXE itself (such as MAXWS) and any start-
up parameters that may be required by your application. You will need to associate
your own icon with your application during its installation.

If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC)using the gacutil.exe utility program.

Out-of-process COM Server
To make an out-of-process COM Server, you must:

1. Establish one or more OLEServer namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to register the
COM Server on your computer so that it is ready for use.

The command-line for your COM Server invokes the Run-Time EXE, passing it start-
up parameters required for the Run-Time EXE itself (such as MAXWS) and any start-
up parameters that may be required by your application.

To distribute an out-of-process COM Server, you need to supply and install the fol-
lowing files:

Your workspace

The associated Type Library (.tlb) file (created by File/Export)
The Run-Time EXE

whatever additional files that may be required by your application

B W —

To install an out-of-process COM Server you must set up the appropriate Windows
registry entries. See Interface Guide for details.

In-process COM Server
To make an in-process COM Server, you must:

1. Establish one or more OLEServer namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to create an in-
process COM Server (DLL) which contains your workspace bound to the
Run-Time DLL. This operation also registers the COM Server on your com-
puter so that it is ready for use.
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To distribute your component, you need to supply and install
Your COM Server file (DLL)

1. The Run-Time DLL
2. Whatever additional files that may be required by your COM Server.

Note that you must register your COM Server on the target computer using the
regsvr32.exe utility.

ActiveX Control

To make an ActiveX Control, you must:

1. Establish an ActiveXControl namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to create an Acti-
veX Control file (OCX) which contains your workspace bound to the Run-
Time DLL. This operation also registers the ActiveX Control on your com-
puter so that it is ready for use.

To distribute your component, you need to supply and install
Your ActiveX Control file (OCX)

1. The Run-Time DLL
2. Whatever additional files that may be required by your ActiveX Control.

Note that you must register your ActiveX Control on the target computer using the
regsvr32.exe utility.

Microsoft .Net Assembly

A Microsoft .Net Assembly contains one or more .Net Classes. To make a Microsoft
Net Assembly, you must:

1. Establish one or more NetType namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.

2. Use the File/Export ... menu item on the Session window to create a Micro-
soft .Net Assembly (DLL) which contains your workspace bound to
the Run-Time DLL.

To distribute your .Net Classes, you need to supply and install
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Your Assembly file (DLL)

The Run-Time DLL

The Bridge DLL

The DyalogNet DLL

Whatever additional files that may be required by your .Net Assembly.

The Bridge DLL and DyalogNet DLLs must either be on the system path or
placed in the same directory as your EXE. If you are going to use your
Assembly with ASP.NET, the DLLs must also be installed in the global
assembly cache (GAC) using the gacutil.exe utility program.

Additional Files for SQAPL

If your application uses the SQAPL/EL ODBC interface, you must distribute and
install four additional files, according to the Edition you are using, as shown in the
tables below.

N kAW -

Name

File

32-bit Unicode

Dyalog APL 13.2 Unicode\

SQAPL INI sgapl.ini
SQAPL ERR sgapl.err
SQAPL DLL cndya6lUni.dll

APLUNICD INI

aplunicd.ini

32-bit Classic

Dyalog APL 13.2 Classic\

SQAPL INI sgapl.ini
SQAPL ERR sgapl.err
SQAPL DLL cndya6l.dll

APLUNICD INI

aplunicd.ini




48 Dyalog APL/W User Guide

Name

File

64-bit Unicode

Dyalog APL-64 13.2 Unicode\

SQAPL INI

sgapl.ini

SQAPL ERR

sgapl.err

SQAPL DLL

cndya6l1x64Uni.dll

APLUNICD INI

aplunicd.ini

64-bit Classic

Dyalog APL-64 13.2 Classic\

SQAPL INI

sgapl.ini

SQAPL ERR

sgapl.err

SQAPL DLL

cndya6lx64.d1l1

APLUNICD INI

aplunicd.ini

The SQAPL DLL must be installed in the user’s Windows directory or be on the

user’s path.
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Miscellaneous Other Files
AUXILIARY PROCESSORS

If you use any of the Auxiliary Processors (APs) included in the sub-directory
XUTILS, you must include these with your application. Note that, like workspaces,
Dyalog APL searches for APs using the wspath parameter. If your application uses
APs, you must ensure that you specify wspath or that the default wspath is adequate
for your application..

DYALOG32 and/or DYALOG64

This DLL is used by some of the functions provided in the QUADNA . DWS work-
space. If you include any of these in your application this DLL must be installed in
the user’s Windows directory or be on the user’s path.

Registry Entries for Run-Time Applications

The Run-Time DLL does not obtain any parameter values from the Windows reg-
istry. If you need to specify any Dyalog APL parameter values, they must be defined
in the command line when you create an EXE.

The Run-Time EXE does obtain parameter values for the Windows registry, but does
not require them to be present. If the default values of certain parameters are inap-
propriate, you may specify their values on the command line. There is normally no
requirement to install registry entries for a run-time application that uses the Run-
Time EXE.

For example, your application may requires a greater or lesser maxws parameter
(workspace size) than the default value. This may be done by adding the phrase
MAXWS=nnnn (where nnnn is the required workspace size in kilobytes) after the
name of your application workspace on the command line, for example:

dyalogrt.exe MYAPP.DWS MAXWS=8096
Note that the default value of the DYALOG parameter (which specifies where it

looks for various other files and sub-directories) is the directory from which the appli-
cation (dyalogrt.exe)isloaded.
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Nevertheless, registry entries will be required in the following circumstances.

1. If your Classic Edition run-time application requires that the user inputs
APL characters, you will need to specify input/output tables (parameters
APLK, APLT, APLKEYS and APLTRANS).

2. If your application uses the NFILES Auxiliary Processor (now superseded
by the ONxxx system functions), you must specify a registry entry for the
APLKEYS parameter. This is required so that NFILES can find any trans-
late tables you may use. Note that NFILES cannot see the values of param-
eters specified on the APL command line, so you must specify APLKEYS
in the registry.

Installing Registry Entries

To specify parameters using the Registry, you must install a suitable registry folder

for each user of your application. By default, Version 13.2 will use the registry
folder:

HKEY CURRENT USER\Software\Dyalog\Dyalog APL/W 13.2 Unicode
or
HKEY CURRENT USER\Software\Dyalog\Dyalog APL/W 13.2

You may choose a different name for your registry folder if you wish. If so, you must

tell Dyalog APL the name of'this folder by specifying the INIFILE parameter on the
command line. For example:

dyalogrt.exe MYAPP.DWS INIFILE=Software\MyCo\MyApplication

You may install entries into the registry folder in one of two ways:

1. Using a proprietary installation program such as InstallShield

2. Using the REGEDIT utility. This utility program installs registry entries
defined in a text file that is specified as the argument to the program. For
example, if your file is called APLAPP.REG, you would install it on your
user’s system by executing the command:

REGEDIT APLAPP.REG

An example 5-line file that specifies the APLNID and MAXWS
parameters might be as follows:

Windows Registry Editor Version 5.00

[HKEY CURRENT USER\Software\Dyalog\Dyalog APL/W 13.0]
Haplnid"=ll42"
"maxws"="8096"
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COM Objects and the Dyalog APL DLL

Introduction

In each Edition, there are two versions of the Dyalog APL Dynamic Link Library,
named dyalogl32 unicode.dll and dyalogl32rt unicode.dll (Uni-
code Edition) and dyalogl132.d11 and dyalogl32rt.d1l1 (Classic Edition).

dyalogl32 unicode.dlland dyalogl32.d11 are complete Dyalog APL
development systems packaged as Dynamic Link Libraries.

dyalogl32 unicode.dllanddyalogl32rt unicode.dll and
dyalogl32rt.dl1 are the run-time versions of dyalogl32.d11.

In the remainder of this section, the term the Dyalog APL DLL is used to refer to any
one of these DLLs. The term COM object is used to refer to a Dyalog APL in-process
OLE Server (OLEServer object) or a Dyalog APL ActiveX Control (ActiveXControl
object).

The Dyalog APL DLL is used to host COM objects and .Net objects written in Dya-
log APL. Although this section describes how it operates with COM objects, much
ofthis also applies when it hosts .Net objects. Further information is provided in the
.Net Interface Guide.

Classes, Instances and NameSpace Cloning

A COM object, whether written in Dyalog APL or not, represents a class. When a
host application loads a COM object, it actually creates an instance of that class.

When a host application creates an instance of a Dyalog APL COM object, the cor-
responding OLEServer or ActiveXControl namespace is cloned. If the host creates a
second instance, the original namespace is cloned a second time.

Cloned OLEServer and ActiveXControl namespaces are created in almost exactly
the same way as those that you can make yourselfusing [JOR and OWC except that
they do not have separate names. In fact, each clone believes itself to be the one and
only original OLEServer or ActiveXControl namespace, with the same name, and is
completely unaware of the existence of other clones.

Notice that cloning does not initially replicate all the objects within the OLEServer
or ActiveXControl namespace. Instead, the objects inside the cloned namespaces are
actually represented by pointers to the original objects in the original namespace.
Only when an object is changed does any information get replicated. Typically, the
only objects likely to differ from one instance to another are variables, so only one
copy of the functions will exist in the workspace. This design enables many
instances of a Dyalog APL COM object to exist without overloading the workspace.
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Workspace Management

By default, the Dyalog APL DLL does not use a fixed maximum workspace size, but
automatically increases the size of'its active workspace as required. If you write a
run-away COM object, or if there is insufficient computer memory available to load a
new control, it is left to the host application or to Windows itselfto deal with the sit-
uation.

Nevertheless, it is possible to specify a value for MAXWS for the application in
which the Dyalog APL DLL is embedded. This is achieved by defining a Registry
key named:

HKILM\Software\Dyalog\Embedded\<appname>

where <appname> is the name of the application, containing a String Value named
maxws set to the desired size (in kb). If you were running an APL in-process server
from Microsoft Excel, the application name would be excel.exe.

When an application loads its first Dyalog APL COM object, it starts the Dyalog
APL DLL which initialises a CLEAR WS. It then copies the namespace tree for the
appropriate OLEServer or ActiveXControl object into its active workspace.

This namespace tree comprises the OLEServer or ActiveXControl namespace itself,
together with all its parent namespaces with the exception of the root workspace
itself. Note that for an ActiveXControl, there is at least one parent namespace that
represents a Form.

For example, if an ActiveXControl namespace is called #.F .Dual, the Dyalog APL
DLL will copy the contents of #. F into its active workspace when the first instance
of'the control is loaded by the host application.

If the same host application creates a second instance of the same OLEServer or
ActiveXControl, the original namespace is cloned as described above and there is no
further impact on the workspace

If the same host application creates an instance of a different Dyalog APL COM
object, the namespace tree for this second object is copied from its DLL or OCX file
into the active workspace. For example, if the second control was named
X.Y.MyControl,the entire namespace X would be copied.
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This design raises a number of points:

1. Unless you are in total control of the user environment, you should design a
Dyalog APL COM object so that it can operate in the same workspace as
another Dyalog APL COM object supplied by another author. You cannot
make any assumptions about file ties or other resources that are properties of
the workspace itself.

2. If you write an ActiveXControl whose ultimate parent namespace is called
F, a host application could not use your control at the same time as another
ActiveXControl (perhaps supplied by a different author) whose ultimate par-
ent namespace is also called F.

3. Dyalog APL COM objects must not rely on variables or utility functions
that were present in the root workspace when they were saved. These func-
tions and variables will not be there when the object is run by the Dyalog
APL DLL.

4. A Dyalog APL COM object may create and subsequently use functions and
variables in the root workspace, but if two different COM objects were to
adopt the same policy, there is a danger that they would interfere with one
another. The same is true for [JSE.

Multiple COM Objects in a Single Workspace

If your workspace contains several OLEServer or ActiveXControl objects which
have the same ultimate parent namespace, the Dyalog APL DLL will copy them all
into the active workspace at the time when the first one is instanced. If the host appli-
cation requests a second COM object that is already in the workspace, the namespace
tree is not copied again.

If the workspace contains several OLEServer or ActiveXControl objects which have
different ultimate parents, their namespace trees will be copied in separately.

Parameters

With the exception of maxws (see above) the Dyalog APL DLL does not read param-
eters from the registry, command-line or environment variables. This means that all
such parameters will have their default values.
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System Errors

Introduction

Dyalog APL will display a System Error Dialog and (normally) terminate in one of
two circumstances:

e As aresult of the failure of a workspace integrity check
e As aresult of a System Exception

aplcore file

In these circumstances, APL saves an aplcore file which may be sent to Dyalog for
diagnosis. The default name and location of the aplcore file may be specified by the
AplCoreName parameter. This parameter may also be used to suppress generation of
the aplcore file.

Workspace Integrity

When you ) SAVE your workspace, Dyalog APL first performs a workspace integrity
check. Ifit detects any discrepancy or violation in the internal structure of your work-
space, APL does not overwrite your existing workspace on disk. Instead, it displays
the System Error dialog box and saves the workspace, together with diagnostic infor-
mation, in an aplcore file before terminating.

A System Error code is displayed in the dialog box and should be reported to Dyalog
for diagnosis.

Note that the internal error that caused the discrepancy could have occurred at any
time prior to the execution of ) SAVE and it may not be possible for Dyalog to iden-
tify the cause from this aplcore file.

If APL is started in debug mode with the —Dc, -Dw or —DW flags, the Workspace
Integrity check is performed more frequently, and it is more likely that the resulting
aplcore file will contain information that will allow the problem to be identified and
corrected.
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System Exceptions

Non-specific System Errors are the result of Operating System exceptions that can
occur due to a fault in Dyalog APL itself, an error in a Windows or other DLL, or
even as a result of a hardware fault. The following system exceptions are separately

identified.
Code | Description Suggested Action
. As the most likely cause is a temporary
AP
900 aging Fault has network fault, recommended course of
occurred .
action is to restart your program.
990 | An exception has occurred
& in the Development or Run-
991 |Time DLL.
An exception has occurred | Carefully check your [INA statement and
995 |in a DLL function called the arguments that you have passed to
via [INA the DLL function
An exception has occurred
996 |in a DLL function called As above
via a threaded ONA call
An exception has occurred
997 | while processing an
incoming OLE call
An exception has been
999 |caused by Dyalog APL or
by the Operating System

Recovering Data from aplcore files

Objects may often (but not always) be recovered from aplcore using ) COPY. Note
that because (by default) the aplcore file has no extension, it is necessary to explic-
itly add a dot, or APL will attempt to find the non-existent file aplcore. DWS, i.e.

)COPY aplcore.
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Reporting Errors to Dyalog

If APL crashes and saves an aplcore file, please email the following information to
support@dyalog.com:

1. a brief description of the circumstances surrounding the error

2. details of your version of Dyalog APL: the full version number, whether it
is Unicode or Classic Edition, and the BuildID. This information appears in
the Help->About box; the Copy button copies this information into the clip-
board, from where it can be pasted into an email etc.

3. the aplcore file itself

If the problem is reproducible, i.e. can be easily repeated, please also send the appro-
priate description, workspace, and other files required to do so.

System Error Dialog Box

The System Error Dialog illustrated below was produced by deliberately inducing a
system exception in the Windows DLL function memcpy () . The functions used

were:

Vv foo
[1] goo

\'4

V goo
[1] hoo

\'4

V hoo
[1] crash

\'

V crash

[1] [ONA'dyalog32|MEMCPY u u u'
[2] MEMCPY 255 255 255
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-

Dyalog APL/W version 13.0.7041.0

An exception haz occurred in an external DLL.
|n warkspace [process [D:23660]
Syzermar; 995 code: O
Interpreter BuildiD: 0x515930699
|nterpreter Created: Feb 1 2017 at 18:35:07
Interpreter Yersion 13.0.7841.0
Senal Mumnber ; 000042

If you chooze to generate an aplcore, it will be zaved az: "'C:A\Documents and
SettingzhPetehaploore',

[t may be poszible to retrieve local varables and other objects from thiz file using [JCY,

APL Stack trace-=

#.crash[2] MEMCPY 255 255 255
#.hoall] crazh

#.goo0[1] hoo

#.foo[l] goo

[ Generate complete image core
[ Create trappable error

[v Create an aplcore file

LCopy to clipboard |

[ Pasz exception on to operating system Conbinue
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Options
Item Parameter Description
t . .
g)?leitz Dumps a complete core image with the
. P CreateAplCoreonSyserror | User Mode Process Dumper (a
image .
Microsoft tool) - see below.
core
If you check this box (only enabled on
Create System Error codes 995 and 996), APL
Trappable will not terminate but will instead
Error generate an error 91 (EXTERNAL DLL
EXCEPTION) when you press Dismiss.
Create an . .
If this box is checked, an aplcore file
aplcore CreateAplCoreonSyserror | .
will be created.
file
Pass
exception If this box is checked, the exception
on to PassExceptionsToOpSys |will be passed on to your current
operating debugging tool (e.g. Visual Studio).
system
Copy to Copies the contents of the APL stack
clipboard trace window to the Clipboard.

Generate complete image core

The Generate complete image core option attempts to execute [SYSDIR]
\userdump.exe,where [SYSDIR] isthe windows system directory (typically
c:\windows\system32, and userdump . exe is the User Mode Process Dumper, a
Microsoft tool that can be downloaded from the following url (which you may copy
from Winhelp and paste into a browser):

http://www.microsoft.com/downloads/details.aspx?
FamilyID=e23cd741-d222-48df-9cd8-28796f414256&DisplayLang=en

The process creates a file called dyalog.core in the current directory. This file con-
tains much more debug information than a normal aplcore (and is much larger than
an aplcore) and can be sent to Dyalog Limited (zip it first please). Alternatively the
file can be loaded into Visual Studio .Net to do your own debugging.
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Debugging your own DLLs

If you are using Visual Studio, the following procedure should be used to debug
your own DLLs when an appropriate Dyalog APL System Error occurs.

Ensure that the Pass Exception box is checked, then click on Dismiss to close the Sys-
tem Error dialog box.

The system exception dialog box appears. Click on Debug to start the process in the
Visual Studio debugger.

After debugging, the system exception dialog box appears again. Click on Don't
send to terminate Windows' exception handling.

ErrorOnExternalException Parameter

This parameter allows you to prevent APL from displaying the System Error dialog
box (and terminating) when an exception caused by an external DLL occurs. The fol-
lowing example illustrates what happens when the functions above are run, but with
ErrorOnExternalException set to 1.

0«2 ONQ'.' 'GetEnvironment'
"ErrorOnExternalException’
1
foo
EXTERNAL DLL EXCEPTION
crash[2] MEMCPY 255 255 255
A

QOEN
91

)SI
crash[2]x*
hoo[1]
goo[1]
foo[1]
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Chapter 2:

The APL Environment

Introduction

The Dyalog APL Development Environment includes a Session Manager, an Editor,
and a Tracer all of which operate in windows on the screen. The session window is
created when you start APL and is present until you terminate your APL session. In
addition there may be a number of edit and/or trace Windows, which are created and
destroyed dynamically as required. All APL windows are under the control of Win-
dows and may be selected, moved, resized, maximised and minimised using the stand-
ard facilities that Windows provides.

APL Keyboards

The Classic and Unicode Editions of Dyalog APL for Windows use different tech-
niques for mapping keystrokes to APL characters and to special command shortcuts.

The Classic Edition uses a proprietary technique for these mappings. The Unicode
Edition uses Microsoft’s IME (Input Method Editor) technology. Many other appli-
cations use the same technology, which means that the Dyalog Unicode IME may be
used not only with Dyalog APL for Windows Unicode Edition, but also with word
processing applications, spreadsheets, terminal emulators etc. Therefore with the Dya-
log Unicode IME installed, and with a suitable font selected, APL characters can be
entered and viewed in many other applications.

In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.

For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the key-
strokes which define special command keyboard shortcuts. For further details, see
"Unicode Edition Keyboard" on page 66 or "Classic Edition Keyboard" on page 71
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Unicode Edition

Previous Unicode Editions of Dyalog APL used the Dyalog Ctrl or Dyalog AltGr
keyboard or the old IME to enter APL characters. With Version 13.2 the Dyalog Ctrl
and Dyalog AltGr keyboards are no longer issued and the Dyalog Unicode IME is
the sole input mechanism for APL characters. The Dyalog Unicode IME can be used
with previous Unicode Editions of Dyalog APL provided that they are patched to a
Version created on or after 15¢ April 2011.

Note that previous versions of Dyalog APL included the Comfort on-screen key-
board; which has been withdrawn.

Further details and a list of languages supported are described in the Dyalog Unicode
IME section below.

Classic Edition

The mapping for each of the [JAV positions and its associated keystroke is defined by
a selectable translate table. JAV includes all the APL symbols used by Dyalog APL
as well as all the (non-APL) characters which appear on a standard keyboard. This
mapping only works with Classic Edition.

The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.

The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Dyalog Unicode IME

The Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.
Only keystrokes which resolve to characters that either do not appear on the standard
keyboard or which differ from those that appear on the standard keyboard are
included in the selectable translate table. In effect the Dyalog Unicode IME can be
regarded as an overlay of the standard keyboard which contains just APL characters.

Dyalog intends to extend the Dyalog Unicode IME to include a mechanism that will
allow any overstrike combination to be added, and that the Dyalog Unicode IME
will be made freely available and not be reserved just for Dyalog APL users.

This new Dyalog Unicode IME replaces the previously issued IME, as well as the
Dyalog Ctrl and Dyalog AltGr keyboards.

The Dyalog Unicode IME supplied with Version 13.2 includes support for Danish,
Finnish, French, German, Italian, Swedish and British and American English key-
boards, based on the Version 12.1 Dyalog Ctrl layouts.
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The Dyalog Unicode IME also has support for the Danish, British and American Eng-
lish physical keyboards, which are available from Dyalog Ltd. It also includes sup-
port for Spanish and German keyboards based on the layout of the Dyalog hardware
keyboard.

The default keyboard mapping for unsupported languages is American English.

The IME translate tables include mappings for the special command keystrokes used
by Dyalog APL.

These command keystroke mappings are ignored by applications unless the appli-
cation is explicitly named in the Dyalog Unicode IME configuration. It is expected
that only terminal emulators used for running UNIX-based versions of Dyalog APL
will use this feature.

In particular, Dyalog APL for Windows Unicode Edition does not use the mappings
in the translate tables; the mappings are defined under Options/Configure/Keyboard
Shortcuts (see "Keyboard Shortcuts Tab" on page 135).

To allow you to identify which IME you are using, the Dyalog Unicode IME uses a
different icon to that used in previous Versions as shown below:

The Dyalog Unicode IME ﬁl

The old APL IME m

Session Manager

The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them. Functions
and variables can be stored in the session namespace. This is independent of the
active workspace; so there is no conflict with workspace names, and your utilities
remain permanently accessible for the duration of the session. Finally, you may set
up different session configurations for different purposes which can be saved and
loaded as required.

The session window is defined by an object called JSE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status bars
on the session window are in fact MenuBar, ToolControl and StatusBar objects
owned by [JSE. All of the other components such as menu items and tool buttons are
also standard GUI objects. You may use [JWC to create new session objects and you
may use OWS to change the properties of existing ones. OWG and OWN may also be
used with JSE and its children.
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Components of the session that perform actions (Menultem and Button objects) do so
because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be per-
formed by Dyalog APL/W. These are coded as keywords within square brackets. For
example, the system operation [WSClear] producesa clear ws, after first dis-
playing a dialog box for confirmation. You may customise your session by adding or
deleting objects and by attaching system operations or APL expressions to them.

Like any other object, [JSE is a namespace that may contain functions and variables.
Furthermore, (JSE is independent of the active workspace and is unaffected by )
LOAD and ) CLEAR. It is therefore sensible to store commonly used utilities, par-
ticularly those utilities that are invoked by events on session objects, in [JSE itself,
rather than in each of your application workspaces.

The possibility of configuring your APL session so extensively leads to the require-
ment to have different sessions for different purposes. To meet this need, sessions are
stored in special files with a .DSE (Dyalog Session) extension. The default session
(i.e. the one loaded when you start APL) is specified by the session_file parameter.
Y ou may customise this session and then save it over the default one or in a separate
file. You can load a new session from file at any stage without affecting your active
workspace.

Positioning the Cursor

The cursor may be positioned within the current APL window by moving the mouse
pointer to the desired location and then clicking the Left Button. The APL cursor
will then move to the character under the pointer.

Selection

Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple lines,
the use of the left mouse button always selects text from the start of the line. A con-
tiguous block of text can be selected by dragging with the right mouse button.

Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling

Data can be scrolled in a window using the mouse in conjunction with the scrollbar.
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Invoking the Editor

The Editor can be invoked by placing the mouse pointer over the name of an editable
object and double-clicking the left button on the mouse. If you double-click on the
empty Input Line it acts as "Naked Edit" and opens an edit window for the sus-
pended function (if any) on the APL stack. For further details, see "Invoking the
Editor" on page 211. See also "DoubleClickEdit " on page 18.

The Current Object

If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property of
the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or click
a button that executes code that accesses the name.

The Session Pop-up Menu

Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.

Drag-and-Drop Editing

Drag-and-Drop editing is the easiest way to move or copy a selection a short distance
within an edit window or between edit windows.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loca-
tion.

3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.
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Interrupts

To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Altematively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.

Unicode Edition Keyboard

Introduction

Unicode Edition supports the use of standard Windows keyboards that have the addi-
tional capability to generate APL characters when the user presses Ctrl, Alt, AltGr (or
some other combination of meta keys) in combination with the normal character
keys.

Version 13.2 is supplied with the Dyalog Unicode IME keyboard for a range of dif-
ferent languages as listed below. These keyboards have the same mappings as the
Dyalog Ctrl keyboard layouts used in Version 12.1. The intention is that only APL
characters and characters that appear in locations different from the underlying key-
board are defined; any other keystroke is passed through as is.

Installation

During the Installation of Dyalog Version 13.2 Unicode Edition, setup installs the
Dyalog Unicode IME (IME). For any given Input Language the IME consists of an
additional service for that Input Language, and a translate table which maps key-
strokes for the appropriate keyboard to Unicode code points for APL characters

An IME service is installed for every Input Language that the user who installs Dya-
log APL has defined, as well as every Input Language for which Dyalog has support.

The keyboard mappings are defined for the following national languages:

e Danish, Finnish, French, German, Italian, Swedish and British and American
English keyboards (based on the Dyalog APL Version 12.1 Ctrl layouts)

e Danish, British and American English physical keyboards, as supplied by
Dyalog Ltd.

e German and Spanish keyboards based on the Dyalog hardware keyboard lay-
out

For any other Input Language the American English translate table is selected. Note
that some Input Languages are defined to be substitutes for other Input Languages;
for example Australian English Input is a substitute for American English Input, Aus-
trian German Input a substitute for German German Input. In these cases the IME will
install the appropriate translate table. It is also possible to create support for new lan-
guages or to modify the existing support. See the IME User Guide for further details.
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Configuring the Dyalog APL IME

The following description uses screenshots taken from a Windows 7 PC with three
Input Languages configured for the current user: English (United Kingdom) - the
default Input Language, Danish (Denmark) and English (United States).

The Dyalog Unicode IME is added as an additional service to all keyboards defined
to the user and the administrator at the time that the IME was installed.

For each IME the underlying keyboard layout file will be the same as that defined for
the base keyboard. The layout file is a DLL created by Microsoft.

The language specified in the description of the IME is the name of the IME translate
table that has been associated with the IME for the specific keyboard. In the case of
languages not supported by the IME the keyboard will default to en-US. With the
IME as supplied with Version 13.2 altering this text requires editing the appropriate
Registry value.

The IME may be configured from within APL or from Windows.

From within Dyalog APL

To change the properties of the IME go to Options/Configure/Unicode Input tab
and select Configure Layout:

B Dyalog APL/W Configuration
Trace/Edit ] Auto Complete ] SALT ] Uzer Commands ] Obiject Syntax ]
General Unicode Input ] Kepboard Shortouts ] Wwiotkspace ] Windows ] Session ] Log ]

[ipalog can automatically load your selected keyboard when the sezzion window iz made wvisible:

I Show kepboards for all languages

Keyboard:

| Dyalog APL IME [en-GE] |

LConfigure Lapout, ..

(]9 | Cancel




68 Dyalog APL/W User Guide

From Windows

Right click on either the Input Language icon or the Keyboard layout icon in the
TaskBar and select Settings:

Restore the Language bar
Addioral icons i taskbar

Adjust the Language band position

v Auto Adjust
Settings...

Bh

General | Language Bar | Advanced Key Seftings |

Default input language

Select one of the installed input languages to use as the default for all input
fields.

| Englsh (United Kingdem) - United Kingdom -

Imstalled services

Select the services that you warnt for each input language shown in the list.
|z the Add and Remove buttons to modify this list.

English {United Kingdom) i
“...#55 Keyboand E
-~ = United Kingdom
-« = [hyalog APL IME (enGEB}
B Danish {Denmark)
.‘él Keyboard i {
- = [anizh
- = Dyalog APL IME {da-DK}
English {United States}
- Keyboard / Move Lip
w5
~ » [yalog APL IME (en-LU5} =|| Mave Down

m

S ]
METITVE

Propeties.

[ ok ][ cancet || ooy
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To alter the configuration of any of the installed IMEs, select that IME and click on
Properties:

Dyalog APL Input Method Editor Properties

| A bt ]

|nput Tranzlate Table:

C:%Program FileshDyaloghU nicodel ME \aplkeyshen-GE. din Browsze. ..

[v Enable Overstrikes
[ Owerstrikes do nat require the '05" introducer key [experimental]

[vw Usze Overstike popup

QE. | Cancel

Input translate table:

The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create sup-
port for new keyboards by altering the translate table, or by selecting a different trans-
late table. See the IME User Guide for more details.

Overstrikes:

In the original implementations of APL, many of the special symbols could only be
generated by overstriking one character on top of another as is reflected in the appear-
ance ofthe glyphs. For example, the symbol for Grade Up (4) is actually the symbol
for delta (A) superimposed on the symbol for vertical bar (1)

In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example 4 may be gen-
erated using Shift+Ctrl+4, or by switching to Replace mode and typing the three key-
strokes Ctrl+h, Left-Cursor, Ctrl+m.

Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike Introducer
Key (key code OS).
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Use Overstrike popup:

With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last char-
acter typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

b CLEAR WS - Dyalog APL/W N o [ 2 |3
File Edit View Windows 5Session Log Action™ Options Tools Threads

-

Help
ws O =0 @ Object B! HH ?& i%) b £ || Tool :El:lrt_ Session
Language Bar g x] %J

B[ B[] [TEFEY FEEFRERR (REE & 3

i 5

F

Editar

Debugger B8l x|
Ready... Rep |NUM '
CurObj: & {Ur [E:=1 Obq:0 |[OTRAP |OS5I:0 |[OI0:1 |[OML:0

Note the fine (red) line under the A in the Session window. This indicates that an
overstrike creation operation is in progress.

The input of the symbol A can be completed by pressing Ctrtm, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down
Overstrikes do not require the OS introducer key (exper-
imental):

With this option selected, the IME identifies characters which are part of a valid over-
strike, and when such a character is entered into the session, begins an overstrike cre-
ation operation. This mode is experimental in the IME supplied with Version 13.2.
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Classic Edition Keyboard

The standard Version 13.2 Classic Edition keyboard tables are files supplied in the
aplkeys sub-directory named cc.din where cc is the standard 2-character country
code,e.g. uk.din.

Note that the standard tables do not support the entry of APL underscored characters
AABCDEFGHIJKLMNOPQRSTUVWXYZ.

The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

Unified Layout

The following picture illustrates the standard UK keyboard Unified layout.

File Edt View Keyboard Options Help

| F1| F2| P3| Fra Fs

|1 2|af4]|s|e]|7|8fa]of-]=]
| o] ulefr|t]|u|ov]i]ofel|c|al

| ol s|afe]ofn]|ofwfa]:]f]u]

o0 5] 5= ) ]

Fe | F7| F8 | Fa| F1o| F11| Fiz

Exec

r ctr1| | {Blank} | r ] r Ctr]|

| MO 5 M1

C:\Program Files\DyaloghDiyalog 4PL 12,1 Classichaplkeysuk.din - Keyboard=UIE = 241
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APL symbols are entered using the Ctrl and Ctrl+Shift keys as illustrated below.

File Edt View Keyboard Options Help
Esc | F2s| F2s| F27| 28| F2s| Fao| Fa1| Faz| Fas| Fa4| Fas| Fas|
2 0 S ) ) = ) e ) ) )

Exec
ol I N N N N N N I

b e r ) fe ] afe ] o] e] =] |
L 2 N Y S O AT Y I
v ctrl | | {Blank> | Fiaiter | = ctrl |
| C MO G M

|C:\Program Files\Dyalog\Dyalog APL 121 Classichaphkeys\uk din - Kegboard=UK* | 24.1

File Edt View Keyboard Options Help

2221 o

- e

|
l!lo
|

| =] 3] ¢ ¢] ] l-l’ﬁlﬁl-lﬂlE
- xec
2 1 I | =| | =]o]o]
(20 N U 0 N N
AL B I T I Y Y A
v Cctrl | | {Blank} | roaiter | @ ctr |
| C MO G oM

\C:\Program Files\Dyalog\Dyalog APL 12.1 Classichapkeys\uk.din - Keyboard=UK * 24,1
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Traditional Layout

The following picture illustrates the standard UK keyboard Traditional layout.

Fle Edt Vew Keyboard Options Heb
esc| F1| F2| Fa| Fa| Fs| Fe| F7 | F8 | Fa| Fio] F11] Fi2f

| 1] 2| 3] afs]e|r]efs|of ||
o] ] o] o) e | ] -

| e s| o]l F]s|u]a]k]]c] ]«

e | e|lz|x|c|luls|n|n|.].| ]rt]
I ctrl | | {Blank> | miaiter | Fictrl|
| cw cwn

|L'.t‘-Frogm Files\DyaloghDyalog APL 12.1 Classichaplkeys\ud. din - Keyboard=UK, * 241

APL symbols are entered using the Shift and Ctrl+Shift keys as illustrated below.

Fle Edt View Keyboard Options He
Esc | F13| F14| F1s| F1e] F17| Fi8| F1s| F2o| F21| F22| F23| F24]

o ] e e ]
Sl N 3 N N N Y BN Y

S S N S N I -1 S N

2 I I I N X

Exec

u

I ctrl | | {Blank> | mauter | I ctel |

[ FMo O
|C:\Program Fies\DyaloghDyalog APL 12.1 Classichapkeys\uk.din - Keyboard=UK " | |24
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Fle Edt View Keyboard Options Hel
R N O O N o v o v v
LAl B Lol el fo [ e ol ]
T Y O T I Y i
AN Y Y L U
A N Y U O AN N N
@ ctrl | | (Blank> | m | # ctr1|
| & MO M
C:\Program Files\Dyalog\Dyalog APL 12.1 Classichaplkeys\uk.din - Keyboard=UK * 241

Line-Drawing Symbols

Classic Edition includes 12 single-line graphics characters for drawing lines and
boxes. Line-drawing characters are entered using the keys on the numeric keypad in
conjunction with the Ctrl key as shown below. Num Lock must be on.

Normal Ctrl
7 8 9 r T L
4 5 6 |- .|_ _I
1 ) 3 L 4 d
0 : | —

Note:to accommodate other characters, line-drawing symbols are located in the non-
printable area of the font layout. Although these characters can normally be used in
output to the session (function: DISP in the UTIL workspace uses them), many
printer drivers and some display drivers will not display characters from these
positions in the font.
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Keyboard Shortcuts

The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that
produces a symbol.

Unicode Edition

Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of Dya-
log APL, these are identified by 2-character codes; for example the action to start the
Tracer is identified by the code <TC>, and mapped to user-configurable keystrokes.

In the Unicode Edition, Keyboard Shortcuts are defined using Options/Con-
figure/Keyboard Shortcuts and stored in the Windows Registry. Note that the Uni-
code IME translate tables have definitions for the Keyboard Shortcuts too; these are
ignored by the interpreter, and are intended for use with terminal emulators being
used in conjunction with non-GUI versions of Dyalog APL.

To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon

. If you hover the mouse over this icon, a pop-up tip is displayed to remind you of
your keyboard shortcuts as illustrated below.

S5 CLEAR WS - Dyalog APL/W M=
File Edit View Windows Zession Log Action Options Tools Threads Help
ws [1 = 08 E & | Object B B 55 b x| [ Tool @ G) B W Edt X Ca || Session [ [APL3IBS Unicode v |[ 16—

Language Bar o=l ﬁ
[T TTe®RlT] (AUl FREREREEE [AH=PIRE] [flo<] LETelelele] [EELT] [ofelel#] [laflull] = @
[Dyalog APL/W Wersion 13.0.7841
Serfal Mo : 0000LZ A
Unicode Edition (@ Other Keyboard Shortcuts
E;z’;zgegzelgfg:?ﬁmgzi1E”'ld QT: Quit (and lose changes): Shift+Esc

' TB: Tab between windows: (Nane)
clesr ws ET: Back Tab between windows: (Nane)

EP: Exit (and save changes): Esc

RS: Right Screen: (Mane)

LS: Left Screen: (Nane)

CT: Cut: (None)

CP: Copy: (Naone)

PT: Paste: (None)

RD: Reformat: Hum divide

DK: Delete Block: Control+Delete

FD: Foruard or Redo: Control+Shift+Enter

BK: Backward or Undo: Control+Shift+Back

SC: Search: (Nane)

RP: Replace: (Nane)

NK: Next: (Nane)

PV: Previous: (None)

ED: Edit: Shift+Enter

TC: Trace: Control+Enter

FX: Fix the current function: (None)

LH: Toggle Line numbers: Hum -

BH: Run to exit (in tracer): (None)

BP: toggle breakpoint: (Nane)

RM: Resume execution (in tracer): (None)

TL: toggle localisation: Control+Up

UA: undo all changes: (Nane)

A0: Add comments: (Nane)

DO: Del comments: (None)

BL: Bo to Line: (Nane)

TO: Toggle outline: (Nane)

MO: Boto matching outline: (Nane)

S1: Exit script and fix entire seript:  (None)

$2: Exit script and only fix functions: (None) 8
B i i B =

bebugger 0S: Begin overstrike sequence: (None) e

Ready...

CurObj: a:1 Ope:o [OTRAP DsI:o [Oro:i [DML:o
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Classic Edition

Commands fall into four categories, namely cursor movement, selection, editing

directives and special operations, and are summarised in the following tables. The
input codes in the first column of'the tables are the codes by which the commands are
identified in the Input Translate Table.

Table 1: Cursor Movement Commands

Input .

Code Keystroke Description

LS Ctrl+PgUp Scrolls left by a page

RS Ctrl+PgDn Scrolls right by a page

us PgUp Scrolls up by a page

DS PgDn Scrolls down by a page

LC Left Arrow Moves the cursor one character position to the left

RC Right Arrow Moves the cursor one character position to the
right

DC Down Arrow Moves t.he cursor to the currenF character position
on the line below the current line

uc Up Arrow Moves t_he cursor to the curreth character position
on the line above the current line

UL Ctrl+ Home M.ove the cursor to the top-left position in the
window

DL Ctrl+End Move.s the cursor to the bottom-right position in
the window

RL End Moves the cursor to the end of the current line

LL Home Moves the cursor to the beginning of the current
line

LW Ctrlt Left Arrow Moves the cursor to the beginning of the word to
the left of the cursor

Ctrl+Right Moves the cursor to the end of the word to the
RW .
Arrow right of the cursor
TB Ctrl+Tab Switches to the next session/edit/trace window
BT Ctrl+Shift+Tab | Switches to the previous session/edit/trace window
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Table 2: Selection Commands

Input N
Code Keystroke Description
Le Shifi+ Left Arrow Extends the selection one character position to
the left
Re Shift+Right Extends the selection one character position to
Arrow the right
Ctrl+Shift+Left | Extends the selection to the beginning of the
Lw
Arrow word to the left of the cursor
Ctrl+Shift+Right | Extends the selection to the end of the word to
Rw .
Arrow the right of the cursor
Uc Shift+Up Arrow Eth—‘:I.ldS the sele(j‘tlon to the current cha.racter
position on the line above the current line
De Shift+Down Extends the selection to the current character
Arrow position on the line below the current line
Ll Shifi+ Home Extends .the selection to the beginning of the
current line
RI Shifi+End Extends the selection to the end of the current
line
Ul Ctrl+ Shift+ Home Extel.lds the gelectlon to the beginning of the first
line in the window
DI Ctrl+Shift-End Exten.ds the selection to the end of the last line in
the window
Us Shift+PgUp Extends the selection up by a page.
Ds Shift+PgDn Extends the selection down by a page
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Table 3: Editing Directives

g?;et Keystroke Description
DI Delete Deletes the selection
Del he current line in an Edit win .
DK Ctrl+Delete Dzl::z ;efez?edeliiles ?n thi Se:sito:;v LS;.W
CT Shifi+ Delete E{I?Ir:;oox;iz the selection and copies it to the
CP Ctrl+Insert Copies the selection into the clipboard
FD Ctrl+Shift+Enter | Reapplies the most recent undo operation
BK Ctrl+Shift+Bksp | Performs an undo operation
PT Shifi+ Insert C(?pies the contents .of the clipboard into a
window at the location selected
OP Ctrl+Shifi-Insert :Ls:r(t:dziltzia;rll(bl/i)ne immediately after the current
HT Tab Indents text
TH Shift+Tab Removes indentation
RD Keypad-slash Reformats a function (editor only)
TL Ctrl+Alt+L Toggles localisation of the current name
GL Ctrl+Alt+G Go to [line]
AO Ctrl+Alt+, Add Comments
DO Ctrl+Alt+. Delete Comments
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Table 4: Special Operations

21(?(111: Keystroke Description

IN Insert Insert on/off

LN Keypad-minus | Line numbers on/off
ER Enter Execute

ED Shift+Enter Edit

TC Ctrl+Enter Trace

EP Esc Exit

QT Shift+Esc Quit
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The Session Colour Scheme

Within the Development Environment, different colours are used to identify different
types of information. These colours are normally defined by registry entries and may
be changed using the Colour Configuration dialog box as described later in this chap-
ter. In the Classic Edition, colours may alternatively be defined in the Output Trans-
late Table (normally WIN.DOT). This table recognises up to 256 foreground and 256
background colours which are referenced by colour indices 0-255. These colour
indices are mapped to physical colours in terms of their Red, Green and Blue inten-
sities (also 0-255). Foreground and background colours are specified independently
as Cnnn or Bnnn. For example, the following entry in the Output Translate Table
defines colour 250 to be red on magenta.

C250: 255 0 O + Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of data
in edit windows.

Table 5: Default Colour Scheme - Session

Colour |Used for Default

249 Input and marked lines Red on White

250 Session log Black on White

252 Tracer : Suspended Function Yellow on Black

253 Tracer : Pendent Function Yellow on Dark Grey
245 Tracer : Current Line White on Red

Table 6: Default Colour Scheme Edit windows

Colour |Array Type Editable |Default

236 Simple character matrix Yes Green on Black
239 Simple numeric No White on Dk Grey
241 Simple mixed No Cyan on Dk Grey
242 Character vector of vectors Yes Cyan on Black
243 Nested array No Cyan on Dk Grey
245 0OR object No White on Red

248 Function or Operator No White on Dk Cyan
254 Function or Operator Yes White on Blue
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Syntax Colouring in the Session

As an adjunct to the overall Session Colour Scheme, you may choose to apply a syn-
tax colouring scheme to the current Session Input line(s). You may also extend syn-
tax colouring to previously entered input lines, although this only applies to input
lines in the current session; syntax colouring information is not remembered in the
Session Log.

Syntax colouring may be used to highlight the context of names and other elements
when the line was entered. For example, you can identify global names and local
names by allocating them different colours.

"Colour Selection Dialog" on page 157 for further details.
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The Session Window

The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as the
session log. Normally, the session window will have a menu bar at the top with a
tool bar below it. At the bottom of the session window is a status bar. However, these
components of the session may be extensively customised and, although this chapter
describes a typical session layout, your own session may look distinctly different. A
typical Session is illustrated below.
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A typical Session window

Window Management

When you start APL, the session is loaded from the file specified by the session_file
parameter. The position and size of the session window are defined by the Posn and
Size properties of the Session object OSE, which will be as they were when the ses-
sion file was last saved.

The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or ) LOAD another.

You can move, resize, minimise or maximise the Session Window using the standard
Windows facilities.
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In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows. You
may dock and undock these windows as required. The standard Session layout illus-
trated above, contains docked Editor, Tracer and SIStack windows.

Note that the session window is only displayed when it is required, i.e. when APL

requests input from or output to the session. This means that end-user applications

that do not interact with the user through the session, will not have an APL session
window.

Docking

Nearly all of the windows used in the Dyalog APL IDE may be docked in the Ses-
sion window or be stand-alone floating windows. When windows are docked in the
Session, the Session window is split into resizable panes, separated by splitters. The
following example, using the Status window, illustrates the principles involved.
(The use of the Status window is described later in this Chapter.)

To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)
window as shown below.
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If you press the left mouse button down over the Status window title bar, and drag it,

you will find that when the mouse pointer is close to an edge of the Session window,
the drag rectangle indicates a docking zone as shown below. This indicates the space
that the window will occupy if you now release the mouse button to dock it.
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The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session log
window in the lower pane. You can resize the panes by dragging with the mouse.

You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked
window.
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,

which is used to restore the pane to its original size.
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You can pick up a docked window and then re-dock it along a different edge of the
Session as illustrated below.

S5 CLEAR WS - Dyalog APLIW M [=1%]
File Edt View Windows Session Log Action Options Tools Threads Help
ws [0 5 08 I & [ Obiect B B S5 VOB b B2 @ 1k |[Tool @ G [ 3 |[Edt B (B o0 o || Session 0 PP Uricede <[ 152
Language Bar Zlelx| ﬁ
FELEEEERET (ML FEEE] [=FORE [l N 3 . e e D R ==
Dyalog APL/W - Status TN
yalog APL/W Wersion 13.0.7841
erial Mo @ 000042
nicede Edition
re-relsase Development Build
ed Feb 02 15:22:14 2011
lear ws
]
5
Debugger =i=TE T
| [Ready. .. Ins
“CurObj: [a:1 |Oba:o |[OTRAP [OSI:0 [OI0:1 OML:0

Docking the Status window along the left edge of the Session causes the Session win-
dow to be split into two vertical panes. Notice how the title bar is now drawn ver-
tically.
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If you click the right mouse button over any window, its context menu is displayed.
Ifthe window is dockable, the context menu contains the following options:

Undocks the docked window. The window is displayed at

Undock .. . . . .

ndoc whatever position and size it occupied prior to being docked.
Hlde. Hides the title bar of the docked window,
Caption

Specifies whether the window is currently dockable or is locked
Dockable | in its current state. You can use this to prevent the window from
being docked or undocked accidentally.

The last picture shows the effect of using Hide Caption to remove the title bar. In this

state, you can resize the pane with the mouse, but the Minimise, Maximise and Close

buttons are not available. However, you can restore the object's title bar using its con-
text menu.

15 CLEAR WS - Dyalog APL/W g@

File Edt View Windows Session Log Action Options Tools Threads Help

ws [ = 08 I ] || Object B B Bg ¥ i b2 @ L: |Tool @ G B W Ede By XY Ca || Session [ |APLIE5 Unicode || 16

Lo B B

|
FLPEEREREE) [T EEEEEEER H[v[<l=T00404] [effe]ol<]~] [L=Telef=s] [FTL-Io] [mofafels] [elelofel-] &) A
Dyalog APL/W Version 13.0.7841
Serisl No @ 000042
Unicode Edition
Pre-ralease Devalopment Build
Wed Feb 02 15:22:14 2011
lear we

Minimize
Maximize
Close

UnDack

v Dackabls

v Above Session
Show Caption

Editar

Debugger Slal=|

Ready. .. Ins

CurObj: &1 obg:o  OTRAP  OSI:0 DOI0:l OML:0




Chapter 2: The APL Environment 89

Entering and Executing Expressions

Introduction

The session contains the input line and the session log. The input line is the last line
in the session, and is (normally) the line into which you type an expression to be eval-
uated.

The session log is a history of previously entered expressions and the results they
produced.

If you are using a log file, the Session log is loaded into memory when APL is started
from the file specified by the log_file parameter. When you close your APL session,
the Session log is written back out to the log file, replacing its previous contents.

In general you type an expression into the input line, then press Enter (ER) to run it.
After execution, the expression and any displayed results become part of the session
log.

You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end of the
last (i.e. the current) line in the session log. Home (LL) and End (RL) move the cursor
to the beginning and end respectively of the line containing the cursor.
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Language Bar

The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.

If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tip
is displayed to remind you of'its usage. If you click on a symbol in the Language Bar,
that symbol is inserted at the cursor in the current line in the Session.
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Auto Complete

As you start to enter characters in an APL expression, the Auto Complete suggestions
pop-up window (AC for short) offers you a choice based upon the characters you
have already entered and the current context.

For example, if you enter a [, AC displays a list of all the system functions and var-
iables. If you then enter the character r, the list shrinks to those system functions and
variables beginning with the letter r, namely Orefs,dr |, and Ort L. Instead of
entering the remaining characters, you may select the appropriate choice in the AC
list. This is done by pressing the right cursor key or (in PocketAPL) by tapping the
choice in the list.

If you begin to enter a name, AC will display a list of namespaces, variables, func-
tions, operators that are defined in the current namespace. If you are editing a func-
tion, AC will also include names that are localised in the function header.

Ifthe current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.
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As an additional refinement, AC remembers a certain number of previous auto com-
plete operations, and uses this information to highlight the most recent choice you
made.

For example, suppose that you enter the two characters ) c. AC offers you )clear
thru' ) cs, and you choose ) cs from the list. The next time you enter the two char-
acters ) c, AC displays the same list of choices, but this time ) cs is pre-selected.

You can disable or customise Auto Completion from the Auto Complete page in the
Configuration dialog box which is described later in this chapter.

Executing an Expression

To execute an expression, you type it into the input line, then press Enter (ER). Alter-
natively, you can select Execute from the Action menu. Following execution, the
expression and any displayed results become part of the session log.

Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you do
so, it will be displayed using colour 249 (Red on White), the same as that used for
the input line. When you press Enter the new line is copied to the input line prior to
being executed. The original line is restored and redisplayed in the normal session
log colour 250 (Black on White).

An alternative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwards
and forwards through the input history, successively copying previously entered
expressions over the current line. When you reach the expression you want, simply
press Enter to re-run it. These operations may also be performed from the Edit menu
in the session window.

Executing Several Expressions

You can execute several expressions, by changing more than one line in the session

log before pressing Enter. Each line that you change will be displayed using colour

249 (Red on White). When you press Enter, these marked lines are copied down and
executed in the order they appear in the log.

Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a lead-
ing space for instance.
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It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste them
back into the session using Shift+Insert (PT). Lines pasted into the session are always
marked (Red on White) and will therefore be executed when you press Enter. To
execute lines from an edit window, you use a similar procedure. First select the lines
you want to execute, then cut or copy the selection to the clipboard. Then move to
the session window and paste them in, then press Enter to execute them.

Session Print Width (PW)

Throughout its history, APL has used a system variable [JPW to specify the width of
the user's terminal or screen. Session output that is longer than [JPW is automatically
wrapped and split into multiple lines on the display. This feature of APL was
designed in the days of hard-copy terminals and has become less relevant in modern
Windows environments.

Dyalog APL continues to support the traditional use of JPW, but also provides an
alternative option to have the system wrap Session output according to the width of
the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.

Using Find/Replace in the Session

The search and replace facilities work not just in the Editor as you would expect, but
also in the Session. For example, if you have just entered a series of expressions
involving a variable called SALES and you want to perform the same calculations
using NEWSALES, the following commands will achieve it:

Enter SALES in the Find box,and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White). Now
click on the session and press Enter (or select Execute from the Action menu).

Once displayed, the Find or Find/Replace dialog box remains on the screen until it is
either closed or replaced by the other. This is particularly convenient if the same oper-
ations are to be performed over and over again, and/or in several windows. Find and
Find/Replace operations are effective in the window that previously had the focus.
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Value Tips

If you hover the mouse pointer over a name in the Session or Debugger window,
APL will display a pop-up window containing the value of the symbol under the
mouse pointer.

For example, in the following picture the mouse pointer was moved over the name of
the variable HW in the Session window.
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The next picture illustrates the Value Tip displayed when the mouse is hovered over
the name of the variable MAT.
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Similarly, if you hover the mouse pointer over the name of a function, the system dis-
plays the body of the function as a pop-up, as illustrated below.
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Configuring Value Tips

You may enable/disable Value Tips and select other options from the General tab of
the Configuration dialog box as shown below.

You may experiment by changing the value of the delay before which Value Tips are
displayed, until you find a comfortable setting.

Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.

B Dyalog APL/W Configuration
Trace/Edit ] Auta Complete ] SALT ] User Commands ] Object Syntax ]
General l Unicode |nput ] Keyboard Shortcuts ] YWwiortkspace ] ‘windows ] Session ] Log ]

Recently uzed file list size; g

v Display Value Tips after, |500 [z

Colour Scheme: |Default j

Iv Enable Native Look and Feet

[ Apply Native Look and Feel to docked captions

LConfiguration zaved in:
HEEY_CURREMT_USERSOFTWARE \DyaloghDyalog APLAY 13.0 Unicode

Ok, | Cancel
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Array Editor

The Array Editor! allows you to edit arbitrary arrays. It is invoked by either:

e Clicking the icon in the Session toolbar when the mouse pointer is over
the name of a suitable variable.

e Calling the User Command Jaedit, specifying the name of a suitable var-
iable as its argument.

e Calling it directly via [INA

The Array Editor draws data using a format that is similar to the output of the
DISPLAY function. For example:

. N
Array Editor L = | E &J

File Edit Actions Insert Options Help

Characters: |ﬁ;BCE =

Numbers : \o 1 |4 5 6 \3.14 5.6E723 (071

Scalars:

Vectors: ‘Four‘ score and seven years ago

Matrices: [1 2 3 4
5 & 7 8
g 10 11 13J
4 I )
Type: General array =: 3 =fp: 5 pp: 2 p: 51 =:

1Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2013
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Documentation

Full documentation for the Array Editor, including a list of the keystrokes it uses, is
available from the Help menu in the Array Editor's window.

Supported Arrays

The Array Editor supports arrays that consist solely of characters and/or numbers.
You may not use it to edit an array that contains an object reference or a [JOR.

Reject unsupported data

The way that the Arrays Editor reacts to unsupported arrays is determined by the
value of the Reject unsupported data option which is accessed by the
Options/Reject unsupported data menu item on the Array Editor menubar.

Ifthis is set to true (the default), and you try to edit an array containing an object ref-
erence, the Array Editor will refuse the start and the system will generate an error mes-
sage.

[SE.NumEd.numed: Unexpected error in array editor:

DOMAIN ERROR Argument contained data that is neither simple or
nested.

Ifthis option is cleared, the Array editor will start but you will not be able to do any-
thing. It is therefore advisable that you leave this option set.

Notes

e The Array Editor is supplied only with Unicode Editions of Dyalog
APL/W. Please visit www.davidliebtag.com for details about availability
and support for Classic Editions of Dyalog APL/W.

Namespaces are not supported.

Internal representations returned by [JOR are not supported.

Only one instance of the Array Editor may be executed at a time.

All calls to interpreter primitives use a value of 3 for OML.

Negative numbers must be represented using high minus signs. For example,
~3 not -3.
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Implementation

The Array Editor is implemented by a DLL named dlaedit.d11 (32-bit) or
dlaedit64.dll (64-bit).

The DLL exports two functions: DyalogEditArray and

DyalogEditArrayTit le. The latteris used when you click the the £l icon in
the Session toolbar (via the APL function JSE . NumEd. numed) and by the User
Command Jaedit

Calling the Array Editor Directly
If you wish to use the Array Editor directly, you may do so as follows using [JNA L

Forboth DyalogEditArray and DyalogEditArrayTit Le the first argument
is the array to be edited, while the second argument is a place holder and should
always be 0

ForDyalogEditArrayTit le the 3rd argument is a character vector whose con-
tents are displayed in the caption of the array editor window.

The result is the newly altered array.

Examples

ONA'dlaedit.dll|DyalogEditArray <pp >pp' A 32-bit
ONA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]' ~n 32-bit
ONA'dlaedité4.dl L |DyalogEditArray <pp >pp' A 64-bit

ONA'dlaedité4.dl L |DyalogEditArrayTitle <pp >pp <0C2[]'m 64-bit

New«DyalogEditArray Old O
New«<DyalogEditArrayTitle Old 0O Name

INote that these are not standard [INA calls, but rather use an extension to [ONA, called Direct
Workspace Access. Dyalog does not intend to make this feature generally available at present: if
you are interested in this feature please contact sales@dyalog.com.
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SharpPlot Graphics Tools

Introduction

Included with Dyalog APL (32-bit Windows versions only with the Microsoft .Net
Framework Version 2.0 or later installed) is the SharpPlot graphics library which is
part of the RainPro graphics package..

The Session includes 4 buttons which use SharpPlot to generate simple graphical pic-
tures of the contents of the Current Object (identified by the name under or to the left
of'the cursor).

For example, if you have a numerical matrix in a variable called MAT, you can plot it
by first positioning the cursor on the name MATin the Session window, and then
clicking one of'the 4 graphical buttons in the Session toolbar.

Data Structures
The charting function can plot variables with the following data structures:

a simple numeric vector

a vector of simple numeric vectors

a simple numeric matrix

a matrix whose first row contains simple character vectors and whose other

elements are simple numerics. In bar and line charts, the column headings in

row | are used as x-axis labels.

e a matrix whose first column contains simple character vectors and whose
other elements are simple numerics. In bar and line charts, the row headings
in column 1 are used as legends to annotate the different series.

e a matrix whose first row and first column both contain simple character vec-

tors and whose other elements are simple numerics. In bar and line charts,

the column headings in row 1 are used as x-axis labels, and the row head-
ings in column 1 are used as legends annotate the different series.
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Example: Bar Chart b

Wine_Prices
1961 1964 1966
Lafite 8800 1342 1210
Latour 15400 2357.5 4600
Margaux 5980 672.5 920
Mouton Rothschild 6710 713 2070
Haut-Brion 13225 1840 1323

o5 Causeway chart viewer

/o)t

File Zoom

Wine Prices
L6000

14000
12000
10000
BO00
G000+
4000 4

2000 4

0 -
1961 1964 1966

T T aour R hlargaux B Movion Rothschild [ Haui-Brion
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Example: Line Chart £

First_Growths
1961 1964 1966 1970 1975 1976 1978 ...
Lafite 8800 1342 1210 605 1380 2070 920 ...
Latour 15400 2357.5 4600 2760 1552 978 1058
Margaux 5980 672.5 920 632 900 800 1208

i Causeway chart viewer
File  Zoom
- Bl
First Growths
1 RO00
16000
14000
12000
10000
=000 4
000
4000
2000 4
D 1 ) T T 1 1 1 I T T
1964 1970 1976 | 9f1 1983 1986 1989 1994 1996 2000
—— Lafite —— Latour —— Murgaux
Implementation

The SharpPlot tools are implemented by four buttons in the Session toolbar. Each but-
ton has a Select callback which runs the function JSE .Chart.DoChart. This runs
[JSE.Chart.Do which constructs and then runs a function named
OSE.Chart.MyChart.

[SE.Chart.MyChart usesan instance of the SharpPlot graphics class to produce
a chart of your data, which it saves as a temporary file. It then calls the SharpPlot
viewer to display the file on your screen.
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SharpPlot is a library of graphical subroutines, (originally written in APL and
machine-translated into C#) which is implemented as a .Net Namespace named
Causeway and supplied in \bin\sharpplot.dll inthe Dyalog program direc-

tory.
Notes

Although SE.Chart .MyChart is overwritten by successive uses of the graphical
buttons, it is deliberately not erased each time. This allows you to use MyChart asa
simple template to develop your own custom graphics function.

The image is stored in Microsoft Enhanced Metafile Format in a temporary file
whose name and location are generated automatically. The system does not delete
the temporary file after use. For further details, See Get TempFileName in the Win-
dows documentation..

The default program used to display the EMF file is SharpView.exe. You can opt
to use a different EMF viewer by setting the Charts\ViewCMDregistry key to
name another program, such as Windows Picture and Fax Viewer.

An attempt to plot the contents of a variables with an unsupported data structure (see
above) is handled entirely by error trapping and will result in an error message box
and perhaps messages in the Status window.

The Session GUI Hierarchy

As distributed, the Session object JSE contains two CoolBar objects. The first,
named [JSE . cbtop runs along the top of the Session window and contains the tool-
bars. The second, named [SE . cbbo't, runs along the bottom of the Session win-
dows and contains the statusbars.

The menubar is implemented by a MenuBar object named JSE . mb.

The toolbars in JSE . cbt op are implemented by four CoolBand objects, bandtb1,
bandtb2,bandtb3 and bandtbk4 each containing a ToolControl named tb.

The statusbars in [JSE . cbbo't, are implemented by two CoolBand objects ,
bandtb1 and bandtb?2, each containing a StatusBar named sb.
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The Session MenuBar

The Session MenuBar (OSE . mb) contains a set of menus as follows.

The File Menu

The File menu (JSE .mb . fi le)provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents of
a typical File menu and the operations they perform are illustrated below.

Mew
open...
Copy...

Save

Save As...
Export...

Export to Memory

Drop...

Prink Setup. ..

Cankinue
Exit

1 F:ihelpll OWAPLGRES. DS
2 CAProgram Files\Crwalod)Dyalog APL 11, 00ws\WDESIGH, DS
3 CAProgram FilesiCryvalod) Dyvalog APL 11, 00wesiatkil, DS
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Table 7: File Menu Operations

Item Action Description
New [WSClear] Prompts for confirmation, then clears the
workspace
Pr e k fil hen 1
Open [WSLoad] ) ompts for a workspace file name, then loads
Prompts for a workspace file name, then
Copy [WSCopy] copies it
Save [WSSave] Saves the active workspace
Save As [WSSaveas] irompts for a workspace file name, then saves
Export [Makeexe] Creates a bound executable, an OLE Server,
p an ActiveX Control, or a .Net Assembly
E rtt .
l\/f:)n?oryo I[\S:Z:]ETT;?FY Creates an in-memory Net Assembly
Drop [WSDrop] irompts for a workspace file name, then erases
Print [PrintSetup] |Invokes the print set-up dialog box
Setup 1 P p p g
. . Saves the active workspace in
Continue | [Continuel | o\ 1NUEDWS and exits APL
Exit [Off] Exits APL
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Export

The Export... menu item allows you to create a bound executable, an OLE Server (in-
process or out-of-process), an ActiveX Control ora .Net Assembly.

The dialog box used to create these various different files offers selective options
according to the type of file you are making. The system detects which of these types
is most appropriate from the objects in your workspace. For example, if your work-
space contains an ActiveXControl namespace, it will automatically select the

ActiveX Control option.
Create bound file
Savein |L§ w3 [v] a2 e E-
E’ gﬂcalc.exe
by Recent
Docurnents
Deskiop

o,

=

My Documents

59

tdy Cornputer

File name: | CALC exne [v]

Py Metwark, Save a3 lype: | Standalone Executable [includes interpreter e:-:t[vl [ Cancel ]

Buntime application [ ] Comsole application  [¥]EE nable Native Look and Feet

Command ling:
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The Create bound file dialog box contains the following fields. These will only be
present if applicable to the type of bound file you are making.

Item Description
Allows you to choose the name for your bound file The name
File name |defaults to the name of your workspace with the appropriate
extension.
f;g: as Allows you to choose the type of file you wish to create.
If this is checked, your application file will be bound with the
Runtime Run-Time DLL. If not, it will be bound with the Development
application | DLL. The latter should normally only be used to permit
debugging.
Console Check this box if you want your executable to run as a console
. application. This is appropriate only if the application has no
application } .
graphical user interface.
Enable
Native If checked, Native Look and Feel will be enabled for your bound
Look and |file.
Feel
Allows you to associate an icon with your executable. Type in
Icon file the pathname, or use the Browse button to navigate to an icon
file.
For an out-of-process COM Server, this allows you to specify the
Command |command line for the process. For a bound executable, this
line allows you to specify command-line parameters for the
corresponding Dyalog APL DLL.
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Pressing the Version button brings up the Version Information dialog box shown
below.

This dialog box allows you to specify versioning information that will be stored in
your bound file.

— ¥ersion Information
Indentifier | Yalue |

Comments | Your comments here

CompanyM ame Your Company Mame

FileDiescription Y'our File Description

Filew ersion 1.0.0.0

Productyerzion 1.0.0.0

Productt ame

InternalM ame our Interal Filename

LeqalCopyright Copyright [C] 2005

LeqalT rademarkz Y'our Legal Trademark.z

PrivateBuild

SpecialBuild

ok | ’ Lancel
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The Edit Menu

The Edit menu (OSE .mb . edi t) provides a means to recall previously entered input
lines for re-execution and for copying text to and from the clipboard.

Back. Zkrl+Shift+Bksp
Back. Forveard Chkrl+5hift+Enter
Farward

Clear Chrl+Delete
Zuk Copy Chrl+-Insert
Copy Paste Shift+Insert
Paste Paste Unicode
Find... Paste Non-Unicode
Replace. .. Eind. ..

Unicode Edition

Replace...

Table 8: Edit menu operations

Classic Edition

Item Action Description
Displays the previous input line. Repeated
Back [Undo] use of this command cycles back through the
input history.
Displays the next input line. Repeated use of
Forward | [Redo] this command cycles forward through the
input history.
Clear [Delete] Clears the selected text
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
th ion 1 t th t location. Th
Paste [Paste] e session log at the current location. The
new lines are marked and may be executed
by pressing Enter.
Paste Same as Paste, but gets the Unicode text from
. [Pasteunicode] | the clipboard and converts to JAV. Classic
Unicode ..
Edition only.
Paste Same as Paste, but gets the ANSI text from
Non- [Pasteansi] the clipboard and converts to JAV. Classic
Unicode Edition only.
Find [Find] Displays the Find dialog box
Replace | [Replace] Displays the Find/Replace dialog box
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The View Menu

The View menu (OSE .mb . view) toggles the visibility of the Session Toolbar, Stat-
usBar, and Language Bar.

v Toolbar
v Skatusbar
v LanguageBar

Table 9: View menu operations

Item Action Description

Toolbar Shows/Hides Session toolbars

Statusbar Shows/Hides Session statusbars

LanguageBar Shows/Hides Language Bar
The Window Menu

This contains a single action (OSE .mb . windows) which is to close all of the Edit
and Trace windows and the Status window.

Close all windows

LanguageBar

Debugger
Editor k

Table 10: Window menu operations

Item Action Description

Close all Windows |[[CloseAll] |[Closes all Edit and Trace windows

Note that [CloseAl Ll ] removes all Trace windows but does not reset the State
Indicator.

In addition, the Window menu will contain options to switch the focus to any sub-
sidiary windows that are docked in the Session as illustrated above.
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The Session Menu

The Session menu (OSE .mb . session)provides access to the system operations
that allow you to load a session (JSE) from a session file and to save your current ses-
sion ((SE) to a session file. If you use these facilities rarely, you may wish to move
them to (say) the Options menu or even dispense with them entirely.

Open,..
Save
Save As...

Table 11: Session menu operations

Item | Action Description

Prompts for a session file name, then loads the session
from it, replacing the current one. Sets the File
property of JSE to the name of the file from which the
session was loaded.

Open | [SELoad]

Saves the current session (as defined by OSE) to the

S . . .
ave | [SESave] session file specified by the File property of JSE.

Prompts for a session file name, then saves the current
[SESaveas] [session (as defined by [JSE) in it. Resets the File
property of OSE.

Save
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The Log Menu

The Log menu (OSE .mb

ulate Session log files.

e
open...

Save

Save As...

Print. ..

. Log) provides access to the system operations that manip-

Table 12: Log menu operations

Item | Action Description

New |[NewLog] Pron'1pts for confirmation, then empties the current
Session log.
Prompts for a Session log file, then loads it into

Open | [OpenLog] memory, replacing the current Session log

Save |[SaveLog] Saves .the .current .Session log in the current log file,
replacing its previous contents

Save Prompts for a file name, then saves the current

[SavelLogAs] . o
As Session log in it.
Print | [PrintLog] [Prints the contents of the Session log.
The Action Menu

The Action menu (OSE .mb . act ion)may be used to perform a variety of operations
on the current object or the current line. The current object is the object whose name
contains the cursor. The current line is that line that contains the cursor. The Edit,
Copy Object, Paste Object and Print Object items operate on the current object. For
example, if the name SALES appears in the session and the cursor is placed some-
where within it, SALES is the current object and will be copied to the clipboard by
selecting Copy object or opened up for editing by selecting Edit.
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Execute runs the current line; Trace traces it.

Edit. ..
Trace...
Execute

Copy Object
Paste Ohject

Clear Stops
Interrupk
Reset

Unicode Edition

Shift+Enter
Ckrl+Enter
Enter

Edit...
Trace...
Execute

Copy Object
Paste Object

Clear Stops
Interrupt
Reset

Classic Edition

Table 13: Action menu operations

Item Action Description
Edit [Edit] Edit the current object
Executes the current line under the control of the
Trace [Trace]
Tracer
Execute | [Execute] Executes the current line
Copy . Copies the contents of the current object to the
Object [ObjCopy] clipboard.
Pas.te [ObjPaste] Pastes the .contents 01'°the' clipbogrd into the
Object current object, replacing its previous value
Print [ObjPrint] |[Prints the current object
Object ] Ject.
1
Clear [ClearTSM] Clegrs all OSTOP, JMONITOR and [JTRACE
Stops settings
Interrupt | [Interrupt ] | Generates a weak interrupt
Reset [Reset] Performs )RESET

113
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The Options Menu

The Options menu (OSE .mb.options)provides configuration options.

Chject Synkax
Line Mumbers

Zonfigure. ..
Colours, .,

Table 14: Options menu operations

k| Expose GUI Properties
Expose Foot Properties
Expose Session Properties

Murn -

Item Action Description
Expose GUI Exposes the names of properties,
Properties [ExposeGUT] methods and events in GUI objects
Exposes the names of the properties,
E R
xposev oot [ExposeRoot] methods and events of the Root
Properties .
object
Expose .
. . Exposes the names of the properties,
Session [ExposeSession]
. methods and events of [JSE
Properties

Line Numbers

[LineNumbers]

Toggle the display of line numbers in
edit and trace windows on/off

Configure

[Configure]

Displays the Configuration dialog
box

Colours

[ChooseColors]

Displays the Colours Selection dialog
box

The values associated with the Expose GUI, Expose Root and Expose Session
options reflect the values of these settings in your current workspace and are saved in

it.

When you change these values through the Options menu, you are changing them in
the current workspace only.

The default values of these items are defined by the parameters default wx, Prop-
ertyExposeRoot and PropertyExposeSE which may be set using the Object Syntax
tab ofthe Configuration dialog.
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The Tools Menu

The Tools menu (OSE .mb . tools)provides access to various session tools and

dialog boxes.

Explarer., ..
Search. ..
Skatus...
AukoSkatus
Event Viewer

Unicode Edition

Explorer...
Search...
Cbject List. ..
Status...

v AutoStatus
Ewent Yiewer

kevboard Viewer, .

Classic Edition

Table 15: Tools Menu Operations

Item Action Description

Explorer [Explorer] Displays the Workspace Explorer tool

Search [WSSearch] Displays the Workspace Search tool

Status [Status] Displays or hides the Status window
Toggle; if checked, causes the Status

AutoStatus | [AutoStatus] [window to be displayed when a new
message is generated for it

Event . . . .

. [EventViewer] | Displays or hides the Event Viewer

Viewer

Properties | [Ob jProps] Di§p1ays a property sheet for the current
object

Keyboard Displays the APLTeam Keyboard Viewer.

Viewer Classic Edition only.
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The Threads Menu

The Threads menu (OSE .mb . threads) provides access to various session tools
and dialog boxes.

show Threads. ..
Shaw Skack., ..
Shows Token Pool...
Auto Refresh

v Pause on Error
Pause all Threads
Resume all Threads
Restart all Threads

Table 16: Threads Menu Operations

Item Action Description

Show )

Threads [Threads] Displays the Threads Tool
Show Stack |[Stack] Displays the S7 Stack window
Show Token Displays the Token Pool

[TokenPool]

Pool window

Refreshes the Threads Tool on

Auto Refresh | [ThreadsAutoRefresh] .
every thread switch

Pause on

[ThreadsPauseOnError] |Pauses all threads on error
Error

Pause all

[ThreadsPauseAll] Pauses all threads
Threads

Resume all

[ThreadsResumeAl l] Resumes all threads
Threads

Restart all

[ThreadsResrartAll] Restarts all threads
Threads
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The Help Menu

The Help menu (OSE .mb . he L p) provides access to the help system which is pack-
aged as a single Microsoft HTML Help compiled help file named

help\dyalog.chm.

Dacurentation Cenker
Latest Enhancements
Language Help

L Help

Drvalog Web Site
Email Cvyalog

About Crvalog APL

Table 17: Help menu operations

Label Action Description
Opens your web browser on
Documentation help\index.html which displays an
[Decanter] . . .
Center index to the on-line PDF documentation
and selected internet links.
Opens help\dyalog. chm, starting at
Latest the first topic in the Version 13.2
[Reunites] Release Notes section. Note that
Enhancements

previous Release Notes are also
included for your convenience.

Language Help | [Lang Help]

Opens help\dyalog.chm, starting at
the first topic in the Language
Reference section.

Opens help\dyalog. chm, starting at

Gui Help [GuiHelp] the first topic in the Object Reference
section.

Dyalog Web [DyalogWeb] Opens your web browser on the Dyalog

Site home page.

Email Dyalog |[DyalogEmail]

Opens your email client and creates a
new message to Dyalog Support, with
information about the Version of
Dyalog APL you are running.

About Dyalog

APL [About]

Displays an About dialog box
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Session Pop-Up Menu

The Session popup menu (SE . popup) is displayed by clicking the right mouse but-
ton anywhere in the Session window. If the mouse pointer is over a visible object
name, the popup menu allows you to edit, print, delete it or view its properties. Note
that the name of the pop-up menu is specified by the Popup property of [SE.

Edit Shift+Enter

Zhart 2 Barchart
Linechart
Pie
Scatter

Cuk Control+

Copy Control+Insert

Paste Shift+Insert

Paste Unicods
Paste Mon-Unicode

Lime Murbers Turm -

Explorer...
Search...
Event Viewer...
Threads...
Skatus, .,
Colours. ..

Inkterrupk

Table 18: Session popup menu operations

Item Action Description
Edit [Edit] Edits the current object
Print [ObjPrint] Prints the current object
Delete [ObjDelete] Erases the current object
. Displays the Object Properties dialog box
P .
roperties | [GUIHelp] for the current object
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Item Action Description
Displays the help topic associated with the
Help [Help] current object or the APL symbol under the
cursor
Line [LineNumbers] |Toggles line numbers on/off
Numbers £g
Copy [Copy] Copies the selection to the clipboard
Pastes the text contents of the clipboard into
h ion 1 h location. Th
Paste [Paste] the session log at the current location. The
new lines are marked and may be executed
by pressing Enter.
Paste [Pasteunicode] Same as Paste, but gets the Unicode text
Unicode from the clipboard and converts to JAV
Paste
. Same as Paste, but gets the ANSI text from
Non- [Pasteansi] .
) the clipboard and converts to AV
Unicode
Explorer [[Explorer] Displays the Workspace Explorer
Search [WSSearch] Displays the Find Objects tool
Event . . .
. [EventViewer] |[Displays the Event Viewer
Viewer
Threads |[[Threads] Displays the Threads Tool
Status [Status] Displays the Status window
Colours |[[ChooseColors] |Displays the Colour Selection dialog
Interrupt | [Interrupt] Generates a weak interrupt
Open Opens the URL or link using the
lir?k [OpenLink] appropriate program. See "Underline URLs
and links" on page 129
Copy Copies the URL or link to the Windows
link to [Copy_Link] Clipboard. See "Underline URLs and links"
clipboard on page 129
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The Session Toolbars

The Session toolbars are contained by four separate CoolBand objects, allowing you
to configure their order in whichever way you choose.

wis DD E Y S
bt BB T V B a2 @ I
ool O G B A
: Edit B w2 cu
- Session (B |APL38S Unicode s || 1602

The Session tool bars

The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBarJSE . cbtop. These represent the

ToolButton images in their normal, highlighted and inactive states and are named
iln,ilhand ili respectively.

These images derive from three bitmap resources contained in dyalog.exe named
tb_normal, tb_hot and tb_inactive. The statements that create these ImageL-
ist object in function BUILD_SESSION in BUILDSE.DWS are as follows.

:With '[0SE.cbtop'’
"iln'0OWC'ImagelList'('MapCols' 0)('Masked' 1)
"iln.bm'OWC'Bitmap'('"' 'tb_normal')('MaskCol' (192 192
192))
"ilh'0OWC'ImagelList'('MapCols' 0)('Masked' 1)
"ilh.bm'0OWC'Bitmap'('"' 'tb_hot')('MaskCol' (192 192
192))
"ili'0WC'Imagelist'('MapCols' 0)('Masked' 1)
"ili.bm'OWC'Bitmap'('"' 'tb_inactive')('MaskCol'(192
192 192))
:EndWith
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[
Clear Workspace

-}

=
Load Workspace

¥
Copy Workspace

Save Workspace

Re-Export
Workspace

=

Print Workspace

Workspace (WS) Operations

Executes the system operation [WSClear ] which asks
for confirmation, then clears the workspace.

Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the
selected workspace.

Executes the system operation [WSCopy ] which
displays a file selection dialog box and copies the
(entire) selected workspace

Executes the system operation [WSSaveas ] which
displays a file selection dialog box and saves the
workspace in the selected file.

Executes the system operation [REExport] which re-
exports the workspace using the settings, parameters
and options that were previously selected using the
Create Bound File dialog.

Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace.
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Object Operations
@J
Copy Object

@J
Paste Object

58
Print Object

W
Edit Object

Edit Array

Juk

Barchart

k2

Linechart

»

Piechart

Scatterplot

Executes the system operation [Ob jCopy ] which
copies the contents of the current object to the
clipboard.

Executes the system operation [Ob jPaste] which
copies the contents of the clipboard into the current
object, replacing its previous value.

Executes the system operation [Ob jPrint] that prints
the current object.

Executes the system operation [ Edit] which edits the
current object using the standard system editor.

Executes a defined function in [JSE that edits the
current object using the Array Editor (Unicode Edition)
or a spreadsheet-like interface based upon the Grid
object (Classic Edition). See "Array Editor" on page 97.

Executes a defined function in [JSE that displays the
value of the current object in a Barchart.

Executes a defined function in [JSE that that displays
the value of the current object in a Linechart.

Executes a defined function in [JSE that that displays
the value of the current object in a Piechart.

Executes a defined function in [JSE that that displays
the value of the current object in a Scatterplot.
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Tools

By

Explorer

Q

Search

-

Line Numbers

|

Clear all Stops

Edit Operations

Copy Selection

&

Paste Selection

K
Recall Last

4 Recall Next

Executes the system operation [Explorer] which
displays the Workspace Explorer tool.

Executes the system operation [WSSearch] which
displays the Workspace Search tool.

Executes the system operation [LineNumbers]
which toggles the display of line numbers in edit and
trace windows on and off.

Executes the system operation [ClearTSM] which
clears all JSTOP, (JMONITOR and (JTRACE settings

Executes the system operation [ Copy] which copies
the selected text to the clipboard.

Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point.

Executes the system operation [Undo Jwhich recalls
the previous input line from the input history stack

Executes the system operation [Redo ] which recalls
the next input line from the input history stack.
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Session Operations

= Executes the system operation [ SELoad] which
Load Session displays a file selection dialog box and loads the

selected Session File.

APLIES Unicode + Selects the font to be used in the Session window.

Select Font

16 = Selects the size of the font to be used in the Session

Select Font Size window.
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The Session Status Bar

The session status bar is represented by two CoolBands each of which contains a Stat-
usBar object. There are a number of StatusFields as illustrated below. Your own
status bar may be configured differently.

© Ready...

Ins  Uni | HNUH

CurObj: Describe (Uariable)

g:1 OpQ:0o  OTRAP  OSI:0  0OI0:1  OHL:O H

Classic Edition
Ready... Ins = NUM
CurObj: Describe (Yariable) &1 ooa: OTRAP  OSI: Oio: ML =

Unicode Edition

The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are
summarised in the tables shown below.

Table 19: Session status fields : first row

StatusField | Style Description
hint None Displays hlpts fo'r 'the sess.10n objects, or "Ready...
when APL is waiting for input
insrep InsRep Displays the mode of the Insert key (Ins or Rep)
Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
mode KeyMode defined by the Mn= string in the Input Table.
Classic Edition Only.
Indicates the state of the Num Lock key. Displays
. NumLock it if Num Lock is on, blank if off
Indicates the state of the Caps Lock key. Displays
Lock i . .
caps CapsLoc "Caps" if Caps Lock is on, blank if off.
Displays a flashing red "Pause" message when the
pause Pause . .
Pause key is used to halt session output
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Table 20: Session status fields : second row

StatusField | Style Description
. . Displays th f th t object (th

curobj CurObj isplays the name of the curren object (the name
last under the input cursor)

e ThreadCount Dl'sp'lays thp number of threads currently running
(minimum is 1)

dqlen DQLen Displays the number of events in the APL event
queue

trap Trap Turns red if OTRAP is set

si SI Displays the length of JSI. Turns red if non-zero

. Displays the value of JI0. Tums red if JIO is

io 10 .
not equal to the value of the default_io parameter
Displays the value of OML. Tums red if OML is

ml ML not equal to the value of the default ml
parameter

Toggle Status Fields

In the default Session files distributed with this release, the Statusfields used to dis-
play the value of JI0, the state of the Insert key (Ins/Rep) and the current keyboard
mode (e.g. Apl/Uni) have callback functions attached to MouseDbIClick. This
means that you can toggle the state of these fields by double-clicking with the left

mouse button.

If you dislike this behaviour, you may set the Event property of the Statusfields to 0
and re-save the Session file. Alternatively, you may modify BUILDSE.DWS and
rebuild the Session from scratch.
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The Configuration Dialog Box

General Tab
B Dyalog APL/W Configuration
Trace/Edit ] Ato Complete ] SALT ] Usger Commands ] Object Syntax ] Met Framework. ]

General l Unicade Input ] Keyboard Shortouts ] Workspace ] Help # D ] Windows ] Session ] Log ]

Recently uzed file list size: q

v Display ‘alue Tips after; |500 [mz)

Colour Scheme: Default -

[¥ Enable Mative Look and Fest ¥ Underline URLs and links

[ Apply Native Look and Feel to docked captions

Configuration zaved in:
HEEY_CURREMT_USERMSOFTWAREYDyalogsDyalog AFLAW 131 Unicode

(]9 | Cancel
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Table 21: Configuration dialog: General

Label Parameter Description
. Determines whether or not line
Show line . . . .
lines on functions numbers are shown in edit/trace
numbers - -

windows

Recently used
file list size

file stack size

Specifies the number of the most
recently used workspaces
displayed in the File menu.

Display Value

Specifies the delay before APL
will display the value of a

. ValueTips/Delay variable or the code for a function
Tips after
when the user hovers the mouse
over its name.
Specifies the colour scheme used
ValueTips/ to display the value of a variable
Colour Scheme or the code for a function when
ColourScheme .
the user hovers the mouse over its
name.
Specifies whether or not Native
Look and Feel is enabled. This
Enable Native changes the appearance of user-
Look and Feel XPLookAndFeel interface controls such as Buttons
in both the Session and the
Dyalog GUL
. Specifies whether or not Native
ﬁ(ﬁ)cl))liyai?tl?é:l Look and Feel is honoured when
XPLookAndFeelDocker | drawing the title bars of docked
to docked . . .
) windows, including docked
captions . .
Session windows.
Underline Specifies whether or not URLs
. URLHighlight and links are highlighted in
URLs and links . R
Session and Edit windows.
Configuration .. Specifies the full pathname of the
8 inifile .
saved in registry folder used by APL
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Underline URLs and links

Ifthis option is selected, valid URLSs are identified when the cursor is in the Session
orin an Edit or Trace window. When the mouse pointer is over a URL, the URL is
underscored and the appropriate items in the Session Popup menu are activated.
These allow you to open the link or copy it to the clipboard.

Y ou may also open a URL using Ctrl+Click (Left Mouse button).

Currently a URL string is defined to be a string starting with any of the following
strings:

http://
https://
WWW.
mailto:
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Unicode Input Tab (Unicode Edition Only)
Unicode Edition can optionally select your APL keyboard each time you start APL.

To choose this option, select one of your installed APL keyboards, enable the
Activate selected keyboard checkbox, then click OK

B Dyalog APL/W Configuration @
Trace/Edit ] Auto Complete ] SALT ] Uger Commands ] Object Syntax ]
General Unicode Input l F.eyboard Shortcuts ] Workspace ] WwWindows I Seszion ] Log ]

Dypalog can automatically load pour selected keyboard when the session window iz made visible:

W Ativate selected keyboarg I Show kepboards for al languages
Kevboard:
|Dyalog APL IME [enGE) ~|

Configure Layout...

(0] 4 | Cancel
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Label Parameter Description
o ey i
selected InitialKeyboardLayoutInUse P

keyboard on start-up.
keyboard .

0 = no action
Show 1 = show list of all

keyboards for
all Languages

InitialKeyboardLayoutShowAll

installed keyboards
0 = show only the Dyalog
keyboards

Keyboard

InitialKeyboardLayout

the name of the APL
keyboard to be selected.
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Dyalog APL Input Method Editor Properties E]

Input Translate T able:

|E:'xF'rcugram FilezhDyalog'nicodelME haplkevs'en-GE . din Browse. ..

[v Enable Overstrkes
[ Owerzstikes do not require the '05" introducer key [expernimental]

[v Uze Overstike popup

k. | Cancel

Table 22: Configuration dialog: Unicode Input/Configure Layout

popup

Label Parameter Description
Enable . 1 = enable overstrikes.
Overstrikes ResolveOverstrikes 0 = disable overstrikes
Overstrikes do 1= IME identifies overstrike operation
not require the automatically
4 0 = IME requires the <OS> key to
<OS> key . . .
signal an overstrike operation

trik . 1= le th trik .

Use Overstrike OverstrikesPopup enable the overstrike popup

0 = disable the overstrike popup




Chapter 2: The APL Environment 133

Input Tab (Classic Edition Only)

B Dyalog APL/W Configuration
ALuto Complete ] SALT ] User Commands ] Object Syntax ]
General Input ] Output ] ‘Workspace ] wWindows ] Session ] Log ] TraceEdit ]

Input table search path:
Drouble click a directory bo ligt its Input T able files

C:\Program Files\DyaloghDyalog APL 121 Clazzichaplkeys

Itput table file:
Contents of the highlighted directory

uk.din ~|

(]9 | Cancel

Table 23: Configuration dialog: Keyboard

Label Parameter Description

Input table aplkevs A list of directories to be searched for the
search path preey specified input table

Input table file |aplk The name of the input table file (DIN)
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Output Tab (Classic Edition Only)

B Dyalog APL/W Configuration
Auto Complete ] SALT ] User Commands ] Object Spntax ]
General ] Input Output ] “Workspace ] windows ] Session ] Log ] Trace E dit ]

Dutput table search path:
Double click a directom to ligt itz Output T able files

IC:4Program Files\DyalogiDyalog APL 121 Classichaplrans

Outpuit table file:
Contents of the highlighted directory

win.dot j

(]9 | Cancel

Table 24: Configuration dialog: Output

Label Parameter Description

Output table A list of directories to be searched for the
apltrans :

search path specified output table

gll; tput table aplt The name of the output table file (DOT)
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Keyboard Shortcuts Tab

B Dyalog APL/W Configuration E]
Trace/Edit ] Auto Comnplete ] SALT ] Uszer Commands ] Object Syntaw ]
General ] Unicode Input Keyboard Shortcuts l Workspace Windows ] Session ] Log ]
Available shortcuts: Shorteut far:
Code | Deseription | Shartcut | fad TL:taggle localisation
as Begin overstike geq...  [Mone]
52 Ewit script and orly fi...  [Mone] Contral+Up
51 Ewit goript and fix en...  [Mone]
w0 Goto matching outline  [Mone) Coanflicts with:
TO Toggle outline [Mone]
GL Goto Line [Mone]
] [rel comments [Mone)
A0 Add commentz [Mone)
) undo all changes [Mane] [~ Confim before ovenrite
TL toggle localization Control+Up
Rk Resume execution (i...  [Mone)
BF toggle breakpoint [Mone]
BH Fiun to exit fin tracer]  [Mone)
LM Togale Line numbers Mum -
Fx Fiw the current functi..  [Mone)
TC Trace Contral+E rter
ED Edit Shift+Enter
P Previous [Mone)
[k Mext [Mone) } )
PP Replace Norel ™ [w Usge Chl-3.CM for clipboard
ak. | Cancel |

To alter the keystroke associated with a particular action, simply select the action
required and press the keystroke. For example, to change the keystroke associated
with the action <UA> (undo all changes) from (None) to Ctrl+Shifi+u, simply select
the corresponding row in the list and press Ctrl+Shift+u. If Confirm before Overwrite
is checked, you will be prompted to confirm or cancel before each and every change
is written back to the registry.
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Workspace Tab

B Dyalog APL/W Configuration
Trace/Edit I Auto Complete SALT ] Uzer Commands I Object Spntax ]
General ] Unicode lnput ] F.eyboard Shortcuts Wworkspace l windows ] Seszion ] Log ]

Workzpace search path:

Browse

C:ADocuments and SettingssPetelbdy Documents\Dyalog APL 13.0 Unicode Files

C:\Program Files\DyaloghDypalog APL 130 Unicodetws

C:\Program Files\DyaloghDypalog APL 13.0 Unicode’S amples'uding
C:%Program Files\DyaloghDyalog APL 12.0 Unicode’S ampleshactives
C:\Program Files'DyaloghDyalog APL 13.0 UnicodetS ampleshole
C:\Program Files'DyaloghDyalog APL 13.0 UnicodetS amplesstepip
C:\Program Files'DyaloghDyalog APL 13.0 UnicodetS ampless0044PL
C:4Program FilesDyaloghDyalog APL 13.0 Unicode!S amplesiawinfarms
C:%Program FilesDyaloghDpalog APL 13.0 Unicodetustib

C:%Program FilesDyaloghDyalog APL 13.0 Unicodettools/aplteam

L

Marimum waork space size (kB]: (64000

ak. | Cancel

Table 25: Configuration dialog: Workspace

Label Parameter Description
A list of directories to be searched for the
Workspace .
wspath specified workspace when the user
search path

executes ) LOAD wsname

Maximum . . .
K . The maximum size of the workspace in
g{‘g) space size | Maxws KB. Default is 16384.
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Help/DMX Tab

B Dyalog APL/W Configuration

[ Status Window

Trace/Edit ] Auto Complete
General ] Unicode Input ] F.eyboard Shaortcuts ] ‘Wworkspace

Db mezsages should go to:

IV Use Microsoft's documentation center for non-Divalog topics

] SALT ] Uzer Commands
Help # Db ] windows ] Sezzion ] Log ]

] Object Syntax ] Met Framework. ]

URL: [ms-help: A/me.msce.w80

QK | Cancel

Table 26: Configuration dialog: Help/DMX

should go to

Label Parameter Description
If checked, these boxes cause
DMX messages DMXOUTPUTONERROR APL to display JDMX messages

in the corresponding window

(s).

Use Microsoft's
documentation
centre for non-
Dyalog topics

UseDefaultHelpCollection

If this option is checked, APL
will look for help at
Microsoft's documentaion
center for the the current string
under the cursor.

URL

DefaultHelpCollection

The url for the documentation
center.
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Windows Tab
B Dyalog APL/W Configuration
Trace/Edit I Auto Complete SALT I Uzer Commands I Object Spntax
General I Unicode Input I Keyboard Shortcuts | ‘Workspace Windaws | Session I Lag
— Edit “indow:

Width lgq— Height |3D—
¥ Pos lg— Y Pog Ig—
X Dffzet |3— ¥ Dffzet |3—

— Trace Window:

# Pos ID— Y Pos ID—
X Offzet |3— ¥ Offzet |3—

~ QuadSh Window

widh [73°  Heght [o5

ak. I Cancel
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Table 27: Configuration dialog: Windows (Edit Windows)

Label

Parameter

Description

Width

edit_cols

The maximum number of rows displayed
in a new edit window

Height

edit_rows

The maximum number of columns
displayed in a new edit window

X Pos

edit_first x

The initial horizontal position in
characters of the first edit window
relative to the Session window

Y Pos

edit first y

The initial vertical position in characters
of the first edit window relative to the
Session window

X Offset

edit_offset x

The initial horizontal position in
characters of the second and subsequent
edit windows relative to the previous one

Y Offset

edit_offset y

The initial vertical position in characters
of the second and subsequent edit
windows relative to the previous one

Table 28: Configuration dialog: Windows (Trace Windows)

Label

Parameter

Description

X Pos

trace first x

The initial horizontal position in
characters of the first trace window
relative to the Session window

Y Pos

trace_first y

The initial vertical position in characters
of the first trace window relative to the
Session window

X Offset

trace offset x

The initial horizontal position in
characters of the second and subsequent
trace windows relative to the previous
one

Y Offset

trace_offset y

The initial vertical position in characters
of the second and subsequent trace
windows relative to the previous one
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Table 29: Configuration dialog: Windows (QuadSM Window)

Label Parameter Description

Width am cols Tl.le width of the [JSM and prefect
- windows

Height S TOWS T}'le height of the [SM and prefect
- windows
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Session Tab
B Dyalog APL/W Configuration
Trace/Edit | Auto Complete SALT | Uzer Commands | Object Syntax
Eeneral I Unicode Input | F.eyboard Shortcuts I “Workspace I WWindows Seszion | Log

— Default setting

Oio: [
OML : o
OpF: [0
ORTL: |g—
ORL: i

o

545
-
Session file:
C:ADocuments and Settings\Pete\My DocumentsiDvalog APL 13.0 Unicode Files\def_uk.dse Browze. . |

QK I Cancel |
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Table 30: Configuration dialog: Session

Label Parameter Description
010 default io The default value of JIO in a clear
- WS.
OML default ml The default value of JML in a c lear ws
PP default_pp The default value of JPP ina clear
WS.
ORTL default_rl The default value of JRTL in a clear
WS.
ORL default 1l The default value of JRL ina clear
WS.
OpIv default div The default value of JDIV in a clear
- WS.
WX default_wx The default value of JWX in a clear
WS.
If checked, the value of [JPW is dynamic
Auto PW auto_pw and depends on the width of the Session
Window.
Session file session file The name of the Session file in which the
- definition of your session (OSE) is stored.
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Log Tab

B Dyalog APL/W Configuration

Trace/Edit ] Auto Complete SALT ] Uzer Commands ] Object Syntax ]
Eeneral ] Unicode Input ] F.eyboard Shortcuts ] “Workspace ] WWindows ] Seszion Log

|E:'\Documents and Settings\Petesky Documents\Dpalog APL 13.0 Unic: Browse. .

[ Confirm on Deletion from Session Log
Sezzion log zize(kb]: 200

Input buffer size(kb): lﬂlﬂi
Histom buffer size(k.b]: |47
PFKey buffer sizefkbl, 100

QK | Cancel
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Table 31: Configuration dialog: Log

Label

Parameter

Description

Use Session log
file

log file inuse

Specifies whether or not the Session log
is saved in a session log file

Use Session log
file

log_file

The full pathname of the Session log file

Confirm on
Deletion from
Session log

confirm_
session_delete

Specifies whether or not you are
prompted to confirm the deletion of a line
from the Session (and Session log).

Session log size

(Kb)

log_size The size of the Session log buffer in Kb
(Kb)
. The size of the buffer used to store
Input buffer size | . . . . . . .
input_size marked lines (lines awaiting execution) in

the Session

History size

history_size

The size of the buffer used to store
previously entered (input) lines in the

(Kb) Session

PFKey buffer . The size of the buffer used to store PFKey
. ptkey size .

size(Kb) definitions (OPFKEY)
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Trace/Edit Tab

B Dyalog APL/W Configuration

General
Trace/Edit

Unicode Input K eybn

Ato Complete

[] Clazsic Dyalog mode

Allow floating edit windows
Show status bars
Show toal bars

Show trace stack on errar

“Wam if trace stack bigger than;

Fix [or Exit and Fix] in a suspended class or namespace should fis:

oard Shortcuts Workspace Help # Db Windowes Seszion Log
SALT Uszer Commands Obiect Syntax Met Framework.
Confirm edit window close on:
Close
[ Exit (and Fix)
[ &bart
AutoFarmat functions
Autolndent
Diouble click to adit
15 Tab stops every | 4 characters.
Qnly Functions v
If nat suspended fix: | Evervthing d
(]9 l [ Cancel
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Table 32: Configuration dialog: Trace/Edit

Label Parameter Description
Classic Dyalog ClassicMode Sel.ects pre-Ver519n 9 behaviour for
mode Edit and Trace windows
Allow floatin Allows individual Edit windows
edit win dowsg DockableEditWindows | to be undocked from (and re-
docked in) the main Edit window
Allow session Specifies whether or not the
above edit SessionOnTop Session may appear on top of Edit
windows and Trace Windows
Single trace . Specifies whether or not there is a
. SingleTrace . .
window single Trace window
Show status Specifies whether or not status bars
bars StatusOnEdit are displayed along the bottom of
individual Edit windows
Specifies whether or not tool bars
Show tool bars | ToolBarsOnEdit are displayed along the top of

individual Edit windows

Show trace
stack on error

Trace on_error

Specifies whether or not the Tracer
is automatically invoked when an
error or stop occurs in a defined
function

Warmn if trace
stack bigger
than

Trace level wam

Specifies the maximum stack size
for automatic deployment of the
Tracer.

Confirm on edit
window close

confirm_close

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then closes it
without saving

Confirm on edit
window fix

confirm_fix

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then saves it using
Fix or Exit
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Label

Parameter

Description

Confirm on edit
window abort

confirm_abort

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then aborts using

Selects automatic indentation for

Auto'fonnat AutoFormat Control Structures when function
functions . i
is opened for editing
. Selects semi-automatic indentation
Autoindent .
. AutoIndent for Control Structures while
functions .
editing
. Specifies whether or not double-
Double-click t . . . .
E((i)iltlb N DoubleClickEdit clicking over a name invokes the
editor
Specifies whether or not text
Paste text as transferred to and from the
. UnicodeToClipboard ; . ;
Unicode fcode LotHipboar Windows clipboard is to be treated
as Unicode
Tab stops every | TabStops The number of spaces inserted by

pressing Tab in an edit window

Exit and fix ...

See Fixing Scripts below

If not ...

See Fixing Scripts below
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Fixing Scripts

When using the Editor to edit a script such as a Class or Namespace you can specify
whether, when you Fix the script and Exit the Editor, just the functions in the script
are re-fixed, or whether the whole script is re-executed, thereby re-initialising any
Fields or variables defined within.

These two actions always appear in the Editor File menu, but you can specify which
is associated with the <EP> (Esc) key by selecting the appropriate option in the
drop-downs labelled:

e Exit and save changes (EP) in a suspended class or namespace should fix:
e If not suspended fix:

In both cases, you may select either Only Functions or Everything.

The label for the corresponding items on the Editor File menu (see "The File Menu
(editing a script)" on page 219) will change according to which behaviour applies.
Note that if you specify a keystroke for <S1> in the Keyboard Shortcuts tab, this will
be associated with the unselected action.
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Auto Complete

Tab

B Dyalog APL/W Configuration

M ake suggeshions after

Suggest up ta

Shaow up to
[v kzep histoy

History Length

IV Include filenames

0 characters. Delay completion for 500 millizeconds.

itemnz at a tme.

E
I? colurmns at a time.
Mo

entries,

OF Kew |F|ight

ar: |[N0ne]

Cancel Key: | Esc

ar: |[None]

Common Key: | Control+Right

General ] Unicode Input ] Fepboard Shaortcuts ] Workzpace ] Help # Dk I Windowes I Seszion ] Log ]
Trace/Edit Ao Cornplete: l SALT ] |Jser Commands ] Object Syntax ] Net Framework ]

QK | Cancel |

Note: To enter values in the OK Key and Cancel Keyfields, click on the field with
the mouse and then press the desired keystroke.

Table 33: Configuration dialog: Auto Complete

Label Parameter Description
Use Auto Enabled Specifies whether or not Auto
Complete Completion is enabled.
Make Specifies the number of characters
. . you must enter before Auto
suggestions PrefixSize . i
Completion begins to make
after .
suggestions
Dela Specifies the delay in milliseconds
- KeyboardInputDelay | before Auto Completion begins to
completion for i
make suggestions
Specifies the maximum number of
Suggest up to | Rows rows (height) in the AutoComplete
pop-up suggestions box.
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Label Parameter Description
Specifies the maximum number of
Show up to Cols columns (width) in the

AutoComplete pop-up suggestion
box

Keep History

History

Specifies whether or not
AutoComplete maintains a list of
previous AutoCompletions.

History Length

HistorySize

Specifies the number of previous
AutoCompletions that are maintained

Include
filenames

ShowFiles

Specifies whether or not
AutoCompletion suggests directory
and file names for ) LOAD, )COPY
and )DROP system commands.

OK Key

CompleteKey1
CompleteKey?2

Specifies two possible keys that may
be used to select the current option
from the Auto Complete suggestion
box.

Cancel Key

CancelKey1
CancelKey?2

Specifies two possible keys that may
be used to cancel (hide) the Auto
Complete suggestion box.

Common Key

CommonKey1

Specifies the key that will auto-
complete the common prefix. This is
defined to be the longest string of
leading characters in the currently
selected name that is shared by at
least one other name in the Auto
Complete suggestion box.
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SALT

SALT is the Simple APL Library Toolkit, a simple source code management system
for Classes and script-based Namespaces. SPICE uses SALT to manage development
tools which “plug in” to the Dyalog session

B Dyalog APL/W Configuration
General I Unicode Input | Fepboard Shortouts | “Workspace I Wwindoves | Sezzion I Log
Trace/E dit | Auto Complete SALT I Iser Commands | Object Syntax

Compare command line: |5D|

Editor command line: I

Source folders: I Browsze

C:\Program Files\DyaloghDyalog APL 13.0 UnicodesSALT
Eemaove
Hove Up

Miove Bown

L

(]9 I Cancel
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Table 34: Configuration dialog: SALT

Label Parameter Description
Enable . .
Salt AddSALT Specifies whether or not SALT is enabled
Compare The command line for a 3™ party file
command CompareCMD [ comparison tool to be used to compare
line two versions of a file. See note.
. . Name of the program to be used to edit
E E .
ditor ditor script files (default "Notepad").
Class . . .
Sets the SALT working directory; a list of
source SourceFolder
folders folders to be searched for source code.
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User Commands Tab

B Dyalog APL/W Configuration
General I Unicode Input ] F.epboard Shaortcuts “Workspace ] Windowes ] Sezsion I Log ]
Trace/E dit ] Auto Complete ] SALT Uszer Commatids ] Object Syntax ]
Source folders: || Browse

C:\Program Files\DyaloghDyalog APL 13.0 UnicodesSALT S pice

L

QK | Cancel |

This page is used to specify and organise a list of folders that contain User-Command
files. When you issue a User Command, these folders will be searched for the source
of the command in the order in which they appear in this list.

Table 35: Configuration dialog: User Commands

Label Parameter Description

Use this field to add folders to the
Source Folders | SALT\CommandFolder | list of folders that will be searched
for User Commands.
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Object Syntax Tab

B Dyalog APLAY Configuration

General Unicode lnput F.eyboard Shortcuts Workspace wWindows
Trace/E dit Auto Complete SALT Uger Commands

[¥]E #pose properties of GLI Namespaces

] Expose properties of Boot

[] Expose properties of Session Namespace

Session
Object Spntax

Lo

Ok,

J|

Cancel
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Table 36: Configuration dialog: Object Syntax

Label Parameter Description

Specifies the value of WX in a clear
workspace. This in turn determines
whether or not the names of
properties, methods and events of
GUI objects are exposed. If set (OWX
default wx is 1), you may query/set properties
and invoke methods directly as if
they were variables and functions
respectively. As a consequence, these
names may not be used for global
variables in GUI objects.

Expose
properties of
GUI
Namespaces

Specifies whether or not the names of
properties, methods and events of the
Root object are exposed. If set, you
may query/set the properties of Root
and invoke the Root methods directly
as if they were variables and
functions respectively. As a
consequence, these names may not be
used for global variables in your
workspace.

Expose
properties of PropertyExposeRoot
Root

Specifies whether or not the names of
properties, methods and events of the
Session object are exposed. If set, you
may query/set the properties of JSE
PropertyExposeSE | and invoke OSE methods directly as
if they were variables and functions
respectively. As a consequence, these
names may not be used for global
variables in the [JSE namespace.

Expose
properties of
Session
Namespace

The Object Syntax tab ofthe Configuration dialog is used to set your default pref-
erences for Object Syntax.

The Object Syntax settings for the current workspace are reflected by the Object
Syntax submenu of the Options menu. Use Options/Object Syntax to change them.
These settings are saved in the workspace.
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.Net FrameworkTab
B Dyalog APL/W Configuration
General ] Unicode lnput I Keyboard Shortcuts ] Workzpace ] wWindows Seszion ] Log ]
Trace/Edit ] Auto Complete ] SALT ] User Commands ] Object Syntas Met Framework

I+ Specify MNet Yersion

|v2.0.50727 ~|

config file contents:

< configuration:
<startup ugel egacyy' 2R unbimedctivationPolicy="tug">
<supportedBuntime version="v2 0 50727"/>
</startup>
<runtimes
<MetFxd0_LegacySecuntyPolicy enabled="te"/>
<Jruntimes
< /configuration

ak. | Cancel |

This dialog box allows you to specify which version of the .Net Framework you
want to use with Dyalog APL. It is only necessary to do this if you have more than
one version of the .Net Framework installed.

If Specify .Net Version is selected, APL will display the versions of the .Net Frame-
work that are installed in the combo box below.

Choose the version you require and click OK.

Unlike the other configuration dialogs, which typically set values in the Registry,
this dialog creates a configuration file dyalog.exe.config in the same directory
as the Dyalog APL program. Note the following:

e Version 13.2 does not read the contents of an existing
dyalog.exe.config file.

e For .Net Version 2, no configuration file is required; if you select Version 2
having previously selected Version 4, the file will be deleted.

e You will need suitable permissions to write the configuration file, or delete
it — you may wish to start APL by right clicking on the Dyalog shortcut
and selecting Run as administrator.

The dialog box shows the contents of this file as illustrated above.
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Colour Selection Dialog

Dyalog APL/W Colours

Schemes

Syntax | Yariables | Session/Trace | Status

Lol Colours ncilocal:o:0I0:dfn:f A dummy function Foreground

[11 O1o«1 A local sys war

[21 OTRAP<0 *C* '+Errors’ i global sys war I v

[31 local+'char const’ A local + char const

[41 globalel.2 2 345 @ global + num const | Dookaeund

[5] For o :In lOWNL nc A kegword + sus fn [ [+

[al O5E.FRIMT OCR o A global name

[?] EndFor A keuword Element

[al =

[31 Errors: A label Global Mame e
[10] CCA=00-A1+="missing A errars -
[113 Single Background
[121 dfnelirslte+{an wiluw wi+w? A D-function I Sl s

[13] f.Caption+'Owalog APL' A Lacal Praoperty :

[14] Caption«'Dyalag APL" fi Global Property [¥] Function Editer

[15] idiome, s B idiom

Function Tracer
Seszion [nput
Only current input line

| ok || Cancel | [ e |

Colour for Background

265:265:255

The Colour Selection dialog box allows you to select colours for:

e Syntax colouring
e Edit, Trace and Session windows
e Status window

The colour selection dialog box is selected by the [ChooseColor] system action
which by default is attached to the Options/Colours menu item on the Session menu-
bar and to the Colours menu item in the Session pop-up menu.
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Syntax Colouring

Syntax colouring allows you to visually identify various components in the function
edit and session windows by assigning different colours to them, such as:

¢ Global references (functions and variables)
e Local references (functions and variables)
e Primitive functions

e System functions

e Localised System Variables

e Comments

e Character constants

e Numeric constants

e Labels

e Control Structures

e Unmatched parentheses, quotes, and braces

Schemes

You may define a number of different syntax colouring schemes which are suitable
for different purposes and a selection of schemes is provided. Choose the scheme you
wish to use from the Combo box provided. If you change a colour allocation, you
may overwrite an existing Colour Scheme or define a new one by clicking Save As
and then entering the name of the Scheme. You may delete a Colour Scheme using
the Delete button.

Changing Colours

To allocate a colour to a syntax element, you must first select the syntax element.
You may select a syntax element from the Combo box provided, or by clicking on an
example in the sample function provided. Having selected a syntax element, choose
a colour using the Foreground or Background selectors as appropriate.

Show Idioms

The Show Idioms checkbox allows you to choose whether or not idioms are to be
identified by syntax colouring.

Single Background

The Single Background checkbox allows you to choose whether to impose a single
background colour, or to allow the use of different background colours for different
syntax elements.
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Function Editor

Check this box if you want to enable syntax colouring in Edit windows.

Function Tracer

Check this box if you want to enable syntax colouring in Trace windows.

Session Input

Check this box if you want to enable syntax colouring in the Session window. Note
that the colour scheme used for the Session may differ from the colour scheme
selected for Edit windows and is specified by the Session Colour Scheme box on the
Session/Trace tab.

Only current input line

This option only applies if Session syntax colouring is enabled. Check this box if
you want syntax colouring to apply only to the current input line. Clear this box, if
you want to apply syntax colouring to all the input lines in the current Session win-
dow. Note that syntax colouring of input lines is not remembered in the Session log,
so input lines from previous sessions do not have syntax colouring.

HotKeys
You may associate different sot key with any or all of your colour schemes.

When you depress a hot key over a function in an Edit window, the function is dis-
played using the scheme associated with the hot key. Releasing the hot key causes it
to be displayed in the normal scheme.

This feature is intended to allow you to quickly check for certain syntax elements.
For example, you may define a special scheme that only highlights global names and
associate a hot key with it. Pressing the hot key will temporarily highlight the glob-
als for you.

To associate a hot key with a colour scheme, click on the Hotkey field, and then
make the desired keystroke. To disassociate a hot key, use <backspace>.
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Print Configuration Dialog Box

The Print Configuration dialog box is displayed by the system operation
[PrintSetup] thatis associated with the File/Print Setup menu item. It is also
available from Edit windows and from the Workspace Explorer and Find Objects
tools.

There are four separate tabs namely Setup, Margins, Header/Footer and Printer.

Note that the printing parameters are stored in the Registry in the Printing sub-folder

Setup Tab
B Dyalog APLAY Print Configuration

Setup | Marging | Header/Footer | Printer

Color scheme | Default l Lead wrapped lings with;
(%) Thiz bext:
Line numbers on functions (3 Thiz many spaces;

[] Line numbers on variables

&PL385S Unicode . 12

(] ] [ Cancel
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Table 37: Print Configuration dialog: Setup

Label Parameter Description
Check this box if you want to print
Color scheme InColour functions V&flth syl.ltax colou.nng. Note
that that printing in colour is slower than
printing without colour.
Color scheme SchemeName Se.lec't the colour scheme to be used for
printing.
Check this option button if you wish to
. . prefix wrapped lines (lines that exceed
Th hT . . .
Is text WrapWithText the width of the paper) with a particular
text string
. ifies th f fixi
This text WrapLeadText Spec1 ies the text for prefixing wrapped
lines
This many WrapWithSpaces Check this optiop butt(.)n if you wish to
spaces prefix wrapped lines with spaces.
. Specifies the number of spaces to be
This many . o
WrapLeadSpaces | inserted at the beginning of wrapped
spaces .
lines.
Line numbers LineNumsFns Check this box if you want line numbers
on functions to be printed in defined functions.
. Check this box if you want line numbers
Line numbers . . . .
. LineNumsVars to be printed in variables. If you choose
on variables . . . .
this option, line numbering starts at JI0.
Click to select the font to be used for
Font Font printing. Note that only fixed-pitch fonts

are supported.
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Margins Tab

B Dyalog APLAY Print Configuration

Setup | Marging | Header/Footer | Printer

(T

Left margin: A
- g (#) Inches

() Centimetras
Bight margin. |05
Top margir; (IR

Bottom margin: |05

(] l [ Cancel

Table 38: Print Configuration dialog: Margins

Label Parameter Description

Use margins UseMargins Check this box if you want margins to
apply

Left margin MarginLeft Specifies the width of the left margin

Right margin MarginRight Specifies the width of the right margin

Top margin MarginTop Specifies the height of the top margin

Bottom margin | MarginBottom | Specifies the height of the bottom margin

Inches Marginlnch Specifies that the margin units are inches

Centimetres MarginCM Ssstciin{z;)tsr;}s]at the margin units are
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Header/Footer Tab

B Dyalog APLAY Print Configuration

Setup || Marging | Header/Footer | Printer

Workspace Twznamet{cr}

Footer
{crF{h1}Printed at {printdate} {printtime}{rj}Page {cu

Prefis funcions with:
Th1H{objname}{ri} Author:{author} Last Fixed:{fixdatel}

Prefix wariables with:
{Th1H{objname}{cr}

Prefiz other objects with
{Th1H{objname}{cr}

(] l [ Cancel
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Table 39: Print Configuration dialog: Header/Footer

objects with

Label Parameter Description

Header DoHeader Spec1ﬁes whether or not a header is
printed at the top of each page

Header HeaderText The header text

Footer DoFooter Spemﬁes whether or not a footer is
printed at the bottom of each page

Footer FooterText The footer text

Prefix functions DoSenFn Specifies whether or not text is printed

with P before each defined function

. The text to be printed before each defined

Prefix functions . . . .

with SepFnText function. This can include its name,
timestamp and author

Pr'eﬁx variables DoSepVar Specifies whether or not text is printed

with before each variable.

Prefix variables SepVarText The text to be printed before each

with p variable. This can include its name.
Specifies whether or not text is printed

Prefix other before other objects. These include

. . DoSepOther locked functions, external functions, JNA

objects with . . .
functions, derived functions and
namespaces.

Prefix other SepOtherText The text to be printed before other

objects. This can include its name.
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The specification for headers and footers may include a mixture of your own text,
and keywords which are enclosed in braces, e.g. {objname}. Keywords act like var-
iables and are replaced at print time by corresponding values.

Any of'the following fields may be included in headers, footers and separators.

{WSName} {WS}
{NSName} {NS}
{ObjName} {OB}
{Author} {AU}
{FixDate} {FD}
{FixTime} {FT}
{PrintDate} {PD}
{PrintTime} {PT}
{CurrentPage} {CP}
{TotalPages} {TP}
{RightJustify} {RJ}
{HorizontalLine} {HL}
{CarriageReturn} {CR}

For example, the specification:

Workspace name
Namespace name

Object name

Author

Date function was last fixed
Time function was fixed
Today's date

Current time

Current page number

Total number of pages
Right-justifies subsequent text/fields
Inserts a horizontal line

Inserts a new-line

Workspace: {wsname} {objname} {1j} Printed {PrintTime} {PrintDate}

would cause the following header, footer or separator to be printed at the appropriate

position in each page of output:

Workspace: U\WS\WDESIGN WIZ change toolbar Printed 14:40:11 02 March

1998
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Printer Tab

5 Dyalog APL/W Print

Frinter l Setup | Margins | Header/Footer

Frirt
Al

~

Where:  hpd200

Mame:  |HP Laseret 4200L PCL &

ﬂ Properties. ..

Frirt | Cancel

Table 40: Print Configuration dialog: Print

Label Parameter Description
. . The name of the printer to be used for
N PrinterFiel "
ame rinterfield printing from Dyalog APL.

Properties Click this to set Printer options.

Where Reports the printer device
Allows you to choose between printing
all of the current object or just the

Print selection. Note that this option is present
only when the dialog box is displayed in
response to selecting Print.
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Status Window

The Status window is used to display system messages and supplementary infor-
mation. These include the operations that take place when you register an OLEServer
or ActiveXControl.

The Status window is also used to display supplementary information about errors.
For example, ifin a [JWC statement you misspell the type of an object, you will get a
suitable error message in the Status window, in addition to the DOMAIN ERROR mes-
sage in the Session.

Example

'"F'OWC'FROM' A Should be 'FORM'
DOMAIN ERROR
'"F'OWC'FROM'

A

15 Dyalog APLAY - Status mEx]

File Options

Inwalid ohject tupe: FROM

Cloze

The Status window can be explicitly displayed or hidden using the [Status ] sys-
tem operation which is associated with the Tools/Status menu item.

There is also an option to have the Status window appear automatically whenever a
new message is written to it. This option is selected using the [AutoStatus] sys-
tem operation which is associated with the Tools/AutoStatus menu item.

Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool

The Explorer tool is a modeless dialog box that may be toggled on and off by the sys-
temaction [Explorer]. In a default Session, this is attached to a Menultem in the
Tools menu and a Button on the session toolbar.

The Explorer contains two sub-windows. The one on the left displays the namespace
structure of your workspace using a TreeView. The right-hand window is a ListView
that displays the contents of the namespace that is selected in the TreeView.

| Exploring C:\Program Files\Dyalog\Diyalog APL 13.... g@
Eile Edit ©Options Wiew Tools
ABEXAQHE of EEEERE 2 4lalfl
Workzpace Tree Contents of H.Whezign.PropFmt
=I5 # | Name |T',,-'|:|e |_A_
-] Whesign .@Animatian Function
&) [Fns/0ps] FIBTHS Yariable
+¥] [Vars] E|BTNSCONY Function
+-C] Bitmaps .@Eitmap Function
+-(Z7 BMED .@Bruuseﬂnx Function
4.0 Buttons ¥ CHOICES Variable
#-[3 ColourPick .@Ealendar Function
4[] Events .@Eheck Function
4. GridTitles .@Eircle Function
4[] BWiz .@Enmbu Function
. . @EDmeEx Function
.@Euulﬂar Function
+ ]
T .@Eursnr Function
2@ Zmliual .@DateTimeF‘... Function
#-(3 Sty '.ES | .@Edit Function _
" (3 TabMiz || |EEditBax Function )
.{. .}. .{. .>.
75 object(s), 60,38Mb Free, 233536 bytes used (0 bytes se

The Explorer is closely modelled on the Windows Explorer in Windows and the facil-
ities it provides are very similar. For Windows users, the operation of this tool is prob-
ably self-explanatory. However, other users may find the following discussion

useful.
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Exploring the Workspace

The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and [JSE. The icon for # is open indicating that its con-
tents are those that appear in the ListView. You can expand or collapse the TreeV-
iew of the workspace structure by clicking on the mini-buttons (labelled + and -) or
by double-clicking the icons. A single click on a closed namespace icon opens it and
causes its contents to be displayed in the ListView. Another way to open a names-
pace is to double-click its icon in the ListView. Only one namespace can be open at
a time. The icons used in the display are described below.

Class
Namespace (closed)
GUI Namespace (closed)

Namespace (open)

geolE

GUI Namespace (open)

Function

Variable

Operator

Indicates an object that has been erased
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Viewing and Arranging Objects

The ListView displays the contents of a namespace in one of four different ways
namely Large Icon view, Small Icon view, List view or Details view. Y ou can switch
between views using the View menu or the tool buttons that are provided. In the first
three views, the system displays the name of the object together with an icon that
identifies its type. In Details view, the system displays several columns of additional
information. You may resize the column widths by dragging or double-clicking the
lines in the header. To hide a column, drag its width to the far left. The additional col-
umns are:

This is the namespace containing the object. By definition, this
Location is the same for all of the objects shown in the ListView and is
normally hidden

For a function or operator, this is the function header stripped of
localised names and comment. For a variable, the description

e . indicates its rank, shape and data type. For a namespace, the
Description e e .
description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is

described as Form, and so forth.

Size The size of the object as reported by JSIZE.

Modified | For functions and operators, this is the timestamp when the
on object was last fixed. For other objects this field is empty.

Modified | For functions and operators, this is the name of the user who
by last fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size, timestamp
or class by clicking the appropriate tool button. In Details view, you may sort in
ascending or descending order by clicking on the appropriate column heading. The
first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects

You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.

To move one or more objects using drag-and-drop editing:

1. Select the objects you want to move in the ListView.

2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.

3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.

To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse but-
ton.

You may also move and copy objects using the Edit menu. To do so, select the
object(s) and then choose Move or Copy from the Edit menu. You will be prompted
for the name of the namespace into which the objects are to be moved or copied.
Enter the namespace and click OK.

Editing and Renaming Objects

You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the orig-
inal name is discarded. Unlike changing a function name in the editor, this is not a
copy operation.
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Using the Explorer as an Editor

If you open the Fns/Ops item, the names of the functions and operators in the names-
pace are displayed below it alphabetically in the left (tree view) pane. When you
select one of these names, the function itselfis opened in the right (list view) pane.

=1 | Exploring C:\Program Files\D'yalog\Dyalog APL 13.0 Unicode\ws\wdesign E]@
Eile Edit Options Wew Tools

BB XQE of alglals

Workspace Tree

B 1nscoL A oA A X ~| 4B 40 | *m *F ®p
&) INSROW L OML

&) KEYPRESS ML<0

& LAST_ETH :1f 2=0ONC'DESCRIBE’

& LIST_0BI T tDESCRIBE

B LoCATE tEndlf

&) LOWER

B MAKE

£ MAKE_BTN

& MAKE_EXEC

£ MAKE_FMT_FH

&) MAKE_FMT_PROP

&) MAKE_FN

E MAKE_FN_FORM

£ MAKE_FN_GRID [,
<] Lo (] [Function Dyadic: 25/06{199 Pos: 0/5, 1
413 object(s), 60.37Mb free. 1041076 bytes used (0 bytes selected)

Y ou may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.

You may also edit the function directly in the right (list view) pane before moving
on to another.
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The File Menu

Prink...
Prinkt setup...

Delete
Rename
Properties

Close

Fz
alk Enker

The File menu, illustrated above, provides the following actions. All but Print setup
and Close act on the object or objects that are currently selected in the ListView.

Print Prints the object(s).

Print Displays the Print Configuration dialog box

setup play g g .

Delete Erases the object(s).

Rename Re.nam?s the object. This option only applies when a single
object is selected.

Properties [ Displays a property sheet; one for each object that is selected.

Close Closes the Explorer
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The Edit Menu

Edit  Enter
Copy (Chrl
Move

Select k Select Functions
Seleck variables

Select Mone
Select Al kel &
Invert Seleckion

The Edit menu, illustrated above, provides the following actions. The Edit, Copy and
Move operations act on the object or objects that are currently selected in the List-

View.
Edit Opens an edit window for each of the objects selected.
Copy Prompts for a namespace and copies the object(s) there.
Move Prompts for a namespace and moves the object(s) there.
Select . . e

. Selects all of the functions and operators in the ListView.

Functions
Sele.ct Selects all of the variables in the ListView.
Variables

Select None |Deselects all of the objects in the ListView.

Select All Selects all of the objects in the ListView.

Invert Deselects the selected objects and selects all those that were
Selection not selected.
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The Options Menu

v Toolbar

Toolbar Captions

v Status Bars

v Twpe Libraries

Expand All

Refresh Mo
v Auto Refresh

Fa

The Options menu, illustrated above, provides the following actions.

Toolbar |Displays or hides the Explorer toolbar.
Toolbar . . .
Captions Displays or hides the button captions on the Explorer toolbar.
StatusBar | Displays or hides the Explorer statusbar.
Type . . . .
Libraries Enables/disables the exploring of Type Libraries
Expand Expands all namespaces and sub-namespaces in the TreeView,
P providing a complete view of the workspace structure, including
All . . .
or excluding the Session object JSE.
Redisplays the TreeView and ListView with the current structure
Refresh . .
and contents of the workspace. Used if Auto Refresh is not
Now
enabled.
Auto Specifies whether or not the Explorer immediately reflects
Refresh |changes in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-cal-
culator mode. This means that it is always in step with the active workspace. If you
have a large number of objects displayed in the Explorer, the update may take a few
seconds and you may wish to prevent this by un-checking this menu item If'you do
so, the Explorer must be explicitly updated by selecting the Refresh Now action.
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The View Menu
Caolumns F  Mame
v Location
Large Icons
W Tvpe
amall Icons o
. v Descripkion
List Icons )
® Dekails v iz
v Modified an
Scope k| Modified by

arrange Icons
Line up Icons
W Aubo Arrange

4

The View menu, illustrated above, provides the following actions.

Columns [Allows you to select which columns you wish to display.
L . e

arge Selects Large Icon view in the ListView.
Icons
Small Selects Small Icon view in the ListView.
Icons
List Icons | Selects List view in the ListView.
Details Selects Details view in the ListView.
Scope Allows you to choose whether the Explorer displays objects in

P local scope or in global scope.
A . . N .
Icl(‘)l;lasnge Sorts the items in the ListView by name, type, size or date.
Line up . . .
Rearranges the icons into a regular grid.

Icons
Auto If checked, the icons are automatically re-arranged when
Arrange |appropriate
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The Tools Menu

Find... F3
Go ko, Ckrl g

(30 ko Session Space
Set Session space

The Tools menu, illustrated above, provides the following actions.

Find Displays the Find Objects Tool

Prompts for a namespace and then opens that namespace in the

Go to . . L . g
TreeView, displaying its contents in the ListView
Go to . . .
Session Opens the namespace in the TreeView control corresponding to
the current space in the Session.
Space

Set Session | Sets the current space in the Session to be the namespace that is
Space currently open in the TreeView.
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Browsing Classes

Classes are represented by icons. The picture below shows 3 classes: Bird,

Parrot and DomesticParrot.

| Exploring C:\Help13.0%ws\PARROTS [#]

BEX

Eile Edit ©ptions Wew Tools

BB XQE | of

alglol ol

Workspace Tree

Contents of # (Global Scopel

+ﬂ
+- (&9 OSE

3 objeck(s). 61.57Mb free,

Bird

Farrot

38544 bytes used (20136 bytes selected)

If you open the # node in the left-hand pane, you see the contents of # as a tree.

.ﬂ Exploring C:\Help13.0%ws\PARROTS [#]

M=

File Edit ©Options Yew Tools

BBRXQE o

algl ol &l

Workspace Tree

Contents of # [

Elobal Scape)

- ﬁ
+-[E0 Bird
+[E0 DomesticPar
+[ED Parrot

+- (7] OSE

(] i | [)]

3 object(s), 61.57Mb free,

Bird

38548 bytes used (20136 byvtes selected)

Farrot




Chapter 2: The APL Environment 179

Browsing Class Scripts

Selecting DomesticParrot in the left-hand pane brings up its Class Script in the
right-hand pane.

J Exploring C:\Help13.0\ws\PARROTS [# DomesticParrot] =JoEs
File Edit ©Options VYiew Tools

BEBEXQHE o alal ol &l

Workspace Tree Contents of #.0omesticParrot
-t oA A X ~| 0B A m*F %P
« [ Bird tClass DomesticParrot: Parrot
+. B0 & tField Public Name
+ [0 Parrot
+-[g) OSE [0] = 7 egglname species]
[1] tAccess Public
[2] tImplements Constructor :Base species
[3] O0F Hame<name
[L4] L 7
[0l = 7 eggl
[1] tAccess Public
[2] :Implements Constructor :Base 'Generic’
[3] ODF Hame+'Polly'
[L4] L 7
[0l = 7 R+Speak
[1] tAccess Public
[2] R+0BASE. Speak, ' Who's & pretty boy,thent’
[3] 7

tEndClass A DomesticParraot

< I | [»][class Pos: 0/21,0
3 objectis), 61.57Mb free, 38548 bytes used (20136 bytes selected)
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... and selecting Parrot in the left-hand pane brings up the Class Script for

Parrot.

1) Exploring C:\Help13.0%s\PARROTS [#.Parrot]

=/

File Edit Options ‘iew Tools

(BB XQAE | of mEEAda s

Workspace Tree

_n
+-[E Bird

+ [0 DomesticPar
4+ [0

+-() OSE

|Contents of #.Parrot

MR A X

~| 46 & | *m *F *p
[

[0]
[1]
[2]
[21

[0]
[1]
[2]
[21]
[0]
[1]
[2]
[3]

=

iClass Farrot: Bird

¥ egg zpecies
tAccess Public Instance

Implements Constructor
7
7 R+Speak
tAccess Public
R+'Squarkt’
7
7 kill
tImplements Destructaor
'Thiz Parrot is dead’
v

C:iEmdClass m Parrot

iBase

"Farrot:

'yspecies

Y untiled - Paint
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... and finally, selecting B i rd in the left-hand pane brings up the Class Script for

Bird.
] Exploring C:\Help13.0\ws\PARROTS [#.Bird] =Jo&d
File Edit Options Yiew Tools
EBRXQE | cf mEEE 408
Workspace Tree |C0ntents of #.Bird
@b B A A X ~| a8 4% | *m °F *p
+EBind tClass Bird
+[E0 DomesticPar & :Field Public Species
+ [ Parrot
+ (g7 OSE (o] = 7 eqg spec
[1] tAcceszs Public Insztance
[2] tImplements Canstructor
[3] Speciestszpec
[u] L v
(o] = 7 R<Speak
[1] tAccess Public
[z2] fe'Tweet, tweett'
[31] L 7
tEndClass A Bird
<] I | [i”class | |Pos: 0f15,0
3 objectis), 61,57Mb free, |38548 bytes used (20136 bytes selected) A
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Ifyou open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods ] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and high-
lighting the appropriate section of the script.
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B
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w48 [Properties]
+-%7 [Sections]
4 [ED Parrot

+- (291 OSE

L4 ] 1
3 object{s), 61.57Mhb free,

A& X

| a8 g0

(ol
[11
(21
[al
(4]

w4 [Nested Namespaces] [o]

(1]
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[z21]
(4]
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[11
[z1]
(21

<
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&
=

tGlass DomesticParrot: Parrot
tField Public Hame

7

?

egglname species]

tAccess Public

tImplements Constructor :Bawe
O0F Mame<rname

eggl

tAccess Fublic

tImplements Constructor :Bawk
ODF Mame<'FPolly’

R+Speak
tAccess Public
R<OBASE. Speak, ' Who's a prew

iEndClass A DomezticParrot

I | (]

Pos: 15/21,0

38548 bytes used (20136 bytes selected)
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Browsing Type Libraries

When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:

e Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.

e Load Type Libraries for COM objects

e Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft .Net Framework is installed, you may in addition:

e Load Metadata for specific .Net classes
e Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

Ifthe Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.

..'IJ Exploring CLEAR WS [#] g@ﬂ

File Edit Wiew Columns Tools

$RXQeE | EEEE M8

Workspace Tree Contents of #
- # Name Type
+ OsE

+-Jit MetaData
#1 Typelibs

%' Loaded Libraries
530 Registered Libraries

<] B
0 ohjectis), 61, 7Mb (64700600 bytes) free, 0 bykes used (0 bytes selected) in Lo
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Browsing Registered Libraries

If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.

Ifyou select one of these Library names, some summary information is displayed in
the list view pane.

For example, the result of selecting the Microsoft Excel 9.0 Object Library is illus-
trated below.

2| Exploring CLEAR WS [#] E]@

File Edit View Columns Tools

TR XQE r DEGEE |60

Workspace Tree Contents of Typelibs\Reqgistered LibrariesiMicrosoft Excel 9.0 Ob
#I Microsaft DTSF‘ackag_*j Attribute Value
ﬂil Microzoft Excel 5.C CLSID {0002081 3-0000-0000-C000-00000000004
£ Microsoft Excel 9.0 Object Library. ('u'er'sion:1.3,Ll:uc:ahe:(?l)F"E><

] " T TR DR L= L= LI L ] L= T OSOTT TTTCE TTTC

3{;' Microsoft FlexGrid HelEFiIe C:':Pm;ram Files':Microsoft OFFice'ltOFFice'l,VB
#idMicrosoft FlexBGrid HelpID Dx0000FFFF
#IMicrosoft Forms 2.0 Yersion 1.3

< [ 2] |l 2]

0 object(s), 61.7Mb (64700600 bytes) Free,

Ifinstead, you select the Registered Libraries folder itself, the list of Registered Type
Libraries is displayed in the list view pane

s 1| Exploring CLEAR WS [#] [Z]@

File Edit View Columns Tools

YR XQE r DEGEE |60

Workspace Tree Contents of Tvpelibs\Reqistered Libraries
- B A Mame Loaded | CLSID A
+ OsE ~ || Microsaoft Directs Transforms Image T... {SEFTEE
4.t MetaData Microsoft Disk Quota 1.0 {798865
a \ Microsoft Excel 5.0 Object Library {000z208
= Typelibs . Microsoft Excel 8,0 Object Library | {000208
# Loaded Libraries Microsaft: Flexiarid Control 6.0 {9CF7aAll
547 Re gistered Libraries Microsoft Flexarid Contral 6.0 (SP3) {SESE7E
] Microsoft Farms 2.0 Object Library {0D452E
IAS Hel CoM C©
>y L """ | Microsoft Forms 2.0 Object Library [E7DELC
#9 IAS RADIUS Protocc || microsoft Forms 2.0 Object Library {67DSFO
. (Version:l1.0,Loce Microsoft Farms 2.0 Object Library {BEEAT]
¥l :-) WideoSoft weFle | Microsaft Forms 2.0 Object Library faC115z2
) @ w o ee e M| Microsoft Forms 2.0 Obiect Library {9C1152 %

0 object(s), 61.7Mb (64700600 bytes) Free, 0 bytes used (0 bytes selected) in Local Scope
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Loading a Type Library
You can load a library shown in the list view pane by double-clicking its name.

Alternatively, you can load a library shown in the tree view pane by selecting Load
from its context menu.

In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.

Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 9.0 Object Library brings in the
Microsoft Office 9.0 Object Library and the Microsoft Visual Basic for Applications
Extensibility 5.3 Library too. It also contains references to a general library called the
OLE Automation Type Library, so this is also loaded.

When you ) SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.
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Browsing Loaded Libraries

If you have already loaded any Type Libraries into the workspace, using the Work-
space Explorer or as a result of creating one or more OLEClient objects, you can

select and open the Loaded Libraries folder.

The picture below illustrates the effect of having loaded the Microsoft Excel 9.0

Object Library.

4] Exploring CLEAR WS [#]

M=%

File Edit YWiew Columns Tools

YR XQE| | EEEE (3 sl

Workspace Tree Contents of TypelibsiLoaded Libraries
oy B Mamme
+ OsEk DLE Automation
+-J&t MetaData Unknowin Types o
-y Typelibs Microsoft Office 9.0 Object Library

= ﬂgL':'adEd Libraries: Microsoft Excel 2.0 Objeck Library
w4 Microsoft Excel 9.0 O
+ Microsoft Office 9.0
w4 Microsoft Yisual Baszi
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S| Regiztered Libraries

<] (2]

Microsoft Visual Easic For Applications. .,
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{2FCE3BCE-
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{000ZE157-1
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0 object(s), 61.7Mb (64700600 bytes) free,

Notice that any external references to other libraries causes these to be brought in

too.

Ifyou select a loaded Type Library, summary information is displayed in the list

view pane.

If you open a loaded Type Library, four sub-folders appear named Object CoClasses,

Objects, Enums and Event Sets respectively.
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Object CoClasses

A Type Library describes a number of objects. Typically, all of the objects have prop-
erties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.

For example, the Microsoft Excel 9.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.

) Exploring CLEAR WS [#] =<

File Edit ‘Wew Columns Tools

P RXQE | » @0 EE(560 e

‘Workspace Tree Contents of TypelibsiLoaded Libraries\Microsoft Ex
= || Mame CLSID
OSE Application 4000245
Wt MetaDat a Chart 1000208

T Lib Global 4000203

= Typelibs - . - || oLECbject 4000205
=4 Loaded Libraries QuetyTable {59191C
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ﬂilEObj ect CoClasses !
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%1 Enums

#'l Event Sets

<] —m e R Yl = B

0 ohject(s), 61.7Mb (64700600 bytes) free,
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Opening the Application folder you can see that the Application CoClass comprises
the Application object coupled with the AppEvents event set as shown below.

4] Exploring CLEAR WS [#]

l=Jo/Ed

File Edit YWiew Columns Tools

P RXQE| r @ EEE (5
workspace Tree Conkents of TypelibsiLoaded LibrariesMicrosoft Ex
ElaiilLu:-aded Libraries [A]
=4I Microsoft Excel 9.0 Object hame Application
Sl Object CoClasses CLSID {00024500-0000-0000-C000-
HelpString
A ||| HelpFile Ci\Program Files\Microsoft Of
=-#1 Event Sets = ||| HelpID 0x00020001
| AppEvents
= g%l Interfaces
=% _Application
£ Methods
£ Froperties
#9 Chart
-3 Global ()
[{] I | [)] [(] i [}]

0 object(s), 61.7Mb (64700600 bytes) Free,

The specific methods, properties and events supported by the CoClass object can be
examined by opening the appropriate sub-folder. The same information for these and
other objects is also accessible from the Objects and Event Sets folders as discussed

below.
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Objects

The Objects folder contains several sub-folders each of which represents a named
object defined in the library.

Each object folder contains two sub-folders named Methods and Properties. Select-
ing one of these causes the list of Methods or Properties to be displayed in the list
view pane. The picture below shows the Methods exposed by the Microsoft Excel
9.0 Range object.

) Exploring CLEAR WS [#] =<

File Edit “ew Columns Tools

TR XQE | @EEE 360l

‘Warkspace Tree Contents of TypelibsiLoaded LibrariesiMicrosoft Excel 9.0 Obijg
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- #8 Rectangles v g YT YARIANT %)

< B3 S Ed

0 objeckis), 61, 7Mb (64700800 bytes) free,
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If you open the Methods or Properties subfolder, you can display more detailed infor-
mation about individual Methods and Properties. For example, the following picture
shows information about the SaveAs method exposed by the Microsoft Excel 9.0
Worksheet object.

4] Exploring CLEAR WS [#] =JEEs

File Edit Wiew Columns  Tools

B XQE  EEEE 2o el

Workspace Tree Contents of TypeLibsiLoaded Libraries\Micrasoft Excel 9.0 Object Library
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ﬂ:l ResetAl1PageBreaks Fllename VT BSTR [ir]
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o ReadCnlvRecommended YT_VARIANT  [Optional],[in]
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< ¥ < >

0 object(s), 61.7Mb (64700600 bytes) Free,

This tells you that the SaveAs method takes up to 9 parameters of which the first, File-
name, is mandatory and is of data type VT _BSTR (a character string). Note that [in]
indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose
value must be one of a list of Enumerated Constants. Even without looking at the
documentation, the possible values can be deduced by browsing the Enums folder,
with the results shown below.

] Exploring CLEAR WS [#] Mi[=)[<
File Edit Mew Columns Tools
EERXQHE o EEER 21dlol6l
Workspace Tree Contents of TvpelibsiLoaded Libraries\Microsoft Exce
X1EditionOptiora|| MName |\p'alue Fadl
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W E T e mmmt #|ExcelZFarEast Z7
R1Fi1TWith #|Exceld 33
K¥1FilterAction xlExcels 39
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0 object(s), 61.49Mb (64474120 bytes) free,

You can therefore deduce that the following expression, executed in the namespace
associated with the currently active worksheet, will save the sheet in comma-sep-
arated format (CSV) in a file called mysheet.csv:

SaveAs 'MYSHEET.CSV' xlCSV
or

SaveAs 'MYSHEET.CSV' 6
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Event Sets

The Event Sets folder contains several sub-folders each of which represents a named
set of events generated by the objects defined in the library.

If you open one of these event sets, the names of the events it contains are displayed
in the tree view pane. If you then select one of the events, its details are displayed in
the list view pane as shown below.

r."ﬂ Exploring CLEAR WS [#] E]@w
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0 object(s). 60.34Mb (63266256 bytes) free.

This example shows that when it fires, the SheetActivate event invokes your call-
back function with a single argument named S% whose datatype is VT_DISPATCH
(in practice, a Worksheet object).
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Enums

The Enums folder will typically contain several sub-folders each of which represents
anamed set of enumerated constants.

Ifyou select one of these sets, the names and values of the constants it contains are
displayed in the list view pane as shown below.
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Browsing .Net Classes

Microsoft supplies a tool for browsing .NET Class libraries called TLDASM. EXEL

As a convenience, the Dyalog APL Workspace Explorer has been extended to per-
form a similar task as TLDASM so that you can gain access to the information within
the context of the APL environment.

The information that describes NET classes, which is known as its Metadata, is part
of'the definition of the class and is stored with it. This Metadata corresponds to Type
Information in COM, which is typically stored in a separate Type Library.

To enable the display of Metadata in the Workspace Explorer, you must have the
Type Libraries option of the View menu checked.

I TLDASM.EXE can be found in the NET SDK and is distributed with Visual Studio
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To gain information about one or more Net Classes, open the Workspace Explorer,
right click the Metadata folder, and choose Load.

rm Exploring CLEAR WS [#] g@1

File Edit Wiew Columns Tools
ABXQE (@O DO (B
Workspace Tree Contents of MetaData

ERL.
=) OSE

Bt MetaData
&Y Typelibs

This brings up the Browse .Net Assembly dialog box as shown below. Navigate to
the .NET assembly of your choice, and click Open.

Browse .Net Assembly -\
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Note that the NET Classes provided with the .NET Framework are typically located
in C: \WINDOWS\Microsoft.NET\Framework\v2.0.50215. The last
named folder is the Version number.

The most commonly used classes of the NET Namespace System are stored in this
directory in an Assembly named mscorlib.dl1, along with a number of other fun-
damental .NET Namespaces.

The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely
reflects the structure of the Metadata itself.
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Opening the System/ Classes sub-folder causes the Explorer to display the list of
classes contained in the NET Namespace System as shown in the picture below.
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .cfor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.

For example, you can deduce that DateTime . New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. There
are in fact seven different ways that you can create an instance ofa DateTime.

4 Exploring CLEAR WS [#] -Joks
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et (Private)VWoid .ctor(Int6l, System.DateTimeKind, Baaolean)
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Mgt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, S5
Mgt Void .ctor(Int32, Int32, Int32, Int32, Int32, Int32, Int32, S5,
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+- Mgt Methods |
+ . J#t Properties id
4 >

For example, the following statement may be used to create a new instance of
DateTime (09:30 in the morning on 30t April 2001):

mydt<[INEW DateTime (2001 4 30 9 30 0)

mydt
30/04/2001 09:30:00
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The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.

réﬂ Exploring CLEAR WS [#] g@1
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P RXQE| ~|[EEEE |56 el o
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%t Date : System.DateTime
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Bt Kind : System.DateTimeKind
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Tt Ticks @ System.Intél
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Tt UtcHow : System.DateTime
%t Year @ System.Int3Z [v]

(<] | i | (2]

You can query a property by direct reference:

mydt.DayOfWeek
Monday
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Notice too that the data types of some properties are not simple data types, but

Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance of the System. DateTime object:

mydt.Now
07/11/2001 11:30:48
aTs
2001 11 7 11 30 48 O

The Methods folder lists the methods supported by the Class. The Explorer shows the
data type of the result of the method, followed by the name of the method and the
types of its arguments. For example, the IsLeapYear method takesan Int32
parameter (year) and returns a Boolean result.

mydt.IsLeapYear 2000

1] Exploring CLEAR WS [#] M=%
File Edit “iew Columns Tools
18X Q| | [E0mE [ sl ol
Workspace Tree
gt (PrivatelVoid Finalizel() Ai
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figt Boolean TryParsel(System.String, System.DateTime ByRef
figt Boolean TryParse(System.String, System.IFormatProvide
figt Boolean TryParseExact(System.String, System.5tring, S
figt Boolean TryParseExact(System.String, System.Stringl],

 digt Double ToOQADate() ,V:
< >
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Many of the reported objects are listed as Private, which means they are inaccessible
to users of the class — you are not able to call them or inspect their value. For more
information about classes, see the chapter on Object Oriented Programming in the
Dyalog APL Language Reference Manual.
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f&t Bonlean op_LessThanOrEqualCsustem.DateTime, Suste

%ét Boolean TryParselsustem.5tring, Sustem.DateTime E

%ét Boolean TryParselsustem.5tring, Sustem.IFormatPrc

%ét Boolean TruParseExact(Sustem.String, Sustem.Strir

%ét Boolean TruParseExact(Sustem.String, Sustem.Strir

%ét Double ToDADate(d

Hét [nt3z Comparelsustem.DateTime, Sustem.DateTimel
< >

1 objeckis). 53.9Mb (56518472 bytes) free,
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Find Objects Tool

The Find Objects tool is a modeless dialog box that may be toggled on and off by
the system action [WSSearch]. In a default Session, this is attached to a Menultem
in the Tools menu and a Button on the session toolbar. This tool allows you to search
the active workspace for objects that satisfy various criteria.

The first page allows you to specify the name of the object which you wish to find
and the namespace(s) in the workspace that are to be searched for it.

£ Find Objects

File Edit Wiew Columns 3Search

b O I I A I = O O At |

gDeIete Props Large | Small  List Details | Mame | Size Date Tvpe

Name/Location | Madiied | Advanced

MNamed:

ariables Functions Operators Mamezpaces
Loak i
Include sub-nameszpaces Include Sezzion namespace

You type the name of the object you wish to find into the field labelled Named. To
locate all objects beginning with a particular string, enter the string followed by a 'x'
character. For example, if you enter the string FOOx*, the system will locate all
objects whose name begins with FOO.

Four check boxes are provided for you to specify the types of objects you wish to
locate. For example, if you clear Variables, Operators and Namespaces, the system
will only search for functions.
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You can restrict the search to a particular namespace by typing its name into the field
labelled Look in. Y ou can also restrict the search by clearing the Include sub-
namespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have specified
in Look in, and does not search within any sub-namespaces contained therein. Clear-
ing the latter causes the system to ignore [JSE in its search.

The second page, labelled Modified, allows you to search for objects that have been
modified by a particular user or at a certain time

£ Find Objects

File Edit Wew Columns Search

* B BB @B E | #4|od = o8l

;Delete Props Large | Small  List  Details | Mame | Size  Date  Type

Mame/Location | Modified | 4dvanced

Modified Dbjects

Modified by:

) Any date

@ civean | 07M12/2007
and 06/01/2008

O during the presious mianth(z]

) during the previous day(s]

To make the search dependent upon modification, you must check the Modified
Objects check box.

To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.

To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates or
time spans.
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The third page, labelled Advanced, allows you to search for objects that contain a par-
ticular text string.

£ Find Objects

File Edt Wiew Columns  3Search

X E H B8 B B | #4|o sl ol

gDeIete Props Large | Small  List  Details | Mame | Size Date Tvpe

Mame/Location | Modified | Advanced

Containing T ext: ]

Match Caze tdatch whole Ward
Ilse Fegular Expressions [ | As Symbol Reference

[]5ize between

If you wish to search for objects containing a particular character string, type the
string into the field labelled Containing Text.

Match Case specifies whether or not the text search is case sensitive.

Use Regular Expressions specifies whether or not regular expressions are applicable.
For example, if you enter FOO* into the field labelled Containing Text and check
this box, the system will find objects that contain any text string starting with the 3
characters FOO. If this box is not checked, the system will find objects that contain
the 4 characters FOO*.

Match Whole Word specifies whether or not the search is restricted to entire words.

As Symbol Reference specifies whether or not the search is restricted to APL symbols.
If so, matching text in comments and other strings is ignored.

If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields pro-
vided.
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When you press the Find Now button, the system searches for objects that satisfy all
of the criteria that you have specified on all 3 pages of the dialog box and displays
themin a ListView. The example below illustrates the result of searching the work-
space for all functions containing references to the symbol CURSOR.

-,

&1 Find Objects

File Edit Wwiew Columns Search

X B OB EH EBE B 2l o 9 &l

Delete Props Large Small  List Details || Mame Size  Date  Type

Mame/Location | Modiied Advanced l
Containing Text: | CURZOR j

v tatch Caze vk atch whale Word Mew Search
v UszeBegular Exgpressions | Az Symbol Beference Cloze

[ Size between |

Mame Location ||
.@BED_EOPYMENUS #.Whesign.BMED
.@EHﬁ.HGEPHﬁ.L #.Whesign '
Firipenr p1rienl # LiNasinm RMWER bl
4 »

6 object{s) Found in Global Scope

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in the
Workspace Explorer. You may also edit, delete and rename objects in the same way.
Furthermore, objects can be copied or moved by dragging from the ListView in the
Search tool to the TreeView in the Explorer.

If you wish to specify a completely new set of criteria, press the New Search button.
This will reset all of the various controls on the 3 pages of the dialog box to their
default values.
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Object Properties Dialog Box

The Object Properties dialog box displays detailed information for an APL object. It
is displayed by executing the system action [Ob jProps]. In a default Session, this
is provided in the 7ools menu, the Session popup menu and from the Explorer. An

example (for a function) is shown below.

Properties Tab

The Properties tab displays general information about the object. For a function, this
includes an extract from its header line, when it was last modified, and by whom.

¥l #.CENTRE - Properties

=,

{ Properties || value | Monitor

CENTRE

Type Function
Dezcription
Location  #

Size 3926 [392 bytes]

By Diyadic

Modified 04 Movember 1998 12:35

1]9

I

Cancel
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Value Tab

For a variable, the Values tab displays the value of the variable. For a function, it dis-
plays its canonical representation.

Y] #.CENTRE - Properties

-,

[11]
[2]
(2]
(L]
(5]

Froperties || ¥alue | kanitor

¥ TEXT+<W CENTRE TEXT:SPC5:FORE;BACK
TEXT=( (" 1LpTEXT), WITTEXT
SPCE<TEXT=" '
FORE++/~%5PCS
BACK<+/~%$EPCE
TEXT=([0.5=<FORE-BACK) $TEXT

Centre TE.
Stretch t
Identify :
Humber of

D DD D 323D

Rotate ea:

(] l[ Cance
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Monitor Tab

The Monitor tab applies only to a function and displays the result of JMONITOR.
The Reset button resets JMONITOR for the lines on which it is currently set. The Set
All Lines button sets JMONITOR to monitor all the lines in the function. The Clear
All Lines switches JMONITOR off.

[ 1
¥] #.CENTRE - Properties

Properties | Yalue | Manitor

Line Murmber Counk CPU kime {ms) | Elapsed time (ms)

o 4006 551 550

1 4006 140 150

2 4006 F0 70

3 4006 30 40

4 4006 &0 &0

5 4006 130 130

Reset | | SetéllLines | | ClearallLines |
[ (] H Cancel
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COM Properties Tab

The COM Properties tab applies only to a function in an OLEServer or Activ-
eXControl namespace. The tab is used to define arguments and data types for an
exported Method or Property. For further information, see Interface Guide.

Y] #.Loan.CalcPayments - Properties
Properties | Walue | Monitor| COM Properties
Param Name| Type | b odifier | Optional |
Result | WT_R& | WT_ARRAY|w
Laandmt WT_l4 4 E4 ]
LerMax  VT_I4 v ~ O
LerMin  WT_I4 v ~ O
Itz VT4 v ~ O
niMin VT_I4 v ~ O
Help 1D

{(®) Method () Prop Get ) Prop Set

Exported

(] l [ Cancel
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Net Properties Tab

The Net Properties tab applies only to a function in a NetType namespace. The tab is
used to define arguments and data types for an exported Method or Property. For fur-

ther information, see .Net Interface Guide.

e -
#] #.APLClasses.Primitives. IndexGen - Properties E]
F"ru:uperties] Yalue ] b cnitar
Param Name| Type | b ddifier | O ptional |
Resut  |Int32) | -
Murnber Int32 - ﬂ n
Help o] |

0+ Method " wieb Method  © Prop Get ¢ Prop Set |

[+ Public [ Static [ Wirtual [ Construchar
[ Protected

k. | Cancel
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The Editor
Invoking the Editor

The editor may be invoked in several ways. From the session, you can use the system
command ) ED or the system function [JED, specifying the names(s) of the object(s) to
be edited. You can also type the name of the object and then press Shift+Enter (ED),
click the Edit tool on the tool bar, or select Edit from the Action menu. If you invoke
the editor when the cursor is positioned on the empty input line, with a suspended
function in the State Indicator, the editor is invoked on the suspended function and
the cursor is positioned on the line at which it is suspended. This is termed naked
edit. These ways of invoking the editor apply only in the session window

£ Editor - [BUILD_SESSION] =)o
[ file Edit Refactor window iiew - & =
1A A X v 0B 4 m*F P

[0] {FILE}EBUILD_SESSION LANG: OBT; MSG: OI0:OML; OLD; NEW; MOTIF 2 w|a
[1] A Build the zesszion object and szave if desired

[2] :If 0=0ONC'MoPrompt' < MoPrompt+0 <@ :EndIf

[3] :If O=0ONC'FILE' = FILE+'' % :EndIf

[L]

[5] OWs+0SE.OWs+1 < OML OI0«1 < OPATH+'#.Trans'

[6] OPW+=122 A allows room for Status Bar

[7] MOTIF+='M'=32t«"_ 'OWE"'APLYerszion'

[a] Y12+122230VFT{ (7 1oy’ Dt} 2ot

[2] LANG+upCase, LANG A translation assumes uppercase

[10] UNICODE+80=00R" '

[11] ‘“Unknown language 'O5IGHNAL(Trans.CODESe™~cLANG) 411 ¥
< 2
Function Last saved by Pete: 14 August 2009 0951 Pos: 0f207,1

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the left
mouse button. Alternatively, you can press Shift+Enter or select Edit from the File
menu. The name can appear in the Session, in an Edit window, or in a Trace window;
the effect is the same. Note that, in the Session, typing a name and pressing
Shift+Enter is actually a special case of point-and-edit. Note also that a naked edit
can be invoked by double-clicking the left mouse button in the empty input line.

The type of a new object defaults to function/operator unless the object is shadowed,
in which case it defaults to a variable (vector of character vectors). You can however
specify the type of a new object explicitly using ) ED or JED . For example, typing
")ED €LIST -MAT"ina CLEAR WS would create Edit windows for a vector of
character vectors named LIST and a character matrix called MAT. See ) ED or[JED for
details.
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Ifthe name is not already being edited, it is assigned a new edit window. If you edit a
name which is already being edited, the system focuses on the existing edit window
rather than opening a new one. Edit windows are displayed using the colour com-
bination associated with the type of the object being edited.

Window Management (Standard)

Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone window,
or be docked in the Session window. Each of the objects being edited is displayed in
a separate sub-window. Individual edit windows are managed using standard MDI
facilities.

Editor - |8
[ SEIX]

File Edit Refactor ‘Window View

JP BUILD_SESSION =

FOA A X v|d8 & *m°F °p

[0l {FILE}BUILD_SESSION LANG;OBJ;MSG;DIO;DML;OLD;NEH;MOTIF;CI@
[1] A Build the session object and save if desired

[21 - — : — .

(3] |/ BUILD_MB_FILE =<
[L]

ey [F1 R A X v|d8 40 m *F %P
[&] [o] MEB BUILD_MB_FILE LANG

[7] [1] Ocs Me

[8] [2]

[9] [3] "file'OWE 'Menu' [LANG TranslateString &File’]
reed L]

[ﬂ— [5] 'file.clear 'OWC'Menultem' (LANG TranslateStringm
Functiortli [ ¢ ] "file.clear 'OWS 'Event' 'Select’ '[wsclear]’

[7] "file.clear 'OWS'Hint ' (LANG TranslateString ' Clew

[e]
i | [l]

Function johnd: 10/04/2006 Pos: 0/67,1

The initial size of an edit window is specified by the edit_rows and edit_cols param-
eters. The first edit window is positioned at 0 0. Subsequent ones are staggered
according to the values of the edit_offset y and edit_offset x parameters.

By default, the Session has the Editor docked along the right edge of the Session win-
dow. When you edit a function, the Editor window automatically springs into view
as illustrated overleaf.
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P C:\Program Files\Dyalog\Dyalog APL 12.1 Unicode'ws\BUILDSE - Dyalog APL/W JoEd

File Edit Wiew Windows Session Log Action Options Tools Threads Help
© cu | Sesson [ PLIS nicode v ][ 1672

ws O SO iobe BB S VE b @k it 6 MM e

Language Bar o= ﬁ

FEDELEEEEE] [TRE FREFEEF (EORER L[]} [ Elelel=ls] [TELL [PRlF & &
Unicode Edition [~
Fri Aug 14 09:59:28 2009
clear ws

Jload BUILDSE

C:“Program Files\DyaloghDyalog APL 12.1 Unicodebws\BUILDSE saved Tue Jul 28 12:11:18 2009
This warkspace is used to reset the session according to some
international formats like german, french or english.
For example, to redefine the italian look try

BUILD_SESSION 'IT'
You can slso reset the SALT utility programs hers by doing

BUILD_DVALOGSPACE
In any case, to make sure the charges are sffective, you should
save your session via the menu item Session/Save or Save as...
Dyalog 2008
Yersion 2.31

Yfns
BUILD_DYVALOESPACE BUILD_MB_ACTION BUILD_MB_EDIT BUILD_MB_FILE BUILD_MB_HELP BUILD_MB_LOG
BUILD _MB_OPTIONS BUILD_MB_SESSION BUILD_MB_THREADS BUILD_MB_TOOLS BUILD_MB_VIEW
BUTLO_ME_WIEW_COOL BUTLD_ME_WIKDOWS BUILD_POPUP BUTLD_3B BUILD_SESSION  BUILD_TB
BUILD_TC Bootlib BootLocation Boot SALT BuildSessionMenu Dll¥ersion GetUTF8File
I0_TOBGLE KEY_TOGGLE POSITION_SESSION TB_POPUP TOGELE  UCMD WSloaded lowCsze
upCase wsdiff
5
=

Debugger w

Ready. .. Ins  HUM

CurQbj: &1l Opo:o  OTRAP  OSI:o  OI0:1 OML:0
1 C:\Program Files\Dyalog\Dyalog APL 12.1 Unicode'ws\BUILDSE - Dyalog APL/W ==X

File Edit Refactor Window View
ws O P8 S iobex BB S5 V o B2 @ b oo & G [ W Ed
Language Bar Zleix ﬁ

) cu | Session (S| APLI8E Unisode 1678

[FFFEFERET) (TIL FRERFEER | eumr——
Fri Aug 1b 09:59:28 2009 [a] -

Bl A A X v|ab g m*F P
[o] {FILE}BUILD_SESSION LANG:OBI;MSG:O10:0ML: OLD: NEWsMOTIF; COC
[1] f Build the session object and save if desired
[21 +If 0=0ONC'NoPrompt' ¢ NoePrompt+0 ¢ :EndIf

[3] :If O=ONC'FILE' ¢ FILE+<'' % :EndIf

[u]

[s1] OWX+0SE.OWX+1 < OML OI0+1 < OPATH+'#.Trans'
[8] OP.-
7] MoT1 555 BUILD_MB_FILE

[l V124
e Neles poA X v|d8 & m*F °p

[10] untgflel MB BUILD_MB_FILE LANG

[t1] unifl1] Ocs Me

[12] r2]

[13] n Exg (3] |'file'OWE Menu' (LANG TranslateString &File’)
[14] A ang|l4]

clear ws
Jload BUILDSE
C:\Program Files\Dyalog\Dyalog APL 12.1 Unico

This workspace is used to reset the session a
international formats like german, french ar

For example, to redefine the italian look try
BUILD_SESSION 'IT’

You can alse reset the SALT utility programs
BUILD_DYALOGSPAGE

In any case, to make sure the changes are eff
ssve your session via the menu item Session/S

Dyalog 2003 151 0g74 (5] “file.clear'OWG Menultem' (LANG TranslateStrin
Version 2.31 1161 opll6] “file.clesr'OWS 'Event’ 'Select’ '[wsclear]’
Jins [171 or1,|L7] “file.clear'OWS 'Hint ' (LANE TranslateString Gl
BUILD_DYALOGSPACE BUILD_ME_AGTION BUILD mrufl8]
BUILD_ME_OPTIONS BUILD_MB_SESSION [91 "file.load OWC'Menultem' (LANG TranslateString
BUILD _MB_WIEW COOL BUILD _MB_WINDOWS Function [1o] "file.load WS Event’ ‘Select’ '[wsload]l’
BUILD_TC " Bootlib Bootlocatian Boots [11] "file.load 'OWS'Hint (LANG TranslateString'Loa
[0_TOGELE KEY_TOGELE POSITION_SESS f1z2]

[13] “file.copy OWE'Menultem' (LANG TranslateString
[14] “file.copy OWS'Event’ ‘Select’ '[wseopyl’ L

ris1 (TR P LIS U et O ANP Taamal b aSkninn ! Nan

<] )

upCase wsdiff

m \ 3]

Function Last saved by johnd: 10 April 2006 11337 Pos: 3/67,1 [v]
n

Editor

Debugger Ao x|
Ready. .. Ins HUM

CurObj: ME (Undefined) &:l Opa:o  OTRAF  OSI:0  OI0:1  [OML:0
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You can resize the Editor pane to view more or less of the Session itself, by dragging

its title bar.

Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In
either case, the restore button quickly restores the 2-pane layout.

The picture below shows the effect of maximising the Editor. The BUILD_SESSION
edit window is itself maximised within the Editor too.

£ C:\Program Files\Dyalog\Dyalog APL 12.1 Unicode\ws\BUILDSE - Dyalog APLAY - [BUILD_SESSION] |==|
Jp Fle Edt Refactor Window Yiew -8 x
ws DM E Y o BB S5 v b B2 @b oo O G H e ¥ 4 G Session (B APL3BSUnicede (v || 162
aunﬁx ~ b dh *m *F %P
| [o] {FILE}BUILD_SESSION LANG; 0BT MSG; OI0; OML; OLD; NEWsMOTIF; COOL; MB; SB1; SB2; TB; SBs SEBH  toolsidyalogikini ok OPATH » &
[1] A Build the sezsion object and save if desired
[2] t1fF 0=0NC'NoFrompt' © NoPrompt+d & :EndIf
[31 :If 0=0ONC'FILE' © FILE+'' ¢ :EndIf
[u]
[5] OWX+0SE.OWX+1 < OML OI0<1 ¢ OPATH+'#.Trans’
le] OPWe122 7 allows roam for Status Bar
[71 MOTIF+'M'=32t«". 'OWG " 'APLYersion’
[al Y12¢1222900F 1L (" 1+en . ') tw} 2ot
[3] LANG+upCase, LANG @ translation assumes uppercase
[101 UNIGCODE<B0O=0DR' '
[111 "Unkonwn lTanguage '0SIGNALLTrans.CODES=XcLANGI+11
[12]
[13] A Expunge MenuBar(s), StatusBar(s), ToolBar(s) and TipField(s)
[l A and expunge OSE.WSDoc and OSE.HumEd
[15] OBJ+«0OWN 'OSE "
[16] OBI+( (0BT [OWE"c'Type')e'MenuBar’ 'StatusBar' 'ToolBar' 'TipField' 'Menu' 'CoalBar')/0BI
[1vl OBJ,+'0SE.WSDoc' 'OSE.MNumEd'
[18] DEX 0BT
[19] 'OSE‘OWS 'Event' 0 0
[20]
[211 :If 0=2p0BJ«0SE.ONL 2 2 4 9
[22] 0BJe~o ' 'TLIOBT
[23] TEXT=(='Da yau want to delete all the following Session objects 7°),087
[2uv1 'MSE'OWC 'MsgBox ' 'BUILD_SESSION'TEXT('Style' 'Query')('Event' "All' 1)
[25] $IF NoPrompt
[26] 10r1f 'MsgBtnl '=25000Q'MSG'
[271 [+ Removing ', (7242,/0B7,7c', '),’
[281 OSE.OEXT0BT
‘5 [29] ‘... Done’ v
£l 2]
W Function Last saved by: Danb: 19 May 2009 11:42 Pos: 0j207,1
Ready. .. Ins  NUM
Curdbj: MB (Undefined) &:1 Opg:0o  QOTRAP  OSI:o  OI0:1 OML: 0

Note that when the Editor has the focus, the Editor menubar is displayed in place of

the Session menubar.
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Window Management (Classic Dyalog mode)

If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit win-
dow is a top-level window created as a child of the Session window. This means that
Edit windows always appear on top of the Session.

The first edit window is created at the position specified by the edit_first y and

edit_first_x parameters. The initial size of an edit window is specified by the edit_
rows and edit_cols parameters.

§ BUILD_SESSION M =)<

File Edit Refactor View

1 A A X v |8k 4h *m *F

[0] I{FILE}EUILD_SESSIOH LAHG:OEJ:MSG:DIO:P_;&.

[1] f Build the sezszion object and save ifml

[2] :If 0=0ONC'NaPrompt' < NoPrompt<0 < :Em

[3] :If 0=0ONC'FILE' ¢ FILE<'' ¢ :EndIf

(L]

[5] OWE+OSE.OWE+1 < OML OI0+1 < OFPATH+'#.w»

[£] OPW+122 A allows room for Status Bar (¥

.{. .}-

Function Danb: 190052009 | Pos: 0/207,1

| 54

Ly ¢ B BUILD_TC M=

o7 File Edit Refactor Wiew

(171 |61 A A X v |6 4 *m*

(2] |ITo] BUILD_TC LAMG:¥:IL:TB:S A

(3] )iT11 [L+(='0%E.chtap. '), iln' "ilh' 'ili wl

(L1 21 TB+'Ose.chtop.bandthl.th’

(51 ||[21 TE OWC 'Toolcantral '('Divider' OJ0"'Sh ®

(6] |([u] tWith TE

£ =1 OWS ' Imagelist'IL

Functilf[ £ ] If ~H.MOTIF A pop-up menu probl ®
[7] OWs('Event' 'Mouselown’ '0O5E =
[2] tEndIf —
rn1 1
Funckion johnd: 08/01/2008 Pos: 0f182,1
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Subsequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.

Moving around an edit window

You can move around in the edit window using the scrollbar, the cursor keys, and

the PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the begin-
ning of the top-line in the object and Ctrl+End moves the cursor to the end of the last
line in the object. Home (LL) and End (RL) move the cursor to the beginning and

end respectively of the line containing the cursor.

Closing an edit window

Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then closes
the edit window.

Minimising an edit window

Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the nor-
mal way, or by an attempt to re-edit the same name.
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Editor ToolBar

A A X

~[06 8 *m*F %P

Toggle line numbers

A

Comment selected text

A

Uncomment selected text

X

Save changes and return

Search Box

ik
Search for Next Match

A

Search for Previous Match

m

Refactor text as method

*F
Refactor text as field

*p
Refactor text as property

Toggles Line numbers on/off.

Adds a comment to the beginning of
the current line or all selected lines.

Removes a comment (if present) from
the current line or all selected lines.

Saves changes and closes the current
edit window.

Enter search text and click one of the
following two buttons.

Locates the next occurrence of the
search text

Locates the previous occurrence of
the search.

Inserts a Method template for the
selected name.

Inserts a Field template for the
selected name.

Inserts a Property template for the
selected name.
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The File Menu

Fix

Print...
Print Setup...

Properties

Exit {and Fix) Esc

Exit and discard changes Shift+Esc

The File menu illustrated above is displayed when editing a simple object and pro-
vides the following options.

Fixes the object in the workspace, but leaves the edit
window open. Edit history is also preserved. If the data

Fi .
X has changed and the confirm_fix parameter is set, you

will be prompted to confirm.

Fix Script (Disabled unless editing a script)

. Opens an Edit window on the name under the mouse

Edit . .
pointer. (Disabled when not).

Print Prints the current contents of the edit window.

Print Setup

Displays the Print Configuration dialog box.

Properties

Displays the Object Properties dialog box for the
current object.

Exit (and Fix)

Fixes the object in the workspace and closes the edit
window. If the data has changed and the confirm_exit
parameter is set, you will be prompted to confirm.

Exit (and fix
script)

(Disabled unless editing a script)

changes

Exit and discard

Closes the edit window, but does not fix the object in
the workspace. If the data has changed and the
confirm_abort parameter is set, you will be prompted
to confirm.
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The File Menu (editing a script)

Fixx whole script
Fixx only Funckions

Print...
Print Setup...

Properties

Exit and fix whole script Esc
Exit and fix only Functions
Exit and discard changes  Shift+Esc

The File menu illustrated above is displayed when editing a script and provides the
following different options from those shown on the preceding page.

Fix whole script Fixes the entire script

Fix only functions | Fixes only the functions in the script.

Exit and fix whole

. Fixes the entire script, and exits the Editor.
script

Exit and fix only | Fixes only the functions in the script and exits the
functions Editor.

Editing Scripts

Suppose that you have a Class that manages a list of items in a shared Field, so some-
where in the script would appear a line such as:-

:Field shared public List {gets} {zilde}

You run your application for a bit, and L i s t, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want List to be reset back to the empty vector although you do want the new ver-
sion of the function(s) in the Class to be fixed.

Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and L i st re-initialised.

The options in the File menu shown above provide for these alternatives.

In addition, the Configuration dialog (See "Fixing Scripts" on page 148) allows you
to define the behaviour of the keystrokes <EP> and <S1> for both the suspended
case and the non-suspended case. This association will be displayed against the
appropriate action according to the state of the script you are editing.
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The Edit Menu

The Edit menu provides a means to execute those commands that are concerned with
editing text. The Edit menu and the actions it provides are described below.

Reformat kKeypad-slash
Zut Shift+Delete
Copy Ckrl+Insert
Paste Shift+Insert

Paste Unicode
Paste Mon-Unicode

lear Delete

open Line Ckrl+35hift+Insert
Delete Line Ckrl+Delete

Gota Line

Eird. ..

Replace...

Comment Selected Lines  Chrl+alk+,
Uncomment Selected Lines  Chrl+alk+,

Toggle Local Mame Ckrl+HUp
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Reformats the function body in the edit window, indenting

Reformat .
control structures as appropriate.
Undoes the last change made to the object. Repeated use of
Undo this command sequentially undoes each change made since
the edit window was opened.
Redo Re-applies the previous undone change. Repeated use of
this command sequentially restores every undone change.
Copies the selected text to the clipboard and removes it
Cut .
from the object.
Copy Copies the selected text to the clipboard.
Paste Copies the text in the clipboard into the object at the

current location of the input cursor.

Paste Unicode

Same as Paste, but gets the Unicode text from the clipboard
and converts to JAV

Paste Non- Same as Paste, but gets the ANSI text from the clipboard
Unicode and converts to [JAV.

Deletes the selection or the character under the cursor. Has
Clear .

no effect on the clipboard
Open Line Inserts a blank line immediately below the current one.

Delete Line

Deletes the current line.

Prompts for a line number, then positions the cursor on that

Goto Line line.

Find Displays the Find dialog box.

Replace Displays the Replace dialog box.

Comment Adds a comment symbol to the beginning of all selected

selected lines

lines.

UnComment
selected lines

Removes a comment symbol from the beginning of all
selected lines.

Toggle Local
name

Adds or removes the name under the cursor to/from the
function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.
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Once displayed, each of the two dialog boxes remains on the screen until it is either
closed or replaced by the other. This is convenient if the same operations are to be
performed over and over again, and/or in several windows. Find and Find/Replace
operations are effective in the window that previously had the focus.

The Refactor Menu

Add text as Field
Add text as Properky
Add kext as Method

The Refactor menu illustrated above applies only when editing a Class and provides
the following options. In each case, the user must highlight a name in the Edit win-
dow, and then select one of these options to insert the appropriate template for that
name into the body of the Class.

Add text as Field Inserts a Field template for the selected name.

Add text as Property |Inserts a Property template for the selected name.

Add text as Method |Inserts a Method template for the selected text name.

The View Menu

Trace
W Stop
Monitor

Line Mumbers Mum -
v Funckion Line kMumbers

W Tree Yiew

v Ouklining
Expand all Cutlines
Zollapse All Dutlines
Expand all Dutlines below here
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The View menu, illustrated above, provides the following actions.

Displays a column to the left of the function that displays
Trace .
OTRACE settings
Displays a column to the left of the function that displays
Stop .
OSTOP settings
. Displays a column to the left of the function that displays
Monit .
onttor [OMONITOR settings
Line Toggles the display of line numbers on/off.
Numbers £g play ’
Function Toggles the display of line numbers on individual functions
Line on/off. This option is only enabled when editing a Class,
Numbers Namespace script or Interface.
Tree View |Toggles the display of the treeview in the left-hand pane.
Outlining Turns outlining on and off.
Expand All .
Outlines Expands all outlines.
1l All .
Co flpse Collapses all outlines
Outlines
Expand all
Outlines Expands all outlines below the level of the current line.
below here

Function Line Numbers

The Function Line Numbers option in the Editor menu provides an additional level
of line-numbering. If selected, line numbers are displayed independently on each
individual function (or operator) in the Class. This option is only enabled when you
are editing a Class, Namespace script or Interface, and is disabled for all other types

of object.

Note that function line-numbering and general line-numbering are independent
options and it is possible to have the entire Class numbered (from [0] to the number
oflines in the Class) in addition to having line-numbering on each individual func-

tion.
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The Window Menu

The Window menu provides a means to control the display of the various edit win-
dows. The Window menu and the actions it provides are described below.

Close Al Windows

Cascade
Tile

Arrange Icons

Editar
Debugger

Close All
Windows

Closes all the edit windows. If Confirm on Edit Window Closed is
checked, you will be prompted to confirm for any objects that you
have changed.

Cascade

Arranges the edit windows in overlapping fashion.

Tile

Arranges the edit windows in a tiling fashion.

Arrange
Icons

Arranges any minimised edit windows.

Editor

Allows you to Select the edit window corresponding to the
named object.
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Using the Editor

Creating a New Function

Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on the
screen with the name you have chosen displayed in the top border. The name is also
inserted in the function header and the cursor positioned to the right. The new win-
dow is automatically given the input focus.

Line-Numbers onloff

Try changing the line numbers setting by clicking on the Line Numbers option in the
Options menu. Note that line-numbering on/off is effective for all edit windows.

Adding Lines

Ifthe keyboard is in Insert mode, pressing Enter at the end of a line opens you a new
blank line under the current one and positions the cursor there ready for input. You
can also open a new blank line by pressing Ctrl+Shift+Insert (OP).

Ifthe cursor is at the end of the last line in the function, pressing Enter adds another
line even if the keyboard is in Replace mode.

Indenting Text

Dyalog APL allows you to insert leading spaces in lines of a function and (unless the
AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar or
the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to the
value of the TabStops parameter. If the AutoIndent parameter is set, new lines are
automatically indented the same amount as the preceding line.

Reformatting

The RD command (which by default is mapped to Keypad-Slash) reformats a func-
tion according to your AutoFormat and TabStops settings.

Deleting Lines

To delete a block of lines, select them by dragging the mouse or using the keyboard
and then press Delete or select Clear from the Edit menu. A quick way to delete the
current line without selecting it first is to press Ctrl+Delete (DK) or select Delete
Line from the Edit menu.
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Copying Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Ctrl+Insert or select Copy from the Edit menu. This action copies the selection
to the clipboard. Now position the input cursor where you wish to make the copy
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to duplicate a ragged block of text.

To copy text using drag-and-drop editing:

1. Select the text you want to move.

2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.

3. Release the mouse button to drop the text into place.

Moving Lines

Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Shift+Delete or select Cut from the Edit menu. This action copies the selection
to the clipboard and removes it. Now position the input cursor at the new location
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to move a ragged block of text.

To move text using drag-and-drop editing:

1. Select the text you want to move.

2. Point to the selected text and then press and hold down the left mouse but-
ton. When the drag-and-drop pointer appears, drag the cursor to a new loca-
tion.

3. Release the mouse button to drop the text into place.

Joining and Splitting Lines
To join a line to the previous one: select Insert mode; position the cursor on the first

character in the line; press Bksp.

To split a line: select Insert mode; position the cursor at the place you want it split;
press Return.

Toggling Localisation

The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of the name under the cursor. If the name is currently global, pressing Ctrl+Up causes
the name to be added to the list of locals in the function header. If the name is already
localised, pressing Ctrl+Alt+] removes it from the header.
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Outlining

When you are editing a function, outlining identifies the blocks of code within con-
trol structures, and allows you to collapse and expand these blocks so that you can
focus your attention on particular parts of the code

The picture below shows the result of opening the function JSE.cbtop.TB_
POPUP.

)ed OSE.cbtop.TB_POPUP

[ Editor - [sSE.cbtop.TB_POPUP] =JoEs
b File Edit Refactor Window View I
A A X v b & *m *F *P

[o] I{FLAG}TE_POPUP MSE;TC

[1] fi Popup menu an 3ession ToolControl

[2] E :If 0=0ONGC'FLAG'

[3] E :If (2=52M3G) A Right mouse buttaon 7

[4] 'popup.captions 'OWS'Checked ' Showlaptions

[5] "popup.list 'OWS'Checked'['Flatlist '=5Stylel

[&] "popup.multiline ' OWS'Checked 'Multiline

[7] Opg ' popup’

el L :End

[91] iElse

[10] TC+'bandtbl.tb' 'bandtb2.tb' 'bandtb3.tb’' 'bandtbb.tb'
(111 @ :Select FLAG

[121 tCase 1

[13] ShowCaptions+~ShowCaptions

[14] TC OWS"='ShowCaptions' Showbaptions

[15] :Case 2

[16] Style«(1+'FlatList'=Stylel2'FlatList' 'FlatButtons'
[17] TC OWS"='Style'Style

[181] tCase 3

[19] MultilLines~Multiline

[20] TC OWS"c'Multiline ' Multiline

[21]

[2z2]1 | :End

[23] | :End

Function Last saved by: Dyadict 29 Ockober 1998 17:15 Paos: 0f24,1

Notice that the various control structure blocks are delineated by a treeview diagram.
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e When you hover the mouse pointer over one of the boxes that mark the
start of a block , the line marking the extent of that block becomes high-
lighted, as shown above.

e Ifyou click on a [ box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.

e Ifyou click on a I*| box, the corresponding section is expanded.

5 Editor - [oSE.cbtop. TB_POPUP] =Jo&d
F Ble Edit Refactor Window iew IR
A A X v 48 & *m*F *p

[0] I{FLAE}TB_POPUP M5G:TE

[1] fi Popup menu on Session ToolControl

[2] [ :If 0=0ONC'FLAG'

[31 H| PIf [(2=52M5G) A Right mouse button 9

(91 tElze

[10] TC+'bandtbl.tb' 'bandtb2.tb' 'bandtb3.tb' 'bandtblL.tb’
[11] = iSelect FLAG

[12] :Caze 1

[13] ShowCaptions+~ShowCaptions

[1u] TC OWS™='ShowCaptions'ShowCaptions

[15] iCase 2

[1&] Style«(1+'Flatlist '=Style)=2'Flatlist' 'FlatButtons'
[171] TC OWS™c'Style'Style

[18] :Caze 3

[19] MultiLines~Multiline

[20] TC OWS"='Multiline ' Multiline

[21]

221 | tEnd

(23] [ :End

Function Last saved by Dyadic: 22 October 1938 17:15 Pos: 0f24,1
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Sections

Functions and scripted objects (classes, namespaces etc.) can be subdivided into Sec-
tions with : Section and : EndSection statements. Both statements may be fol-
lowed by an optional and arbitrary name or description. The purpose is to split the
function up into sections that you can open and close in the Editor, thereby aiding
readability and code management. Sections have no effect on the execution of the
code, but must follow the nesting rules of other control structures.

The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmapand CopyToClipBoard.

The first picture shows the function with all sections closed.

5 Editor - [DumpWindow] mEx]

J Bl Edit Refactor Window Yiew -8 x
1A A X v |36 4 m*F %P

[o] DumpWindow ref:0OI0;0OML

[11] iSection Comments I

[&] tSection Init

[10] tSection MAs

[25] tSection MakeBitmap

[37] [H:5ection CopyToClipBoard

< 2]
Maodified Funckion Pete: 1711212010 Pos: 1/44,28
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The next picture shows the effect of opening the Comments section. Notice how this
is delineated by the statements:

:Section Comments

:EndSection Comments

2 Kditor - [DumpWindow] M=%
S Ele Edt Refactor Window Yiew - ax
M A A X v|db 4 *m °F *p

[o] DumpWindow ref:0OI0;0OML

[1] :Section Comments

[2] fi eg DumpWindow f A note unquoted name

[3] A Mote only the visible part of the window is dumped

[4] fi you may need to set 'OnTop' to ensure total window wisibility
[5] tEndSection Comments

[6] :Section Init

[10] tfection NAs

[25] [{ :Section MakeBitmap

[37] H:Section CopyToClipBoard

)] 2]
Modified Function Last saved by Pete: 17 December 2010 14:52 Pos: 0f44,0

And with the Init section opened too:

P Editor - [DumpWindow] M= <
Jib File Edt Refactor window View - a/x
1A A X v|dk A m*F P

[0] DumpWindow ref:OI0:0OML

[1] [ :3ection Comments

[2] A &g DumpWindow f A note unquoted name

[3] A Mote only the visible part of the window iz dumped

[4] A you may need to set 'OnTop' to ensure total window wisibility
[5] L :EndSection Comments

[6] E :Section Init

[7] OML OI0<0

[&] OSHADOWT (=" ref " )~=" "~ JQREFS=2031

[3] | :EndSection|

[10] [l :Section NAs

[25] [ :Section MakeBitmap

[37] [H:Section CopyToClipBoard

<] (2]
Modified Function Last saved by; Pete: 17 December 2010 14:52 Pos: 9/44,12
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Finally, with all the sections opened:

5 Editor - [DumpWindow]

M[EX]

S Bl Edi Refactor Window Yiew -8 x
1A A X ~| b 4 m *F *P

[0] Dumpindaw ref;OI0:OML -
[1] [ :3ection Comments

[2] A &g DumpWindow f A note unquoted name

[3] A Note only the visible part of the window iz dumped

[u] A you may need to szet 'OnTop' to ensure total window visibilim
[5] L :EndSection Comments

(6] E :Section Init

[7] ML OIo+«o0

[8] OSHADOWS (=" ref ") ~=" "~ LOREFS=0S5]

[9] | :EndSection

[10] [Fl :Section NAs

[11] ONA'UL user32|GetWindowDD UL »
[12] OMA' UL user3?|GetWindowRect Ub ={UL U4 UL UL} [
[13] ONA'UL user3Z?|ReleaseDC UL UL »
[14] OWA'UL user32|0penClipboard 1]t -
[15] OWA'UL user32|EmptyClipboard -
[16] OMA'UL user32|SetClipboardData UL Uy -
[17] OWA'UL user32|CloseClipboard -
[181] OMA'U4  gdi32|CreateCompatibleDl UL -
[19] OMA' U4 gdi32|CreateCompatibleBitmap UL UL UL [
[20] ONA'UY  gdi32|SelectObject Ub Uk -
[21] OM&'UL  gdi32|DeleteDt Uy -
[221] OMA' U4 gdi32|Delete0bject Ul 3
[23] OWA'UL gdi3z2|BitBLt b U U b U U U U e
[24] | :EndSection NaAs

[25] [ :Section MakeBitmap

[26] hund<ref.0OWE 'Handle'

[27] hdc+GetWindawll hwnd

[28] sze+t-—/2 2ploGetWindowRect hwnd(LpO)

[29] mdc+CreateCompatibleDC hdc

[30] hbm+CreateCompatibleBitmap hdc,sze

[31] old+SelectObject mdc hbm

[32] jnk+BitBLlt mdc © O,zze,hdc O 0 13369676 m SRCCPY

[33] jnk+SelectObject mdc old

[3L] jnk+ReleaszeDC hdc O

[35] jnk+DeleteDC mdc

[36] L :EndSection MakeBitmap

[37] iSection CopyToGlipBoard

raal ink<Onentlinhnard 0 had
4 >
Madified Function Last sawved by: Pete: 17 December 2010 14:52 Pos: 944,12
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Editing Classes

The picture below shows the result of opening the ComponentF i Le class. Notice
how each function is delineated separately and that each function is individually

line-numbered.

)ed ComponentFile

5 Editor - [ComponentFile] [Z]@
Bb File Edt Refactor window View -8 =
1A A X v 48 & *m *F *p
= [E0 #. ComponentFil I:E]ass ComponentFile -~
w3 [Constructar & tField Private Instance tie "l
oy [DEns] L3 tField Private instance temp+0 A Tek
2 .
+ﬂ:l[FIE]dS] (o] [ 7 Open filename
H 3‘:‘ [Methods] [1] f Open Mamed File
* 3‘:‘ [Nested Clas |[5] :Implements Constructor
#4) [Nested MNams| |[3] tAccess Public Instance
3% [Properties] |[L]
+ 4% [Sections] [s] = :Trap 0
[&] tie+filename OFSTIE 0
(71 tElze
(&l OFUNTIE filename OFCREATE 0O fm|
[9] tievfilename OFSTIE 0 e
(101l | tEndTrap
[111 7
(o] = 7 OpenTemp:;OUSING: =z
[1] fi Default: Open temporary file
[2] :Implements Constructor
[3] tAccess Public Instance
(Ll
[5] OUSIHG+""
[6] z+System. [0.Path.GetTempFileName
[7] z OMERASE =z OWTIE 0 A Erase the t»
[a] tie+z OFCREATE 0O
[91] temp+l
(101 7
[o] 7 Close
[1] tImplements Destructor
[2] tIf tiesOFMUME
[3] :If temp ¢ Name OFERASE tie
(L] tElse ¢ OFUNTIE tie
[s] tEndIf
[e] tEndlf
(71 7 )
B (2] % B
Class Pos: 0f111,0
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The outlining feature really comes into its own when editing classes because you can
collapse and expand whole functions. The picture below shows the effect of col-
lapsing all but the Append method.

5 Editor - [ComponentFile] g@
F Pl Edt Refactor window View -3 %
A A X | v |68 & M % %P
= [E #. ComponentFile kCclass ComponentFile
w8 [Constructors] Lo iField Private Instance tie
w1 [Dfns] & tField Private instance temp+0 »
w4 [Fields] .
[£] 0 fil
o [Methods] [ ¥ Open filename
Cl
#-81 [NBStEd C]EISSBS] 7 OpenTemp:DUSING:z
w4 [Nested Namespaces
w &' [Propertiss] 7 Cloze
w33 [Sections]
A --- Instance Methods ---
(o] 7 r+Append data
[1] tAccess Public Instance
[2] r+data OFAPPEND tie
(3] 7
7 Rename name
7 Replacelcomp datal
M --- Instance Properties ---
tProperty MName
:Property Count
:Property Access
tProperty Mumbered Default Com e
A --- Shared Members
7 Delete fileitie
tEndClasz A Class ComponentFile
(<] Im | [ )2 I | (]
Class Pos: 0f111,0
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When you edit a class, a separate treeview is optionally displayed in the left pane to
make it easy to navigate within the class. When you click on a name in the treeview,
the editor automatically scrolls the appropriate section into view (if necessary) and
positions the edit cursor at its start. The picture below illustrates the result of opening
the [Methods ] section and then clicking on Rename.

5 Editor - [ComponentFile]

M=%

b File Edt Refactor window View -9 %
1A A X v 46 8% *m *F *p
= EJ #.ComponentFile [9] L temp+1 |
+ 8% [Constructaors] [10] ¥
+ ﬂil [DFnS]
55 [Fields] [o] 7 Close
%l [Methods ] [1] :Imp]u?ments Destructor
[2] tIf ties0dFNUMS
£] Append [3] t1f temp © Name OFERAS »
£ Close [u] tElse o OFUNTIE tie
| Delete [5] SEndlf
a Rename [&] tEndIf
B Replace [7] ?
+3°1 [Nested Claszes]
543 [Nested MNamespaces A --- Instance Methods ---
L] .
¥ ﬂ:’ [PI"DP?I"'CIBS] [o] = ¥ r+Append data
#30 [Sections] [1] tAccess Public Instance
[2] r+data OFAPPEND tie
[3] L v
[a] [= 7 Rename name
[1] tAccess Public Instance
[2] name OFREMAME tie
[3] L v
[0] = v Replacelcomp datal
[1] tAccess Public Instance
[2] data OFREPLACE tie,comp
[3] L v
f --- Instance Propertiezs --»
tProperty Mame
tAccess Public Instance
[0] 7 r+get
[1] :If tiecsOFHUMS < r<0OFH »
[2] tElse @ r+'' o :EndIf
[3] 7 i
- tFndPranertw ) ,-v-
£ > )£ Ed
Class Pios; 450111,0
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Sections within Scripts

Scripts can also be subdivided into Sections using : Sectionand :EndSection
statements. As with single functions, the purpose is only to split the script up into sec-
tions that you can open and close in the Editor. Sections have no effect on the
execution of the code.

The following picture illustrates a Class named actuarial which, for editing pur-
poses, has been sub-divided into five separate Sections named Main,
MenuHandlers,Validation,Utilities and OldCode. In this picture, all
the Sections are closed.

5 Editor - [actuarial] g@
S Fle Edit Refactor Window  View -3 %
LA A X ~| b 40 | m *F %P
= ED #.actuarial :Class actuarial: Page
q
.45 [Constructors] tUsing System
.45 [Dfns] ilsing System.Web.Ul,system.web.dll
oot [Fields] :Us1lng System.Web.UI.HtmlControls
% [Methods] tlUsing System.Web. Ul . WebControls
T 3‘:' sthoas tUsing System.Data,system.data.dll
+ SI:I [Hested Classes] iAcceszz Public
+-40 [Nested Mamespaces]
4% [Properties] tSection Main
5985 [Sections] t3ection MenuHandlers
T Main Section Yalidatiaon
T MenuHandlers tSection Utilities
T OldCode tSection OldCode
o tEndClaszse
T Utilities
B Yalidation
< B
Class Paos: 0f1504,0
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The next picture shows the effect of opening just the Mai n section.

5P Editor - [actuarial]

ﬁﬁile Edit Refactor Window Wiew

A A X

BELX

- 46 84 | m *F P
[ |

- #.actuarial
+.#" [Constructors]
+.85 [Dfns]
w48 [Fields]
¥ [Methods]
+#% [Nested Classzes]
+-#% [Nested Mamespaces]
+-%% [Properties]
S.4% [Sectians]
T Main
T MenuHandlers
QldGode

i
B outilities
i3

F

Yalidation

Modified Class

iClass
tlUszing
ilUsing
tUsing
tlUszing
tUsing

(+H1]

[+H+]

actuar
System
System
System
System
System

ial: Page

MWeb Ul systemoweb.dll
Web.UI.HtmlControls
JWeb Ul WebControls
.Data,system.data.dll

tAccess Public

tSection Main

7 Page_Load; INT; AGE: DUR; TERM; TAB_DURM
7 CALC_FSLTABE_RESULTS(abj ew):®:ULT:m
7 CALC_FSL_RESULTS(obj ew);®;CHANGE;wm
tEndSection Main

53] tSection MenuHandlers

&} tSection Yalidation

&) iSection Utilities

53] tSection OldCaode
tEndClaszs

Pos: 445/1500,7

Notice that this section is delimited by the two statements:

:Section Main

:EndSection Main

In this picture the 3 functions within the Ma1i n section are temporarily closed.

Similarly, the section called Validation is delimited by:

:Section Validation

:EndSection Validation
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5P Editor - [actuarial]

S Fle Edt Refactor Window View - & x
- A A X ~| 46 40 | *m *F %P
S ED #.actuarial iClass actuarial: Page |
#3459 [Constructors] iUsing System
w45 [Dfns] tUsing System.Web. Ul,system.web.dll
ooa [Fields] :Using System.Web.UI.HtmlControls
% [Methode] tlUzing System.Web.UIl.WebControls
+ 3‘:‘ tUzing System.Data,system.data.dll
+-40 [Nested Classes] iAcce=s Public
+-4% [Nested Namespaces]
+%% [Properties] tSection Main
4% [Sections] :Section MenuHandlers
TMain :Section Yalidatiaon
? MenuHandlers
B 0ldCode [0l - 7 VYALIDATE_AGE(source args) m Yal »
Ued Lt [1] tAccess Public
7 Trities [2] :Signature YALIDATE_AGE Object ®
T Validation 121 =] tTrap ©
(L] AGE+Canwert.Tolnt32 args.Va »
[5] tElze
[6] args. IsYalid«0
[71] iReturn
[&8] | tEndTrap
[21] args.[sValid=(102AGE) ~B0zAGE
[10] | v
[0] =] 7 VALIDATE_DUR(source args):DT m
[11 tAccess Public
[2] tSignature YALIDATE_DUR Object
[3] =] tIf 2=GET_RUN_OPTIONM
(4] DT+1
[51 tElze 7
rea Pty TR

Modified Class

Pos: 0/1500,0
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Find and Replace Dialogs

The Find and Find/Replace dialog boxes are used to locate and modify text in an

Edit window.

-

Find / Replace

Search For: |

Find Mesxt

Feplace 'With: |

[v Match Caze

v Autobdove

[ Use Regular Expressions
Direction

& Up (¢ Down

El
j Beplace

[~ Match whole Ward Replace Al

diidl

Cloze

Search For

Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the drop-
down list. If appropriate, the search text is copied from the
Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the string in the functions.

Replace With

Enter the text string that you want to use as a replacement.
Note that the text from the last 10 replacements is available
from the drop-down list.

Match Case Check this box if you want the search to be case-sensitive.
Match Whole | Check this box if you want the search to only match whole
Word words.

Use Regular

Check this box if you want to use various wild card

Expressions symbols.
If checked, the Find or Find/Replace dialog box will
AutoMove automatically position itself so as not to obscure a matched
search string in the edit window.
Direction Select Up or Down to control the direction of search.
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Using Find and Replace

Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.

Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position the
cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The Find
Dialog box will appear on your screen with the input cursor positioned in the edit
box awaiting your input. Type "Adam" and click the Find Next button (or press
Return), and the cursor will locate the first occurrence. Clicking Find Next again will
locate the second occurrence. You can change the direction of the search by select-
ing Up instead of Down. You could search another function for "Adam" by opening
anew Edit window for it and clicking Find Next. You do not have to redefine the
search string.

Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find Dialog
box to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" into
the box labelled Replace With, then click Replace All. All occurrences of "Adam" in
the current Edit window are changed to "Amanda". To repeat the same global change
in another function, simply open an edit window and click Replace All again. If
instead you only want to change particular instances of "Adam" to "Amanda" you
may use Find Next to locate the ones you want, and then Replace to make each
individual alteration.

Saving and Quitting

To save the function and terminate the edit, press Esc (EP) or select Exit from the File
menu. The new version of the function replaces the previous one (if any) and the edit
window is destroyed.

Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the his-
tory is also retained, so you can subsequently undo some changes and fix the func-
tion again.

To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if any)
is unchanged.
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The Tracer

The Tracer is a visual debugging aid that allows you to step through an application
line by line. During a Trace you can track the path taken through your code, display
variables in edit windows and watch them change, skip forwards and backwards in a
function. You can cutback the stack to a calling function and use the Session and
Editor to experiment with and correct your code. The Tracer may be invoked in sev-
eral ways as discussed below.

Tracing an expression

Firstly, you may explicitly trace a function (strictly an expression) by typing an
expression then pressing Ctrl+Enter (TC) or by selecting Trace from the Action
menu. This lets you step through the execution of an expression from the beginning.

In the same way as when you execute a statement by pressing Enter, the expression is
(if necessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator,
execution halts at its first line and a Trace window containing the suspended func-
tion or operator is displayed on the screen. The cursor is positioned to the left of the
first line which is highlighted.

Naked Trace

The second way to invoke the Tracer is when you have a suspended function in the
State Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termed
naked trace. The same thing can be achieved by selecting Trace from the Action
menu on the Session Window or by clicking the Trace button in the Trace Tools.
However, in ALL cases it is essential that the input cursor is on the empty Input line
in the Session.

The effect of naked trace is to open the Tracer and to position the cursor on the cur-
rently suspended line. It is exactly as if you had Traced to that point from the Input
Line expression whose execution caused the suspension.

Automatic Trace

The third way to invoke the Tracer is to have the system do it automatically for you
whenever an error occurs. This is achieved by setting the Show trace stack on error
option in the Trace/Edit tab of the Configuration dialog (Trace_on_error param-
eter). When an error occurs, the system will automatically deploy the Tracer. Note
that this means that when an error occurs, the Trace window will then receive the
input focus and not the Session window.
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Tracer Options

From Version 10.1 onwards, the Tracer is designed to be docked in the Session win-
dow.

In previous versions of Dyalog APL, the Tracer was implemented as a stack of sep-
arate windows (one per function on the calling stack) or as a single, but still separate,
window.

You can disable the standard behaviour by selecting Classic Dyalog mode from the
Trace/Edit tab of the Configuration dialog box.

If you do so, you may then choose to have the Tracer operate in multiple windows or
in a single window.

These alternatives are discussed later in this Chapter.
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The Trace Window

The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current func-
tion calling stack; the second (Threads) displays a list of running threads.

In the default Session files, the Tracer is docked along the bottom edge of the Session
window. When you invoke the Tracer, it springs up as illustrated below. In this exam-
ple, the function being traced is JSE . UCMD, which is invoked by typing a user-com-
mand, in this case Jdisplay.

5 CLEAR WS (oSE)- Dyalog APLAWY =JoEd
Tools  Wiew

fws N OF 3] iotiec B EVEs V B bk B2 B 13 (Tool @ GF [ W Gede By @ o ox Session
Language Bar Pl =1 ﬁ
l\||||||E|||||\||f|l|||||¢||||>||?5|||||||T|+|C|||1|4>|°*’||||||||\f"|\|"|*|-ig

Dyalog APL/W Yersion 12.1.0
Serial Mo : 0000LZ
Unicode Edition
Mon Aug 17 10:28:20 2009
clear ws

ldisplay 113

P

Debugger =|Blx|
ST UMD P PZEXINHE ﬂ UCMD[1]1*m User Command Processar.
o
[o] ar+{THISIUCMD Input i
[1] /i User Command Processor.
[2] A Spice is used, see documentation for d »
[2]
[u] +(Input~.=" '1/0 A do nothing?
[5] =
[6] "SALT needs to be enabled'OSIGNAL 11p%9 » | =
[71 ar<0SE.SALTUti1s.Spice Input =
X
- 2 5
B 2| 5 =
Function johnd: 11f08)... Pos: 1/8,0 ol w
| Ready... Ins NUM
© CurObj: &:1 Opg:0  OTRAP  OSI:1  0OIO:=1 [OML:Q

In the default layout, the Sistack window is displayed alongside the main Tracer win-
dow, although this can be hidden or made to appear as a separate floating window, as
required.
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Trace Tools

The Tracer may be controlled from the keyboard, or by using the Trace Tools which
are arranged along the title bar of the Debugger window. Note that the button names
are solely for reference purposes in the description that follows.

Key

Button Name Code Keystroke Description
%r, Exec ER  Enter Executes the current line
3 Trace TC Ctrl+Enter Traces execution of the current
line
“ Back BK  Ctrl+Shift+Bksp Skips back one line
M Fwd FD  Ctrl+Shift+Enter Skips forward one line
> Restart RM -~{JLC Restarts execution of the current
thread, closing all its trace
windows
[> Restart all Restarts execution for all threads,
closing all trace windows
D> Continue BH Continues execution of the
current thread, leaving Trace
windows displayed
= Edit ED Shift+Enter Invokes the Editor
g Exit EP Esc Closes the Trace window, exits
the current function
| Intr Ctrl+Pause Interrupts execution
ﬂ Reset CS Clears all break-points (resets

OSTOP on every function)
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Using the Trace Tools, you can single-step through the function or operator by click-
ing the Exec and/or Trace buttons. If you click Exec the current line of the function
or operator is executed and the system halts at the next line. If you click Trace, the
current line is executed but any defined functions or operators referenced on that line
are themselves traced. After execution of the line the system again halts at the next
one. Using the keyboard, the same effect can be achieved by pressing Enter or
Ctrl+Enter.

The illustration below shows the state of execution having clicked Exec 6 times to
reach JSE.UCMD[7].

5 CLEAR WS (SE)- Dyalog APLAY =J2&d
Toaols  ‘iew

fws 20 3 ot BEVEs VB bk B B By Ton @ G b M Edt By @ o ou CSession
Language Bar P =1 1 ﬂ
l\||||||E|||||\||f|l|||||¢||||||¢|||||||*||||U|4>|*||||||||\f|\|||-iJ

Dyalog APLAW Yersion 12.1.0
Serial Mo @ 0000LZ
Unicode Edition
Mon Aug 17 10:28:20 2009
clear ws

ldisplay 113

b

Debugger =|olx|
ST UMD P PEXTE ﬂ UCMD[71+ar<0SE. SALTUt{1s.5Spice Inp
o
[o] ar+{THIS}IUCMD Input |
[1] A User Command Processor.
[2] A Spice i= used, see documentation for d »
[31]
[u] +(Input~.=' '1/0 A do nothing?
[5] —
[6] 'SALT needs to be enabled 'OSIGNAL 11p%3 » | =
[7] [ar+OSE.SALTUtil1s.Spice Input =
=
- =l & 5
4 2| & =
Function johnd: 11/08)... Pos: 7/8,0 (2] .<. 3| W
! Ready... Ins | HUM
{ Curdbj: 3:1 Opb@:o | OTRAP  OSI:1  OIO:1 | OML:0

Execution Reached [JSE .UCMD[ 7]

The next illustration shows the result of clicking Trace at this point. This caused the
system to trace into JSE.SaltUtils.Spice, the function called from
QOSeE.UCMD[71].

Notice how each function call on the stack is represented by an item in the Sistack
window.
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5 CLEAR WS (oSE.SALTUtiLs)- Dyalog APLAW (=1 ><
Tools  Wiew

fws O OF bl 3] objec BB Es V B b B @ 12 (700 @ G [ W Ed By B o o« Session
Language Bar Zleix| ﬁ

ll||\||IEI||||||f|l\||||¢||||||¢|||||||+|*|IIDI‘#ITI||||||||="|\|*‘\*|- o

Dyalog APL/W Yersion 12.1.0
Serial No @ 0000LZ
Unicode Edition
Mon Aug 17 10:28:20 2009
clear ws

ldisplay 1.3

b

Debugger ~=l=lx=|

ST UM Py PEXI b ﬁ Spicel[ll+m Handle KeyPress in SPIC
[z8] A ~ | UCMDL 7] ar+0SE.SALTUti1s.5pice Inp
[29] v =

[o] 7 {R}+Spice msgicmd;arg: listiiscifin®

[1] F Handle KeyPress in SPICE command w ®

[2] A The function can also be used dire » —

[3] Re 1 =

[u] tIf ~Quiet+isChar cmd+msg now E

[5] +04%"ER "'=32msg A Ente ® | 7

rel crde'T e lhf 15menl OWE ' Tavt A arah el D =
< » i 2
5 £ w =
Function johnd: 11/08/... Pos: 40/960,0 5] .<. »|| W
C o Ready... Ins  MHUM

Curlbj: &1 Opa:0  OTRAP | OSI:2  OIO0:1 | [OML:3

Execution Reached JSE.SALTUtils.Spice [1]
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The illustration below shows the state of execution having traced deeper into the sys-
tem.

§ CLEAR WS (sSE.SALT)- Dyalog APLAY =JoEd

File Edit Wew ‘Windows Session Log Action ©Options Tools Threads Help

fws D8 Gl 3] iotiec B EVEs V B bk B2 B £ Tool @ GF [ W Gede By @ o ox Session

Language Bar EEE] ﬁ
Ixfelleflefte] (MUr] [Fll<R =l M-FF] FHRORE [ell]] [P o
ldisplay 113 ~
Isi b |

OSE.SALT.Load[1]1+
OSE. SALTUti1s.BootSpice[17]
OSE.SALTUtils.Spice[18]
OSE.UCMD[7]
2

Debugger =|Blx|

ST UM P pPZEXI & ﬂ Load[1]+:Access Shared Public
o . .
[16] ref<#.0ONEW(Load cmd),hasargs/cargs Al BootSpice[17] OSE.SALT. Load ' SALTAP
[17] 7 b | Spice[18] :If 0=0ONC'OSE.cbbot.band
e UCMDL 7] ar<0SE.SALTUti1s.3pice Inp
[o] 7 {reF}+{protect}Load clasz:filezaTA®
[1] [tAccess Shared Public
[21] A This function returns either a ref » —
[3] fi or a message for anything else [(fam =
[u] tIf isHelp class E
[5] ref<'Load [pathlclassname’ '' 'Load » | &
a1 ref.oe'' 'Madifiare: " e = =
> = =]
Mamespace Pos: 118/872,0 ol .<. | W
| Ready... Ins NUM
© Cur(bj: &:1 Opa:o | OTRAP  O5I:4 | OIO:1 | 0OML:2

Execution reached four levels deep

At this stage, the State Indicator is as follows:

)SI
[OSE.SALT.Load[1]*
[OSE.SALTUtils.BootSpice[17]
OSE.SALTUtils.Spice[18]
(OSE.UCMD[7]
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Controlling Execution

The point of execution may be moved by clicking the Back and Fwd buttons in the
Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
State Indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.

You can cut back the stack by clicking the <EP> button in the Trace Tools window.
This causes execution to be suspended at the start of the line which was previously
traced. The same effect can be achieved using the keyboard by pressing Esc. It can
also be done by selecting Exit from the File menu on the Trace Window or by select-
ing Close from its system menu.

The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression »~[JL C. The <BH> button also continues execution, but
leaves the Trace window displayed and allows you to watch its progress.

Using the Session and the Editor

Whilst using the Tracer you can skip to the Session or to any Edit window and back
again. While it is docked, you may resize the Tracer pane by dragging its title bar,
and you may use the buttons provided to maximise, minimise and restore the Tracer
pane within the Session window.

Unless you move it sideways, the cursor is positioned to the left of the suspended
line in the top Trace window. If you press Shift+Enter (ED) with the cursor in this
position, the trace window becomes an edit window allowing you to edit the func-
tion or operator on top of the stack. You can achieve the same thing by selecting Edit
from the File menu, but the input cursor MUST again be in the left-most (empty) col-
umn, or the system will attempt to open an edit window for the name under the cur-
sor (point-and-edit).

When you finish editing, the window reverts to a trace window with the new def-
inition of the function or operator displayed.

You may also open a new edit window from within the Tracer using point-and-edit.

You can copy text from a trace window to the session for editing and execution or
for experimentation.

It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on a
different expression.
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Setting Break-Points

Break-points are defined by [JSTOP and may be toggled on and off in an Edit or
Trace window by clicking in the appropriate column. The example below illustrates
a function with a [JSTOP break-point set on line [5].

7 Editor - [BUILD_SESSION] =JoEd
[ Fle Edt Refactor window View R
1 A A X |8 Ah *m *F %P

[0] I{FILE}BUILD_SESSION LANG;OBJ:MSG;I:IIO.‘I:IML;OLD.‘NEH:MOTIFP_Al
[1] A Build the session object and save if desired L)
[2] :If 0=0ONC'MePrompt' ¢ NoPrompt<d < :EndIf

[2] tIf 0=OMC'FILE' ¢ FILE+'' ¢ :EndIlf

[u]

[5] 1 ] OWE+OSE.OW¥+1 < OML OIO+1 < OPATH+'#.Trans'

[&6] OPW+122 A allows room for Status Bar

[7] MOTIF+'M'=3=2t+". 'OWG ' APLYersion'

[&] M12+12<2o0YFI{ (" 1+ ' "I tw} 2ot

[3] LANG+upCase, LANG A translation assumes uppercase

[10] UNICODE+g80=[DR" '

[11] "Unkonwn language 'O5IGHAL{Trans.CODESe~cLANGI 411 )
<] B
Modified Function Lask saved by: Danb: 19 May 2009 11:42 Pos: 0J207,0

[0STOP break-points set or cleared in an Edit window are not established until the
function is fixed. JSTOP break-points set or cleared in a Trace window are estab-
lished immediately.

Clearing All Break-Points
K

You can clear all break-points by pressing the above button in the Trace Tools win-
dow. This in fact resets [JSTOP for all functions in the workspace.
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The Classic mode Tracer

If you select Classic Dyalog mode from the Trace/Edit tab in the Configuration
dialog box, the Tracer behaves in the same way as in Dyalog APL Version 8.2. How-
ever, the Tracer is not dockable in the Session.

Ifyou select the Classic mode Tracer, you may choose between multiple trace win-
dows or a single trace window using the Single Trace Window option.

Multiple Trace Windows

The following behaviour is obtained by deselecting the Single Trace Window
option.

Each function on the SI stack is represented by a separate trace window.
The top window contains the function that is currently executing, other win-
dows display functions further up the stack, in the order in which they were
called.

When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and dis-
plays the newly called function.

When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or typ-
ing Alt-F4, the top trace window disappears and the focus moves to the pre-
vious trace window

If you close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.

The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression »{JLC. The <CS> button also con-
tinues execution, but leaves the trace windows displayed and allows you to
watch their progress.

If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.



250 Dyalog APL/W User Guide

Single Trace Window

The following behaviour is obtained by selecting the Single Trace Window option.

The trace window contains a combo box whose drop-down displays the con-
tents of the SI stack. This box is not provided if there are multiple trace win-
dows.

The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.

When the last function in a traced suspension exits, the trace window dis-
appears.

If you click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.

Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (=) in the session window.

If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool

The Threads Tool is used to monitor and debug multi-threaded applications. To dis-
play the Threads Tool, select Show Threads Tool from the Session Threads menu, or
Threads from the Session pop-up menu.

ﬁThreads E]@
Tid Location State Flags | Treq || 2 [1002,
0: Aun =AUNCA3] OTGET... Session Mormal ﬂ 5
1: GUI SHOWCZZ2] ODQ'F! aon Paused
Z: Lift 1 GOTOC10] ODL .2 0O0OL Paused :

d: Lift 2 GOTOC10] ODL .2 0O0DL Paused =
5: HMHan 5 PERSOMC?] OTG... OTGET... Pauszed 52 =
G: Lady & PERSOMC?] OTG... OTGET... Paused 12 =
7: Han 7 PERSOMC4] Lif... OTGET... Paused 2 E
8: Lady 8 PERS0OMC4] Lif... OTGET... Paused 2 =
< 2| &

The above picture illustrates a situation using the LIFT.DWS workspace after execut-
ing the function RUN. The Pause on Error option was enabled and a Stop was set on
RUN[63]. When RUN suspended at this point, all other threads (1-8) were auto-
matically Paused. Note that all other threads happen to be Paused in the middle of
calls to system functions

The columns of the Threads Tool display the following information.

Column Description

Tid The Thread ID (OTID) and name (OTNAME) if set
Location The currently executing line of function code
State Indicates what the thread is doing. (see below)
Flags Normal or Paused.

Treq The Thread Requirements (OTREQ)
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Thread States
State Description
Pending Not yet running
Initializing Not yet running

Defined function Between lines of a defined function

Dynamic function | Between lines of a dynamic function

Indicates that the thread is suspended and is able to

Suspended accept input from the Session window.

Indicates that Session window is connected to this

Session
thread.

Indicates that the thread has no SI stack and the Session
(no stack) is connected to another thread. This state can only occur
for Thread 0.

Exiting About to be terminated

tHold Waiting fora :Hold token
:EndHold Waiting fora :Hold token

doL Executing (DL

H[p]e} Executing (JDQ

ONA Waiting for a DLL ([NA) call to return.
OTGET Executing OTGET, waiting for a token
OTGET

(Ready to continue) Executing JTGET, having got a token

OTSYNC Waiting for another thread to terminate

Indicates a thread that is associated with a NET system

Awaiting request .
g req thread, but is currently unused

Called .Net Waiting for a call to .NET to return.

Paused/Normal

In addition to the thread state as described above, a thread may be Paused or Normal
as shown in the Flags column. A Paused thread is one that has temporarily been
removed from the list of threads that are being scheduled by the thread scheduler. A
Paused thread is effectively frozen.
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Threads Tool Pop-Up Menu

Switch ko
Interrupt

Refresh Mow
v Hukbo Refresh

v Pause Threads on Error

v Paused
Pause Al
Resume Al
Restart All
Selecting this item causes APL to attempt to suspend (if
Switch to necessary) and switch to the selected thread, connecting
it to the Session and Debugger windows.
Refreshes the Threads Tool display to show the current
Refresh Now reaqs foo P ay W "

position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or

Error .
an interrupt.
This item toggles a thread between being Paused and
Paused Normal. It Pauses a Normal thread and resumes a
Paused thread.
Pause All This item causes all threads to be Paused.
Resume All This item resumes all threads.
Restart All This item resumes all Paused threads, restarts all

suspended threads, and closes the Debugger.
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Debugging Threads

The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other than
Thread 0. The following picture shows the Debugger open on a multi-threaded appli-
cation (LIFT.DWS) when only Thread 0 is suspended. This has been achieved by set-
ting a stop on RUN[63]

£ C:\Program Fi log APL 12.1 Unicode\ws\Kift - Dyalog APL/W m=[=|
Ble Edt Vew Windows Session Log Acion Ophons Tooks Theeads telp

s S E Y ober BB RV b b= @ bx oo Q) [ M [B v ca  Session B APLISUnicode v |[ 162

Language Bar EEE

|
FELEEeERE (Il FREEEEF ETR [l [lelelele] [FF]I| [olofefs] [(lel-fol[-F [f] & 2
Serial Ho i 000042 ~
Unicode Edition
Mon Aug 17 11:20:28 2009
clear we
C:\Program Files\Dyalog\Dyalog APL 12.1 Unicodelws\1ift saved Wed Mar 11 11:17:02 2009
Lift simulation designed to illustrate multi-threading
and thread synchronisation, using the Token Pool.
To run it:

RUN 20 m Simulate 20 arrivals

RUN 5
RUNL63]
v.
Debugger =lBlx|
FSTUPW D P IPEXNHN v|0h & [RUNLE31+OTGET 2[v ﬁ RUNL631+OTGET 2pJobDene A Ha
[56] OTGET GUIReady |
[57] F.LIFTI F.LIFT2 LIFT&"=FLOORS CAPAGITY n Start Lift threads
[58] tFar 1 tln ol A Start <N> people threads
[59] PERSONEFLOORS =
[60] oL 0.2x710 A Simulate randomfish) arrival E
[61] tEndFor =
[62] OTPUT Al1Done m Tell Lifts "that’s it" &
[63] io| [MTGET 2g7oblane A Wait until Lifts have Finished delivering men g
[64] OTKILL OTHUMS A Zap any threads =
vl| = .
2 5
< 2 |5 =
Function Last saved by: Dyalog: 09 July 2004 08:36 Pos: 63/£5,0 e > w
{ Ready... Ins | NUM

¢ Cur0bj: RUN (Functian) &:8 Opa:o  OTRAP  0O5I:1 QOI0:1 [OML:0
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In the next picture, the user has chosen to display the Threads Tool and then dock it
between the Session and Debugger windows. Note that only one thread, thread 0

(Run) is suspended. All the other threads are Paused (because Pause on Error is ena-
bled).

ﬁ C:\Program Files\Dyalog\Dyalog APL 12.1 Unicode'wsilift - Dyalog APLAY

[B|[=15% |

Ele Edit Yiew Windows Sesson Log Action Options Tools Threads Help
ws O DE I &) Gobie BB B V b B @ Teo C G B W Ear By ¥ Cu Session (B APLIBE Unicode v |[ TB[S
Language Bar ﬁ
(DAL= BEl Tz (MU [FRRER A[HEI0[4] [le]vln]<]] [ [eTef#l=l] [T o
RUN S ~
RUN[63] ]
il
Threads =T 1]
Tid Location State Flags | Treg
0: Run +RUN[63] OTGET 2pJobbone f Wai... Session Normal
1t GUI SHOW[22] ODQ'F' oo Paused
25 Lift 1 BOTO[10] ODL 0.2 ooL Paused
3+ Lift 2 BOTO[10] ODL 0.2 ooL Paused
S: Man 5 PERSON[?] OTBET Lift REACHED MYFLO... DOTGET (Ready to continue) Paused bl
6: Lady & PERSON[?] OTBET Lift REACHED MYFLO... DOTGET (Ready to continue) Paused L2
7t Man 7 PERSON[M] Lift<OTGET GoingUp OTGET (Ready to continue) Paused 2
8 Lady 8 PERSOM[4] Lift<OTGET GoingUp OTGET (Ready to continue) Paused 2
Debugger =lol=l
FSFTUPN D P PEZE X K v| o8 & |[RunTe31-OTRET 2w ﬁ RUN[631+0TEET 2pTobbone "W
561} OTEET EUIReady Al
5711 F.LIFT1 F.LIFT2 LIFT& <FLOORS CAPACITY a Start Lift threads
[sel; tFor I iIn ull n Start <N- peaple threads .
[59]: PERSONZFLOORS 5
[60]; OpL 0.2x710 A Simulate random(ish) arrival [r4
[61]1 :EndFor 5
621! OTFUT AllDone n Tell Lifts "that’s it" o]
[63] @ [DOTGET ZpJobbone R Wait until Lifts have finished delivering men =
[eu]! OTKILL OTNUMS n Zap any threads v | % _
< 3] &= 2
= =
Function Last sawed by: Dyalog: 09 July 2004 08:36 Pos: 63(65,0 N 3| @
Ready... Ins  HUM
CurObj: RUN [Functian) 2:8 Opg:0 | OTRAP | OSI:l  OIO:l  [ML:O
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The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)
which was Paused on PERSON[ 7] in the middle of a JTGET. The act of switching
to this thread caused it to be suspended at the beginning of'its current line PERSON
[7] and the Debugger now displays two Tabs to represent the two suspended
threads. Note that both the thread id and the thread name are displayed on the Tabs.

B C:Program Fi log APL 12.1 Unicodewslift - Dyalog APL/W (=]
Ble Edt Wew Windoms Sesson Log Action Options Tools Threads Help
s D EME Y o BB RV b = @ Too Q G) O Ed (B ) cu o Session B APLIGUnicode  |w|[ 16[2]
Language Bar el x| ﬁ
FEDEEERE [l FREEREER R0 [eof[=]] [Telelele) CEELLe] o[l FlREblleR] [f] & 2
MYFLOOR ~
m
)
Threads P =T}
Tid Location State Flags | Treq
0: Run  *RUN[63] OTGET 2pJobbone foWai... Suspended Paused
1: BUI sHow[22] Opa'F' ona Paused
2: Lift | GOTO[10] ODL 0.2 ooL Paused
3: Lift 2 GOTO[10) ODL 0.2 ooL Paused
5: Man 5 PERSON[7] OTGET Lift REACHED MYFLO... OTGET (Ready ta continue) Faused Wi
6: Lady 6 +PERSON[7] (TGET Lift REACHED MVFLO... Session Hormal
7: Man 7 PERSON[L] Lift+OTGET Goinglp .. OTGET (Ready to continus) Paused 2
8: Lady 8 PERSON[L] Lift<OTGET Goinglp ... OTGET (Ready to continus) Paused 2
Debugger =lolx
0: Run| 61 Lady 6 ﬂ PERSON[71+OTEET Lift REACHED MYFL
- o=
STUM PP PEXIN AR ~| 08 & ||PERSONTT1-0TGE|~| | 1
[3] ARRIVE m Arrive at 11Ft shaft | &
[u] Lift<OTEET Goingllp A Wait for 1ift door to be open/fres z
[5] Lift GETIN MYFLOOR=?FLOORS  n Get into the Lift, tell the 1ift where I/ »[ | §
[6] MYFLOOR OTPUT Lift.I10+Manln A Clear the Lift door for nsxt person P
[7] OTGET Lift REACHED MYFLOOR n Walt for Tift to reach my floor o
ral Lift GETOUT MYFLOOR n De-Lift =
[91¢ ¢ OTPUT Lift. [D+ManOut A Tell Lift [’m out, thread ends vl =
< 2| B 2
B 3
Function Last saved by: Dyalog: 02 July 2004 13:28 Pas: 7/10,0 o (¢ 5| 1D
| Ready... Ins | NUM
: CurObj: MYFLOOR [Variable) &:8 | OpQ:0 [OTRAP | Osl:2 OI0:1 [ML:0

Note also that the Session window is connected to the thread indicated by the
selected Tab. In this case, typing MYFLOOR into the Session window displays the
value of the local variable MYFLOOR in Thread 6 (Lady 6).
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You can use the Tabs to switch between the suspended threads, so clicking the Tab
labelled 0 : Run causes the display to change to the picture shown below. The Ses-
sion is now connected to Thread 0 (Run), so the value of [JLC is 63.

£ c:\Program Files\Dyalog\Dyalog APL 12.1 Unicodews\lift - Dyalog APLAY M=
Ble Edt View Windows Sesson Log Action Options Tols Threads Help
ws O DE I &) Gobie BB B V b B @ Teo C G B W Ear By ¥ Cu Session (B APLIBE Unicode v |[ TB[S

Language Bar Zle1x| ?

~ g
(DAL= BEl Tz (MU [FRRER AI0fL] []=[eo[=]] 3 2 i S Y 2 T
~

oLc
63
v
Threads =T 1]
Tid Location State Flags | Treg
0: Run +RUN[63] OTGET 2pJobbone f Wai... Session Normal
1t GUI SHOW[22] ODQ'F' oo Paused
25 Lift 1 BOTO[10] ODL 0.2 ooL Paused
3+ Lift 2 BOTO[10] ODL 0.2 ooL Paused
S: Man 5 PERSON[?] OTBET Lift REACHED MYFLO... DOTGET (Ready to continue) Paused bl
6: Lady & +PERSON[7] OTGET Lift REACHED MYFLO... Suspended Normal
7t Man 7 PERSON[W] Lift+OTGET GoingUp ... OTGET (Ready to continue) Paused 2
8: Lady & PERSON[4] Lift<OTGET GoingUp ... OTGET (Ready to continue) Paused 2
Debugger ~=lol=l
0 Run |6: Lady 6 ﬂ RUN[631+OTRET 2pToblone n W
o
STUM PP PEXN AN ~ A% 8 [ Runlesl-OTeET [v| | 2
[56] | DOTGET GUIReady ~
[57] ¢ i F.LIFTL F.LIFT2 LIFT& cFLOORS CAPACITY R Start Lift threads =
[58] IE :For 1 :iln UN A Start <N> people threads =
1591 i PERSON&FLOORS P
[60] | oL 0.2x710 A Simulate random(ish) arrival 5
[61]; i | :EndFor =|| &
[62] | OTPUT AllDone A Tell Lifts "that’s it" v | x
<l 2 || &8 g
2 2
Function Last saved by: Dyalog: 09 July 2004 08:36 Pos! 63(65,0 D ¢ 3 i
Ready... Ins  HUM

Cur0bj: MYFLOOR (Yariable) &8 Op@:o OTRAP [OST:1  0OIO:1  [OML:O
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The Event Viewer

The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To dis-
play the Event Viewer, select Event Viewer from the Session Tools menu.

You can choose:

¢ which types of events you want to monitor
e which objects you want to monitor

ﬁ" Event Yiewer
Spy  Columns  Select  Options
Ohbject | Eventt ame | Parameters dction | EwentlD |
#F GotFocus 1] s
’F Mouzelp 45 05208206 2510 ] 53
#F MouzeDbIChck 4505208206 2510 ] B0
’F Mouzelp 45 05208206 2510 ] 1
’F Configure 11.58854198 2. 8320312, ®HFOO B2
’F Configure 11.58854198 2. 8320412, #FOO B4
#F Configure 11658854198 2832012, #FOO GG
’F Configure 1158854198 2832012, #FOO B3
’F Configure 11.58854198 2. 8320312, ®HFOO 70
’F Configure 11.58854198 2. 8320412, #FOO 72
#F Configure 11658854198 2832012, #FOO 74
’F Configure 1158854198 2832012, #FOO 76
’F Configure 11.58854198 2. 8320312, ®HFOO 7a
’F Configure 11.58854198 2. 8320412, #FOO a0
HF LostFocus 0 a2

In the example illustrated above, the user has chosen to monitor events on a Form
# . F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,
MouseDbIClick and Configure events. Notice that there is a callback #. FOO
attached to the Configure event.
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The Spy Menu

Close
lzar

LY
Az Queued
Snapshaok

Stop Logging

The Spy menu, illustrated above, provides the following options and actions.

Close: Closes the Event Viewer

Clears all of the event information that is currently

lear: . .
Clear displayed in the Event Viewer.

In this mode all the events are displayed in the Event
All: Viewer as they occur, whether or not there is an action
associated with them.

In this mode only events that have associated actions
are displayed in the event viewer. Note that KeyPress

As Queued:
Q events are always queued and therefore always appear,
even if there is no associated action.
In this mode the Event Viewer displays a snapshot of
the internal event queue. Only those events that are
SnapShot: 4 y

currently in the internal APL event queue waiting to be
processed are displayed.

Stop Logging: When checked, this item switches event logging off.
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The Columns Menu

v Dbject

v Ewventhlame
Eventiurnber

v Parameters

W Ackion
ThreadID
MQed

v EwventID

The Columns menu allows you to choose which information is displayed for the
events you are monitoring.

Object

If checked, this item displays the name of the object on
which the event occurred.

Event Name

If checked, this item displays the name of the event that
occurred.

Event Number

If checked, this item displays the event number of the
event that occurred.

If checked, this item displays the parameters for the

Parameters event that occurred. These are the items that would be
passed in the argument to a callback function.
If checked, this item displays the action associated with

Action the event, for example the name of a callback function,
or an expression to be executed.

Thread ID ?f chec.;ked, this item displays the thread id of the thread
in which the event occurred
If checked, this item displays 0 or 1 according to

Nged whether or not the event occurred naturally or was
generated programmatically by [ONQ.

Event ID If checked, this item displays the event id of the event

that occurred. This id is used internally.
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The Select Menu

Select Matching Events
Select All Events On This Object
Select All Events OF This Type

The Select menu allows you to highlight certain events in the Event Viewer. For
example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.

Highlights all the events that have the same Object and
Event Name (or Event Number) as the currently selected
event.

Select Matching
Events

Select All Events | Highlights all the events that have the same Object as
On This Object the currently selected event.

Select All Events | Highlights all the events that have the same Event
Of This Type Name (or Event Number) as the currently selected event

These items are also available from the pop-up menu that appears when you press the
right mouse button over an event displayed in the Event Viewer window.

The Options Menu

v Always on Top
v Lse AFPL Faont

Sektings...

The Options menu allows you to choose which information is displayed for the
events you are monitoring.

If checked, this item causes the Event Viewer window to
Always on Top be displayed above all other windows (including other
application windows).

If checked, this item causes the information displayed in
the Event Viewer window to be displayed using the
Use APL font APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings... Displays the Event Viewer Options Dialog Box.
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Options Dialog Box

The Event Viewer Options dialog box allows you to select the objects and events
that you wish to monitor.

-

Event YWiewer Options

Options ]

Events to view: Objects to view:
Name [ Dfa] FindToot &9 Select Fram List...
M ouzelowmn 1 L4
Mouselp 2 M ame:
Mousetove 3
M ouzeClick 4 Type:
MouseDbIClick [}

M ouseE nter E .
Mouseleave 7 ThreadiD:
b ousetwbieel a
DiragQwer 10 Handle:
DragDrop 11
DragStart 12 p
Draglisttove 15 B Pl Db e
DiraglistCopy 16 ; ;
KepDown 20 [~ Child Objects
Keylp 21
KepPressz 22 [ Same Thread
K.eyError 23 ¥

T Select Al T || A Dbe

E event(s] selected

Events to view

The list box shows all the events that are support by the Dyalog APL GUI and
allows you to select which events are to be monitored. Only those events that are
selected will be reported. You can sort the events by name or by event number by
clicking the appropriate column header.
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Objects to view

All Objects

If checked, this item enables event reporting on all
Dyalog APL GUI objects.

Objects of Type

If checked, this item activates the adjoining Select
button and disables all other Object selection
mechanisms. Clicking the Select button brings up a
dialog box that allows you to choose which types of
Dyalog APL GUI objects you want to monitor.

Find Tool

This tool allows you to choose a single specific Dyalog
APL GUI object that you want to monitor. To use it,
drag the Find Tool and move it over your Dyalog APL
GUI objects. As you drag it, the individual objects are
highlighted and their details displayed in the Name,
Type, Thread ID and Handle fields. Drop the Find Tool
on the object of your choice.

Select

Clicking this button brings up a dialog box that
displays the entire Dyalog APL GUI structure as a tree
view. You can choose a single object by selecting it.
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The Session Object

Purpose: The Session object [JSE is a special system object that represents
the session window and acts as a parent for the session menus, tool
bar(s) and status bar.

Children Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties  Type, Caption, Posn, Size, File, Coord, State, Event, FontObyj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods ChooseFont, FileRead, FileWrite
Events Close, Create, FontOK, FontCancel, WorkspaceLoaded

Description

There is one (and only one) object of type Session and it is called JSE. You may use
OWG,OWS and OWN to perform operations on [JSE, but you cannot expunge it with
[EX nor can you recreate it using [JWC. You may however expunge all its children.
This will result in a bare session with no menu bar, tool bar or status bar.

[JSE is loaded from a session file when APL starts. The name of the session file is
specified by the session_file parameter. If no session file is defined, JSE will have no
children and the session will be devoid of menu bar, tool bar and status bar com-
ponents.

You may use all of the standard GUI system functions to build or configure the com-
ponents of the Session to your own requirements. Y ou may also control the Session
by changing certain of its properties.

Note that the Session reports a Create event when APL is first started, and a Work-
spaceLoaded event when a workspace is loaded or on a clear ws.
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Read-Only Properties
The following properties of JSE are read-only and may not be set using [JWS:
Type A character vector containing 'Session'
. A character vector containing the current caption in the title bar
Caption . .
of the Session window.
TextSize Reports the bounding rectangle for a text string. For a full

description, see TextSize in Object Reference.

A character vector containing the name of the current object.
CurObj This is the name under or immediately to the left of the input
Ccursor.

A 2-element integer vector containing the position of the input
cursor (row and column number) in the session log. This is JI0
CurPos dependent. If JIO is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). IFQIO0 is 0, its value would be (0 0).

A character vector which identifies the namespace from which
the current expression was executed. If the system is not

CurSpace executing code, CurSpace is the current space and is equivalent
to the result of ' '[INS "' *.
Handle The window handle of the Session window.

A vector of character vectors containing the most recent set of
Log lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.

A vector of character vectors containing the most recent set of
Input input statements (lines that you have executed) contained in the
input history buffer.

A vector of character vectors containing the types of object that

ChildList .
can be created as a child of [JSE.
MethodList A vector of chfaracter Yectors containing the names of the
methods associated with (JSE.
. A vector of character vectors containing the names of the events
EventList
generated by [JSE
. A vector of character vectors containing the names of the
PropList

properties associated with [JSE.
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Read/Write Properties

The following properties of [JSE may be changed using OWS:

Coord

Specifies the co-ordinate system for the session window.

Data

May be used to associate arbitrary data with the session object
OSE.

Event

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

File

The full pathname of the session file that is associated with the
current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

FontObj

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.

HintObj

Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
“Ready...” when APL is waiting for input.

Popup

A character vector that specifies the name of a popup menu to be
displayed when you click the right mouse button in a Session
window.

Posn

A 2-element numeric vector containing the position of the top-left
corner of the session window relative to the top-left comner of the
screen. This is reported and set in units specified by the Coord

property.

Size

A 2-element numeric vector containing the height and width of the
session window expressed in units specified by the Coord property.
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An integer that specifies the window state (O=normal,
I=minimised, 2=maximised). You may wish to use this property to
State minimise and later restore the session under program control. If you
save your session with State set to 2, your APL session will start
off maximised.

Specifies the name of the object in which tips are displayed. Unless
you specify TipObj individually for session components, this
object will be used to display the tips associated with all of the
menu items, buttons, and so forth in the session.

TipObj

XRange | See Object Reference

YRange | See Object Reference

Configuring the Session

As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the fol-
lowing:

You may select a different APL font or character size.

You may alter the appearance of the menus by changing the Caption properties of
the various Menu and Menultem objects. For example, you may prefer the menus to
appear in your own language.

You may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part of
the Edit menu.

You may add new Menu and Menultem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the [JSE namespace so that it is remains available when you
switch from one workspace to another.

You may add other objects to the tool bar to allow you to provide input for your func-
tions or to display output. For example, you may display a Combo object that offers
you a selection of names applicable to a particular task.

You may add additional toolbars.

You may remove objects too; for example, you can remove fields from the StatusBar
or even delete it entirely. Indeed, you may dispense with the menu bar and/or tool
bar as well.
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This section illustrates how you can configure your session using worked examples.
The examples are by no means exhaustive, but are designed to demonstrate the prin-
ciples. Please note that the structure and names of the objects used in these examples
may not be identical to your default session as supplied. Before you attempt to
change your session, please check the structure and the object names using JWN and
[OWG. The supplied session was created using the function BUILD SESSION in the
workspace BUILDSE. If you wish to make substantial changes to your session, you
may find it most convenient to edit the functions in this workspace, re-run BUILD
SESSION, and then save it.

Please note that these examples assume that Expose Session Properties is enabled.

Changing the Font

The APL session font is defined by the Font property of JSE. To change the font per-
manently, you should select a different Font and/or size of Font using the combo and
spinner boxes on the Session toolbar, and save your Session.

Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but it
is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come in
two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may select
other sizes, so long as the height is a multiple of 16 or 22. The scaling is performed
automatically by Windows.

Changing Menu Appearance

The name of the Session MenuBar is [SE . mb". To simplify the specification of
object names, we will first change space to the MenuBar itself:

)CS [OSE.mb
OSE.mb

The names of the Menu objects owned by the MenuBar are given by the expression:

‘Menu' [OWN "'
file edit view windows session Llog action options
tools help

The current caption on the file menu is:

file.Caption
&File

To change the Caption to Workspace:
file.Caption<«'Workspace'
To change the colour of the New option in the File menu to red:

file.clear.FCol«255 0 O
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Reorganising the Menu Structure

This example shows how you may alter the structure of the session menus by adding
a Search menu to the menu bar to provide access to the Find and Find/Replace
dialog boxes and removing these options from the Edit menu.

To simplify the process, we will first change space into the MenuBar object itself:

)CS [SE.mb
(OSE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at posi-
tion 3 (after Edit).

'search'DWC 'Menu' '&Search' 3

Next we will remove the Find and Replace Menultem objects from the Edif menu.
Their names can be obtained from [JWN:

‘MenuItem'[OWN'edit’
edit.prev edit.next edit.clear edit.copy edit.paste
edit.find edit.replace

It is worth noting that these Menultems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace] respec-
tively when they are selected.

edit.find.Event
Select [Find]

edit.replace.Event
Select [Replacel

The following statement removes them from the Edit menu:
OEX"'edit.find' 'edit.replace'’
and the following statements add them to the Search menu:

'search.find' OWC 'Menultem' '&Find'
('Event' 'Select' '[Find]"')
‘search.replace' OWC 'Menultem' '&Replace’
('Event' 'Select' '[Replace]')

Adding your own Menultem

This example shows how you can add a menu item that executes an APL expression.
In this case we will do something very simple; namely add a Time option to the
Tools menu which will execute (JTS. Notice that the statement also defines a Hint.
This will be displayed when you select the option, prior to releasing the mouse but-
ton to action it.
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Once again, we will start by changing space into the 7ools menu itself

)CS [SE.mb.tools
OSE.mb.tools

Then we will define a new Menultem to perform the action we require:

"ts'OWC'Menultem' '&Time'
('Event' 'Select' '¢[TS"')
('Hint' 'Display Timestamp')

The ¢ symbol is very important and distinguishes an expression to be executed imme-
diately, as in this case, from a callback function. The resulting 7ools menu now
appears as follows:

Explarer...
Search...
Skatus...

v AukoSkakus
Event Viewer

Time
A customised Tools menu

Selecting Time produces the following output in the session:

2007 12 10 17 10 2 O

Adding your own Tool Button

This example shows how you can add a button to the session tool bar that executes
an APL function.

The example function we will use is called XREF. This function analyses another
function, listing the sub-functions that it calls. Instead of returning a result, this exam-
ple displays the sub-functions in a Form.
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vV XREF FN;REFS

[1] :If O<pFN

[2] :AndIf 3=[NC FN

[3] REFS<REFS FN

[4] REFS<«(3=[NC REFS)#REFS

[5] REFS<«(4REFS)~""

[6] REFS<«REFS~cFN

[7] :If O<pREFS

[8] 'F'OWC'Form' ('Functions called by ',FN)
[9] F.FontObj<«[JSE.FontObj

[10] "F.L'OWC'List"REFS(0 0)(100 100)
[11] :EndIf

[12] :EndIf

To make this function available from a Session tool button, we need to do a number
of'things.

Firstly, we must install the function in [JSE so that it is always there, regardless of the
current active workspace. This is easily achieved using the Explorer or [INS.

'OSE' ONS 'XREF'

Secondly, we need to find another way to specify its argument FN. One possibility
would be to display a dialog box, asking the user to specify the name of the function
to be analysed. A neater solution is to use the CurObj property of JSE which reports
the name under the cursor. Using CurObj, the user can simply place the cursor over
the name of the function to be analysed, and then click the XREF tool button.

To get FN from CurObj, all we need to do is to change the header and lines 1-2 to:

[o0] XREF;FN;REFS
[1] :If 0<pFN<«[SE.CurObj
[2] :AndIf 3=[INC FN<[JSE.CurSpace,'."',FN

Notice that the function name reported by CurObj is prefixed by its pathname which
comes from the CurSpace property. This reports the user’s current namespace.

Next we will add a new button to the tool bar in the Tools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard text
button:

)CS OSE.cbtop.bandtb3.tb
OSE.cbtop.bandtb3.tb

'xref' [OWC 'Button' 'XREF'
"'xref' [OWS 'Event' 'Select' 'e[JSE.XREF'

Tool % (G B4 3 XREF|

Adding a tool button
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User Commands

Dyalog APL includes a mechanism to define User Commands.

User commands are developer tools, written in APL, which can be executed without
having to explicitly copy code into your workspace and/or save it in every work-
space in which you want to use it.

A User Command is a name prefixed by a closing square bracket, which may be nila-
dic or take an argument. A User Command executes APL code that is typically stored
somewhere outside the current active workspace.

By default, the existing SPICE command processor is hooked up to the user com-
mand mechanism, and a number of new SPICE commands have been added. For
example:

ldisplay 'hello' (5'world")

7
hello| {w
o

£0~—9

-€

The implementation of User Commands is very simple: If a line of input begins with
a closing square bracket (]), and there exists a function by the name [JSE . UCMD,
then the interpreter will call that function, passing the input line (without the
bracket) as the right argument.

To add a user command, drop a new Spice command file in the folder SALT\Spice.
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APL Files

Introduction

Most languages store programs and data separately. APL is unusual in that it allows
you to store programs and data together in a workspace.

This can be inefficient if your dataset gets very large; when your workspace is
loaded, you are loading ALL of your data, whether you need it or not.

It also makes it difficult for other users to access your data, particularly if you want
them to be able to update it.

In these circumstances, you must extract your data from your workspace, and write it
to a file on disk, thus separating your data from your program. There are many dif-
ferent kinds of file format. This section is concemed with the APL Component File
system which preserves the idea that your data consists of APL objects; hence you
can only access this type of file from within APL

The Component File system has a set of system functions through which you access
the file. Although this means that you have to learn a whole new set of functions in
order to use files, you will find that they provide you with a very powerful mech-
anism to control access to your data.
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Component Files

Overview

A component file is a data file maintained by Dyalog APL. It contains a series of
APL arrays known as components which are accessed by reference to their relative
position or component number within the file. Component files are just like other
data files and there are no special restrictions imposed on names or sizes.

A set of system functions is supplied to perform a range of file operations. These pro-
vide facilities to create or delete files, and to read and write components. Facilities
are also provided for multi-user access, including the capability to determine who
may do what, and file locking for concurrent updates.

Tying and Untying Files

To access an existing component file it must be tied, i.e. opened for use. The tie may
be exclusive (single-user access) or shared (multi-user access). A file is untied, i.e.
closed, using JFUNTIE oron terminating Dyalog APL. File ties survive ) LOAD,
[JLOAD and ) CLEAR operations.

Tie Numbers

A file is tied by associating a file name with a tie number. Tie numbers are integers
in the range 1 - 2147483647 and, you can supply one explicitly, or have the inter-
preter allocate the next available one by specifying 0. The system functions which
tie files return the tie number as a ‘shy’ result.

Creating and Removing Files

A component file is created using [JF CREATE which automatically ties the file for
exclusive use. A newly created file is empty, i.e. contains 0 components. A file is
removed with [JF ERASE, although it must be exclusively tied to do so.

Adding and Removing Components

Components are added to a file using JF APPEND and removed using [JFDROP. Com-
ponent numbers are allocated consecutively starting at 1. Thus a new component
added by [JF APPEND is given a component number which is one greater that that of
the last component in the file. Components may be removed from the beginning or
end of'the file, but not from the middle. Component numbers are therefore con-
tiguous.



Chapter 3: APL Files 275

Reading and Writing Components

Components are read using [JFREAD and overwritten using [JFREPLACE. There are
no restrictions on the size or type of array which may replace an existing component.
Components are accessed by component number, and may be read or overwritten at
random.

Component Information

In addition to the data held in a component, the user ID that wrote it and the time at
which it was written is also recorded. This control information is useful in providing
an audit trail and in facilitating partial backups of components that have changed.

Multi-User Access

OF STIE ties a file for shared (i.e. multi-user) access. This kind of access would be
appropriate for a multi-user UNIX system, a network of single user PCs, or multiple
APL tasks under Microsoft Windows.

(F HOLD provides the means for the user to temporarily prevent other co-operating
users from accessing one or more files. This is necessary to allow a single logical
update involving more than one component, and perhaps more than one file, to be
completed without interference from another user. JF HOLD is applicable to External
Variables as well as Component Files

File Access Control

There are two levels of file access control. As a regular data file, the operating system
read/write controls for owner and other users apply. In addition, Dyalog APL man-
ages its own access controls using the access matrix. This is an integer matrix with 3
columns and any number of rows. Column 1 contains user numbers, column 2 an
encoding of permitted file operations, and column 3 passnumbers. Each row specifies
which file operations may be performed by which user(s) with which passnumber.

User Number

This is a number which is defined by the aplnid parameter. If you intend to use Dya-
log APL’s access matrix to control file access in a multi-user environment, it is desir-
able to allocate to each user, a distinct user number. However, if you intend to rely
on under-lying operating system controls, allocating a user number of 0 to everyone
is more appropriate. A user number of 0 (which is the installation default), causes
APL to circumvent the access matrix mechanism described below.
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Permission Code

This is an integer representation of a Boolean mask. Each bit in the mask indicates
whether or not a particular file operation is permitted as follows:

Bit No.

15(14113]|12(11)10(9(8|7|6|5|4|3]|2]|1

File Access
A A R R ) O N R N Operation Code

‘ L—— OFREAD 1
OFTIE 2
OFERASE 4
OF APPEND 8
OFREPLACE 16
OFDROP 32
OFRENAME 128
OFRDCI 512
OFRESIZE 1024
QOFHOLD 2048
OFRDAC 4096
OFSTAC 8192
OFHIST 16384

For example, if bits 1, 4 and 6 are set and all other relevant bits are zero only
OFREAD,OF APPEND and [JF DROP are permitted. A convenient way to set up the
mask is to sum the access codes associated with each operation.

For example, the value 41 (1+8+32) authorises JFREAD, JF APPEND and (JF DROP.
A value of 1 (all bits set) permits all operations. Thus by subtracting the access
codes of operations to be forbidden, it is possible to permit all but certain types of
access. For example, a value of "133 (T1- 4+128) permits all operations except
[F ERASE and [JFRENAME. Note that the value of unused bits is ignored. Any non-
zero permission code allows JF STIE and OFSIZE.OFCREATE,OFUNTIE,JFLIB,
[OF NAMES and [JF NUMS are not subject to access control. Passnumbers may also be
used to establish different levels of access for the same user.

When the user attempts to tie a file using F TIE or JF STIE a row of the access
matrix is selected to control this and subsequent operations.

Ifthe user is the owner, and the owner's user ID does not appear in the access matrix,
the value (JAI[1] ~1 0)isconceptually appended to the access matrix. This
ensures that the owner has full access rights unless they are explicitly restricted.
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The chosen row is the first row in which the value in column 1 of the access matrix
matches the user ID and the value in column 3 matches the supplied passnumber
which is taken to be zero if omitted.

If there is no match of user ID and passnumber in the access matrix (including implic-
itly added rows) then no access is granted and the tie fails with a FILE ACCESS
ERROR.

Once the applicable row of the access matrix is selected, it is used to verify all sub-
sequent file operations. The passnumber used to tie the file MUST be used for every
subsequent operation. Secondly, the appropriate bit in the permission code cor-
responding to the file operation in question must be set. If either of these conditions
is broken, the operation will fail with FILE ACCESS ERROR.

If the access matrix is changed while a user has the file tied, the change takes imme-
diate effect. When the user next attempts to access the file, the applicable row in the
access matrix will be reselected subject to the supplied passnumber being the same as
that used to tie the file. If access with that password is rescinded the operation will
fail with FILE ACCESS ERROR.

When a file is created using JF CREATE, the access matrix is empty. At this stage, the
owner has full access with passnumber 0, but no access with a non-zero passnumber.
Other users have no access permissions. Thus only the owner may initialise the
access matrix.

User 0

If a user has an aplnid of 0, the access matrix and supplied passnumbers are ignored.
This user is granted full and unrestricted access rights to all component files, subject
only to underlying operating system restrictions.

General File Operations

(FLIB gives a list of component files in a given directory. JFNAMES and (JF NUMS
give a list of the names and tie numbers of tied files. These general operations which
apply to more than one file are not subject to access controls.
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Component File System Functions

See Language Reference for full details of the syntax of these system functions.

General

OFAVAIL Report file system availability
File Operations

OFCREATE Create a file

OFTIE Tie an existing file (exclusive)
OFSTIE Tie an existing file (shared)
OFUNTIE Untie file(s)

gdrcorPy Copy a file

OFERASE Erase a file

OFRENAME Rename a file

File information

OFHIST Report file events

OF NUMS Report tie numbers of tied files
OFNAMES Report names of tied files
gFLIB Report names of component files
OFPROPS Report file properties

OFSIZE Report size of file

Writing to the file

OFAPPEND

Append a component to the file

OFREPLACE

Replace an existing component

Reading from a file

OFREAD

Read one or more components

OFRDCI

Read component information
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Manipulating a file

(FDROP Drop a block of components
OFRESIZE Change file size (forces a compaction)
OF CHK Check and repair a file

Access manipulation

OFSTAC Set file access matrix

[OFRDAC Read file access matrix

Control multi-user access

(FHOLD Hold file(s) - see later section for details

Using the Component File System

Let us suppose that you have written an APL system that builds a personnel data-
base, containing the name, age and place of birth of each employee. Let us assume
that you have created a variable DATA, which is a nested vector with each element
containing a person's name, age and place of birth:

DISPLAY 21DATA

Then the following APL expressions can be used to access the database:

Example 1:
Show record 2

DISPLAY 2>5DATA

Example 2:
How many people in the database?

pDATA
123
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Example 3:
Update Pauline's age

(2 2oDATA)<«16
Example 4:

Add a new record to the database
DATA ,« c'Maurice' 18 'London'
Now let's build a component file to hold our personnel database.

Create a new file, giving the file name, and the number you wish to use to identify it
(the file tie number):

'COMPFILE' [JFCREATE 1

Ifthe file already exists, or you have already used this tie number, then APL will
respond with the appropriate error message.

Now write the data to the file. We could write a function that loops to do this, but it
is neater to take advantage of the fact that our data is a nested vector, and use each

).
DATA OFAPPEND™ 1

Now we'll try our previous examples using this file.

Example 1:
Show record 2

DISPLAY [FREAD 1 2

Example 2:
How many people in our database?

OFSIZE 1 A First component, next
1 125 10324 4294967295 A component, file size,
A maximum file size

“1+2o5[JFSIZE 1 A Number of data items

The fourth element of JF SIZE indicates the file size limit. Dyalog APL does not
impose a file size limit, although your operating system may do so, but the concept is
retained in order to make this version of Component Files compatible with others.
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Example 3:
Update Pauline's age
REC « [OFREAD 1 2 A Read second component
REC[2] « 18 A Change age
REC [OFREPLACE 1 2 A And replace component
Example 4:

Add a new record

('Janet' 25 'Basingstoke') [FAPPEND 1

Example 5:
Rename our file

"PERSONNEL "' [FRENAME 1

Example 6:

Tie an existing file; give file name and have the interpreter allocate the next avail-
able tie number.

"SALARIES' OFTIE O
2

Example 7:
Give everyone access to the PERSONNEL file
(1 3p0 ~1 O)OFSTAC 1

Example 8:
Set different permissions on SALARIES.

AM <« 1 3p1 "1 0 A Owner ID 1 has full access
AMs<« 102 1 O A User ID 102 has READ only
AM;« 210 2073 0 A User ID 210 has

A READ+APPEND+REPLACE+HOLD

AM [OFSTAC 2 A Store access matrix

Example 9:

Report on file names and associated numbers

OFNAMES ,[OF NUMS
PERSONNEL 1
SALARIES 2
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Example 10:
Untie all files
JFUNTIE [FNUMS

Programming Techniques

Controlling Multi-User Access

Obviously, Dyalog APL contains mechanisms that prevent data getting mixed up if
two users update a file at the same time. However, it is the programmer's respon-
sibility to control the logic of multi-user updates.

For example, suppose two people are updating our database at the same time. The
first checks to see if there is an entry for ' Geof f ', sees that there isn't so adds a new
record. Meanwhile, the second user is checking for the same thing, and so also adds a
record for ' Geof f '. Each user would be running code similar to that shown below:

Vv UPDATE;DATA;NAMES
[1] A Using the component file
[2] "PERSONNEL"' [FSTIE 1
[3] NAMES<>o[JFREAD ™ 1, 171+2>5[JFSIZE 1
(4] >ENDx1(c'Geoff')eNAMES
[5] ('Geoff' 41 'Hounslow')FAPPEND 1
[6] END:[JFUNTIE 1

\'4

The system function [JF HOLD provides the means for the user to temporarily prevent
other co-operating users from accessing one or more files. This is necessary to allow a
single logical update, perhaps involving more than one record or more than one file,
to be completed without interference from another user.
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The code above is replaced by that below:

VvV UPDATE ;DATA;NAMES

1] A Using the component file

2] 'PERSONNEL' [FSTIE 1

3] ([FHOLD 1

4] NAMES<«>0o[JFREAD ™ 1, 1~1+2>5[FSIZE 1
5] -ENDxi(c'Geoff')eNAMES

6] ('Geoff' 41 'Hounslow')[JFAPPEND 1
7] END:FUNTIE 1 ¢ [FHOLD 10

\'4

Lo B e B e B s N s N e N e |

Successive JF HOLDs on a file executed by different users are queued by Dyalog
APL; once the first JF HOLD is released, the next on the queue holds the file.

OF HOLDs are released by return to immediate execution, by JFHOLD 8, or by eras-
ing the external variable.

It is easy to misunderstand the effect of JF HOLD. It is NOT a file locking mechanism
that prevents other users from accessing the file. It only works if the tasks that wish to
access the file co-operate by queuing for access by issuing [JF HOLDs. It would be
very inefficient to issue a JFHOLD on a file then allow the user to interactively edit
the data with the hold in operation. What happens if he goes to lunch? Any other
user who wants to access the file and cooperates by issuing a JFHOLD would have to
wait in the queue for 3 hours until the first user returns, finishes his update and his

OF HOLD is released. It is usually more efficient (as well as more friendly) to issue

OF HOLDs around a small piece of critical code.

Suppose we had a control file associated with our personnel data base. This control
file could be an external variable, or a component file. In both cases, the concept is
the same; only the commands needed to access the file are different. In this example,
we will use a component file:

"CONTROL '[JFCREATE 1 A Create control file

(1 3p0 "1 0) OFSTAC 1 @A Allow everyone access

& OFAPPEND 1 A Set component 1 to empty
OFUNTIE 1 A And untie it
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Now we'll allow our man that likes long lunch breaks to edit the file, but will control
the hold in a more efficient way:

vV EDIT;CMP;CV
[1] A Share-tie the control file

[2] "CONTROL' [FSTIE 1
[3] A Share-tie the data file
[4] "PERSONNEL"' [FSTIE 2

[5] A Find out which component the user wants to edit
[6] ASK:CMP<ASKAWHICHARECORD

[7] A Hold the control file

[8] [(FHOLD 1

[9] A Read the control vector

[10] CV<[JFREAD 1 1

[11] a Make control vector as big as the data file
[12] CV«(~1+2>o[FSIZE 2)tCV

[13] nA Look at flag for this component

[14] >(FREE,INUSE)[1+CMP>CV]

[15] A In use - tell user and release hold

[16] 1INUSE:'Record in use' ¢ [JFHOLD & ¢ ->ASK

[17] A Ok to use - flag in-use and release hold
[18] FREE:CV[CMP]«1 o CV [JFREPLACE 1 1o [JFHOLD &
[19] @A Let user edit the record

[20] EDITARECORD RECORD

[21] @A When he's finished, clear the control vector
[22] OJFHOLD 1

[23] CV<[JFREAD 1 1 oCV[CMP]«0 ¢ CV [FREPLACE 1 1
[26] [(JFHOLD @&

[27] A And repeat

[28] -+ASK

v

Component 1 of our CONTROL file acts as a control vector. Its length is set equal to
the number of components in the PERSONNEL file, and an element is set to 1 ifa
user wishes to access the corresponding data component. Only the control file is ever
subject to a JFHOLD, and then only for a split-second, with no user inter-action
being performed whilst the hold is active.

When the first user runs the function, the relevant entry in the control vector will be
set to 1. If a second user accesses the database at the same time, he will have to wait
briefly whilst the control vector is updated. If he wants the same component as the
first user, he will be told that it is in use, and will be given the opportunity to edit
something else.

This simple mechanism allows us to lock the components of our file, rather the than
entire file. You can set up more informative control vectors than the one above; for
example, you could easily put the user name into the control vector and this would
enable you to tell the next user who is editing the component he is interested in.
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File Design

Our personnel database could be termed a record oriented system. All the infor-
mation relating to one person is easily obtained, and information relating to a new
person is easily added, but if we wish to find the oldest person, we have to read ALL
the records in the file.

It is sometimes more useful to have separate components, perhaps stored on separate
files, that hold indexes of the data fields that you may wish to search on. For exam-
ple, suppose we know that we always want to access our personnel database by
name. Then it would make sense to hold an index component of names:

A Extract name field from each data record
"PERSONNEL' [OFSTIE 1
NAMES<«>o[JFREAD"1, "1 ~1+2>5[FSIZE 2

A Create index file, and append NAMES
"INDEX' [FCREATE 2
NAMES [FAPPEND 2

Then if we want to find Pauline's data record:

NAMES<[JFREAD 2,1 A Read index of names
CMP<NAMESi1c'Pauline’ A Search for Pauline
DATA<[JFREAD 1,CMP A Read relevant record

There are many different ways to structure data files; you must design a structure that
is the most efficient for your application.

Internal Structure

If you are going to make a lot of use of APL files in your systems, it is useful for you
to have a rough idea of how Dyalog APL organises and manages the disk area used
by such files.

The internal structure of external variables and component files is the same, and the
examples given below apply to both.

Consider a component file with 3 components:

'"TEMP' [JFCREATE 1
'One' 'Two' 'Three' [FAPPEND™1

Dyalog APL will write these components onto contiguous areas of disk:

| One | Two | Three |
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Replace the second component with something the same size:
'Six' [OFREPLACE 1 2

This will fit into the area currently used by component 2.

If your system uses fixed length records, then the size of your components never
change, and the internal structure of the file remains static.

However, suppose we start replacing larger data objects:
'Bigger One' [FREPLACE 1 1

This will not fit into the area currently assigned to component 1, so it is appended to
the end of the file. Dyalog APL maintains internal tables which contain the location
of each component; hence, even though the components may not be physically
stored in order, they can always be accessed in order.

121 13l 1]

The area that was occupied by component 1 now becomes free.
Now we'll replace component 3 with something bigger:
'‘BigThree' [JFREPLACE 1 3

Component 3 is appended to the end of the file, and the area that was used before
becomes free:

Dyalog APL keeps tables of the size and location of the free areas, as well as the
actual location of your data. Now we'll replace component 2 with something bigger:

'BigTwo' [FREPLACE 1 2
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Free areas are used whenever possible, and contiguous holes are amalgamated.

You can see that if you are continually updating your file with larger data objects,
then the file structure can become fragmented. At any one time, the disk area occu-
pied by your file will be greater than the area necessary to hold your data. However,
free areas are constantly being reused, so that the amount of unused space in the file
will seldom exceed 30%.

Whenever you issue a monadic JFRESIZE command on a component file, Dyalog
APL COMPACTS the file; that is, it restructures it by reordering the components and
by amalgamating the free areas at the end of the file. It then truncates the file and
releases the disk space back to the operating system (note that some versions of
UNIX do not allow the space to be released). For a large file with many components,
this process may take a significant time.

Error Conditions
FILE SYSTEM NOT AVAILABLE

In a PC network, or in a single-processor Unix environment, if the FSCB file is miss-
ing or inaccessible (restricted access permissions) the report FILE SYSTEM NOT
AVAILABLE (Error code 28) will be given. The same error will occur under NFS if
the aplfscb "daemon" is not running.

FILE SYSTEM TIES USED UP

The FSCB file has a limited capacity and when that capacity is reached the report
FILE SYSTEM TIES USED UP (Error code 30) will be given.

FILE TIED

A FILE TIED errorisreported if you attempt to tie a file which another user has
exclusively tied. However, it is possible to get spurious FILE TIED errors in a net-
work for the following reason.

Ifan APL session has component files tied or has External Variables associated, and
terminates abnormally, the FSCB will continue to record the file ties, even though
the session is no longer running. To prevent another user (or even the same appli-
cation restarted) from getting spurious FILE TIED errors, APL checks whether the
process flagged as having a file tied is actually running. If not, the entry is cleared
and the new tie honoured.
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In a networked environment, it is not possible for a process running on one node to
check the status of a process running on another. If a node with component files tied
crashes, its file ties will remain (incorrectly) recorded in the FSCB until either that
node itself attempts to re-tie the files or until the FSCB is re-initialised.

Limitations
File Tie Quota

The File Tie Quota is the maximum number of files that a user may tie concurrently.
Dyalog APL itself allows a maximum of 256 under Unix and Windows, although in
either case your installation may impose a lower limit. When an attempt is made to
exceed this limit, the report FILE TIE QUOTA (Error code 31)is given. On a UNIX
system, there is a system-wide and a per-user limit on the number of open file descrip-
tors. On many systems, the per-user limit is 20, and the system-wide limit about 100.
Both limits are usually parameters specified when Unix is installed. Under Windows,
the maximum number of open files permitted is specified by the "FILES=" state-
ment in CONFIG.SYS.

File Name Quota

Dyalog APL records the names of each user's tied files in a buffer of 40960 bytes.
When this buffer is full, the report FILE NAME QUOTA USED UP (Error code 32)
will be given. This is only likely to occur if long pathnames are used to identify files.

The Effect of Buffering

Disk drives are fairly slow devices, so most operating systems take advantage ofa
facility called buffering. This is shown in simple terms below:

| Operating System | Sommm—me- . e niaiilel .
| instruction to |-->| BUFFER |--->| File on |
| write large data | --------- . | disk |
| object to a file |  —mmme—m—e- .

When you issue a write to a disk area, the data is not necessarily sent straight to the
disk. Sometimes it is written to an internal buffer (or cache), which is usually held in
(fast) main memory. When the buffer is full, the contents are passed to the disk. This
means that at any one time, you could have data in the buffer, as well as on the disk.
If you machine goes down whilst in this state, you could have a partially updated file
on the disk. In these circumstances, the operating system generally recovers your file
automatically.
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Ifthis facility is exploited, it offers very fast file updating. For systems that are I/O
bound, this is a very important consideration. However, the disadvantage is that
whilst it may appear that a write operation has completed successfully, part of the
data may still be residing in the buffer, waiting to be flushed out to the disk. It is
usually possible to force the buffer to empty; see your operating system manuals for
details (UNIX automatically invokes the sync () command every few seconds to
flush its internal buffers).

Dyalog APL exploits this facility, employing buffers internal to APL as well as mak-
ing use of the system buffers. Of course, these techniques cannot be used when the
file is shared with other users; obviously, the updates must be written immediately to
the disk. However, if the file is exclusively tied, then several layers of buffers are
employed to ensure that file access is as fast as possible.

You can ensure that the contents of all internal buffers are flushed to disk by issuing
OFUNTIE @ atany time.

Integrity and Security

The structure of component files, the asynchronous nature of the buffering performed
by APL, by the Operating System, and by the external device sub-system, introduces
the potential danger that a component file might become damaged. To prevent this
happening, the component file system includes optional journaling and check-sum
features. These are optional because the additional security these features provide
comes at the cost of reduced performance. You can choose the level of security that is
appropriate for your application.

When journaling is enabled (see [JF PROPS)), files are updated using a journal which
effectively prevents system or network failures from causing file damage.

Additional security is provided by the check sum facility which enables component
files to be repaired using the system function [JF CHK.

Level 1 journaling protects a component file from damage caused by an abnormal ter-
mination of the APL process. This could occur if the process is deliberately or acci-
dentally terminated by the user or by the Operating System, or by an error in Dyalog
APL.

Level 2 journaling provides protection not just against the possibility that the APL
process terminates abnormally, but that the Operating System itself fails. However, a
damaged component file must be explicitly repaired using the system function

OF CHK which will repair any damaged components by rolling them back to their pre-
vious states.
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Level 3 provides the same level of protection as Level 2, but following the abnormal
termination of either APL or the Operating System, the rollback of an incomplete
update will be automatic and no explicit repair will be needed.

Higher levels of Journaling inevitably reduce the performance of component file
updates.

For further information, see JFPROPS and [JF CHK.

Operating System Commands

APL files are treated as normal data files by the operating system, and may be manip-
ulated by any of'the standard operating system commands.

Do not use operating system commands to copy, erase or move component files that
are tied and in use by an APL session.
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Error Trapping

Error Trapping Concepts

The purpose of this section is to show some of the ways in which the ideas of error
trapping can be used to great effect to change the flow of control in a system.

Most APLs have error trapping facilities in one form or another, but this section dis-
cusses the facilities available to a Dyalog APL programmer.

First, we must have an idea of what is meant by error trapping. We are all used to
entering some duff APL code, and seeing a (sometimes) rather obscure, esoteric error
message echoed back:

10+0
DOMAIN ERROR
10+0

A

Now, these sorts of error messages are fine for us clever APL programmers, but mean-
ingless to most of our users. We need to find a way to bypass the default action of
APL, so that we can take an action of our own.

Every error message reported by Dyalog APL has a corresponding error number (for a
list of error codes and message, see JTRAP, Language Reference). Many of these
error numbers plus messages are common across all versions of APL. We can see that
the code for DOMAIN ERRORis 11, whilst LENGTH ERROR has code 5.

Dyalog APL provides two distinct but related mechanisms for the trapping and con-
trol of errors. The first is based on the control structure :Trap ... :EndTrap,
and the second, on the system variable JTRAP. The control structure is easier to
administer and so is recommended for normal use, while the system variable provides
slightly finer control and may be necessary for specialist applications.
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Last Error number and Diagnostic Message

Dyalog APL keeps a note of the last error that occurred, and provides this infor-
mation through system functions: JEN, JEM and [IDM.

10:0
DOMAIN ERROR
100

A

Error Number for last occurring error:

OEN
11

Error Message associated with code 11:

Oem 11
DOMAIN ERROR

[0OM (Diagnostic Message) is a 3 element nested vector containing error message,
expression and caret:

(oM
DOMAIN ERROR 100 A

Use function DISPLAY to show structure:
DISPLAY [IDM

DOMAIN ERROR 10+

|
o
>

€

Mix (1) of this vector produces a matrix that displays the same as the error message
produced by APL:

+0OM
DOMAIN ERROR
10+0

A
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Error Trapping Control Structure

You can embed a number of lines of code in a : Trap control structure within a
defined function.

[1] cen

[2] :Trap O

[3] e

(4] .

[5] :EndTrap

[6] cen

Now, whenever any error occurs in one of the enclosed lines, or in a function called
from one of the lines, processing stops immediately and control is transferred to the
line following the : EndTrap. The 0 argument to : Trap, in this case represents any
error. To trap only specific errors, you could use a vector of error numbers:

[2] :Trap 11 2 3

Notice that in this case, no extra lines are executed after an error. Control is passed to
line [ 6] either when an error has occurred, or if all the lines have been executed
without error. If you want to execute some code only after an error, you could re-code
the example like this:

[2] ;iéap 0

[5] :Else

[8] :EndTrap

Now, ifan error occurs in lines [ 3-4], (or in a function called from those lines), con-
trol will be passed immediately to the line following the : E L se statement. On the

other hand, ifall the lines between : Trap and : E L se complete successfully, con-
trol will pass out of the control structure to (in this case) line [9].
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The final refinement is that specific error cases can be accommodated using : Case
[L1ist] constructs in the same manner as the : Se Lect control structure.

[1] :Trap 17+121 A Component file errors.
[2] tie<name [ftie 0 A Try to tie file

[3] "OK'

[4] :Case 22

[5] 'Can''t find ',name

[6] :Caselist 25+113

[7] 'Resource Problem'

[8] :Else

[9] 'Unexpected Problem'

[10] :EndTrap
Note that : Trap can be used in conjunction with JSIGNAL described below.

Traps can be nested. In the following example, code in the inner trap structure
attempts to tie a component file, and if unsuccessful, tries to create one. In either case,
the tie number is then passed to function ProcessF i Le. Ifan error other than 22
(FILE NAME ERROR)occurs in the inner trap structure, or an error occurs in func-
tion ProcessF i Le (or any ofits called function), control passes to line imme-
diately to line [9].

[1] :Trap O

[2] :Trap 22

[3] tieename [ftie 0
[4] :Else

[5] tie<name [fcreate 0
[6] :EndTrap

[7] ProcessFile tie

[8] :Else

[9] ‘Unexpected Error'

[10] :EndTrap
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Trap System Variable: JTRAP

The second way of trapping errors is to use the system variable: JTRAP.

(OTRAP, can be assigned a nested vector of trap specifications. Each trap spec-
ification is itself a nested vector, of length 3, with each element defined as:

list of error

The error numbers we are interested in.
numbers

Either 'E"' (Execute) or 'C' (Cut Back). There are

action code
others, but they are seldom used.

APL expression, usually a branch statement or a call to

tion to be tak .
action to be taken an APL function.

So a single trap specification may be set up as:
OTRAP«<5 'E' 'ACTION1'
and a multiple trap specification as:

OTRAP«<(5 'E' 'ACTION1')((1 2 3) 'C' 'ACTION2')

The action code E tells APL that you want your action to be taken in the function in
which the error occurred, whereas the code C indicates that you want your action to
be taken in the function where the JTRAP was localised. If necessary, APL must
first travel back up the execution stack (cut-back) until it reaches that function.

Example Traps

These action codes are best illustrated by example.

Dividing by Zero
Let's try setting aJTRAP on DOMAIN ERROR:

MSG«'''Please give a non-zero right arg'''
OTRAP«11 'E' MSG

When we enter:
10+0
APL executes the expression, and notes that it causes an error number 11. Before issu-

ing the standard error, it scans its JTRAP table, to see if you were interested enough
in that error to set a trap; you were, so APL executes the action specified by you:

10+0
Please give non-zero right arg
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Let's reset our JTRAP:
OTRAP<0p[TRAP A No traps now set
and write a defined function to take the place of the primitive function +:

V R<A DIV B
[1] R<A+B
[2] v

Then run it:

10 DIV O
DOMAIN ERROR
DIV[1] R«A=B
A

Let's edit our function, and include a localised JTRAP:

vV R«A DIV B;[TRAP
[1] A Set the trap
[2] OTRAP«11 'E' '-ERR1'
[3] A Do the work; if it results in error 11,
[4] A execute the trap

[5] R<A+B
[6] A ALL OK if we got to here, so exit
(7] =0

[8] a Will get here only if error 11 occurred
[9] ERR1:'Please give a non-zero right arg'
\'4

Running the function with good and bad arguments has the desired effect:

10 DIV 2

10 DIV O
Please give a non-zero right arg

[TRAP is a variable like any other, and since it is localised in DIV, it is only effec-
tive in DIV and any other functions that may be called by DIV. So....

10+0
DOMAIN ERROR
10+0

A

still gives an error, since there is no trap set in the global environment.
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Other Errors

What happens to our function if we run it with other duff arguments:

123 DIV LK 5
LENGTH ERROR
DIV [4] R<«A=B
A

Here is an error that we have taken no account of.

Change DIV to take this new error into account:

V R«<A DIV B;[TRAP
[1] A Set the trap
[2] OTRAP«(11 'E' '-ERR1')(5 'E' '-ERR2')
[3] A Do the work; if it results in error 11,
[4] A execute the trap
[5] R<«A + B
[6] A ALL OK if we got to here, so exit
[7] -0
[8] na Will get here only if error 11 occurred
[9] ERRi:'Please give a non-zero right arg'e-0
[10] A Will get here only if error 5 occurred
[11] ERR2:'Arguments must be same length'
\4

JRESET

12 3DIV LS5
Arguments must be the same Llength

But here's yet another problem that we didn't think of:

(2 3p16) DIV (2 3 4pi2k)
RANK ERROR
DIV [4] R<A:B
A
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Global Traps

Often when we are writing a system, we can't think of everything that may go wrong
ahead of time; so we need a way of catching "everything else that I may not have
thought of". The error number used for "everything else" is zero:

JRESET
Set a global trap:

OTRAP « 0 'E' ' ''Invalid arguments'' '
And run the function:

(2 3p16) DIV (2 3 4pi2h)
Invalid arguments

In this case, when APL executed line 4 of our function DIV, it encountered an error
number 4 (RANK ERROR). It searched the local trap table, found nothing relating to
error 4, so searched further up the stack to see if the error was mentioned anywhere
else. It found an entry with an associated Execute code, so executed the appropriate
action AT THE POINT THAT THE ERROR OCCURRED. Let's see what's in the
stack:

)SI
DIV[4]x

+0DM
RANK ERROR
DIV[4] R<«A+B
A

So although our action has been taken, execution has stopped where it normally
would aftera RANK ERROR.

Dangers

We must be careful when we set global traps; let's call the non-existent function
BUG whenever we get an unexpected error:

JRESET
OTRAP « 0 'E' 'BUG'
(2 3p16) DIV (2 3 4pi2k)

Nothing happens, since APL traps a RANK ERROR on line 4 of DIV, so executes the
trap statement, which causes a VALUE ERROR, which activates the trap action,
which causes a VALUE ERROR, which .... etc. etc. If we had also chosen to trap on
1000 (ALL INTERRUPTS), then we'd be in trouble!
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Let's define a function BUG:

v

BUG

A Called whenever there is an unexpected error

"sxxx UNEXPECTED ERROR OCCURRED IN: ',o14[]SI

"xxx PLEASE CALL YOUR SYSTEM ADMINISTRATOR'

"xxx WORKSPACE SAVED AS BUG.',>1i[0SI

A Tidy up ... reset OLX, untie files ... etc

0OSAVE 'BUG.',>1i[0SI

"x*x%x LOGGING YOU OFF THE SYSTEM'

[oFF

Now, whenever we run our system and an unexpected error occurs, our BUG function
will be called.

Please

10 DIV O
give non-zero right arg

(2 3p16) DIV (2 3 4p112)

xx%x UNEXPECTED ERROR OCCURRED IN: DIV

xxkx PL

EASE CALL YOUR SYSTEM ADMINISTRATOR'

x%xx WORKSPACE SAVED AS BUG.DIV
xxx LOGGING YOU OFF THE SYSTEM'

The system administrator can then load BUG.DIV, look at the SI stack, discover the

problem, and

fix it.

Looking out for Specific Problems

In many cases, you can of course achieve the same effect of a trap by using APL code
to detect the problem before it happens. Consider the function TIEAFILE, which

checks to see

ifa file already exists before it tries to access it:

V R«<TIEAFILE FILE;FILES

[1] ~n
[2] =~
[3] ~n
[4]
[5] ~n
[6]
[7] =~
[8]

Tie file FILE with next available tie number

ALl files in my directory

FILES<OFLIB 'mydir'

Remove trailing blanks

FILES«dbr™4FILES

Required file in list?

+ERRx1~(cFILE)eFILES

Tie file with next number

FILE OFTIE R«1+[/0,0FNUMS
and exit

-0

Error message

ERR:R«'File does not exist'
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This function executes the same code whether the file name is right or wrong, and it
could take a while to get all the file names in your directory. It would be neater, and
more efficient to take action ONLY when the file name is wrong:

V R«TIEAFILE FILE;0TRAP

[1] A Tie file FILE with next available tie number
[2] n
[3] A Set trap

[4] OTRAP<«22 'E' '-ERR'

[5] A Tie file with next number
[6] FILE OFTIE R«1+[/0,[JFNUMS
[7] A ... and exit if OK

(8] =0

[9] A Error message

[10] ERR:R«'File does not exist'

Cut-Back versus Execute

Let us consider the effect of using Cut-Back instead of Execute. Consider the system
illustrated below, in which the function REPORT gives the user the option of 4
reports to be generated:

REPORT
|
| | | |
REP1 REP2 REP3 REPL
|
| | |
DIV

where REPORT looks something like this:
vV REPORT;OPTIONS;OPTION;[TRAP

[1] A Driver functions for report sub-system. If an
[2] ~A unexpected error occurs, take action in the
[3] @A function where the error occurred

(4] =n

[5] na Set global trap

[6] OTRAP<0 'E' 'BUG'

[7] ~n Available options

[8] OPTIONS<«'REP1' 'REP2' 'REP3' 'REPY4'
[9] A Ask user to choose

[10] LOOP:->ENDx10=pOPTION«<MENU OPTIONS
[11] A Execute relevant function

[12] &OPTION

[13] A Repeat until EXIT

[14] -LOOP

[15] A Now end

[16] END:
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Suppose the user chooses REP 3, and an unexpected error occurs in DIV. The good
news is that the System Administrator gets a snapshot copy of the workspace that he
can play about with:

)JLOAD BUG.DIV A Load workspace

)SI A Where did error occur?
DIV[4]x*
REP3[6]

&
REPORT([7]

+[JOM A What happened?
RANK ERROR
DIV[4] R<«A=B
A

v A Edit function on top of stack
[0]R<A DIV B

The bad news is, our user is locked out of the whole system, even though it may only
be REP3 that has a problem. We can get around this by making use of the CUT-
BACK action code.

V REPORT;OPTIONS;OPTION;[JTRAP
[1] A Driver functions for report sub-system. If an
[2] A unexpected error occurs, cut the stack back
[3] A to this function, then take action
[4] n
[5] A Set global trap
[6] OTRAP«O 'C' '-ERR'
[7] a Available options
[8] OPTIONS<«'REP1' 'REP2' 'REP3' 'REPY4'
[9] A Ask user to choose
[10] LOOP:->ENDx10=pOPTION«MENU OPTIONS
[11] A Execute relevant function
[12] <OPTION
[13] A Repeat until EXIT
[14] -LOOP
[15] A Tell user ...
[16] ERR:MESSAGE 'Unexpected error in',OPTION
[17] a ... what's happening
[18] MESSAGE'Removing from Llist'
[19] A Remove option from list
[20] OPTIONS<«~OPTIONS~cOPTION
[21] A And repeat
[22] -LOOP
[23] A End
[24] END:
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Suppose the user runs this version of REPORT and chooses REP 3. When the
unexpected error occurs in DIV, APL will check its trap specifications, and see that
the relevant trap was set in REPORT with a cut-back code. APL therefore cuts back
the stack to the function in which the trap was localised, THEN takes the specified
action. Looking at the SI stack above, we can see that APL must jump out of DIV,
then REP3,then ¢, to return to line 7 of REPORT; THEN it takes the specified
action.

Signalling Events

It would be useful to be able to employ the idea of cutting back the stack and taking
an alternative route through the code, when a condition other than an APL error
occurs. To achieve this, we must be able to trap on errors other than APL errors, and
we must be able to define these errors to APL. We do the former by using error codes
in the range 500 to 999, and the latter by using JSIGNAL.

Consider our system; ideally, when an unexpected error occurs, we want to save a
snapshot copy of our workspace (execute BUG in place), then immediately jump back
to REPORT and reduce our options. We can achieve this by changing our functions a
little, and using JSIGNAL:

vV REPORT;OPTIONS;OPTION;[TRAP
A Driver functions for report sub-system. If an
A unexpected error occurs, make a snapshot copy
A of the workspace, then cutback the stack to
A this function, reduce the option list & resume
A Set global trap
OTRAP«(500 'C' '-~ERR')(0 'E' 'BUG"')
A Available options
OPTIONS«'REP1' 'REP2' 'REP3' 'REPY4'
A Ask user to choose
LOOP : >ENDx10=pOPTION«MENU OPTIONS
A Execute relevant function
¢OPTION
A Repeat until EXIT
~LOOP
A Tell user ...
ERR:MESSAGE 'Unexpected error in',OPTION
A ... what's happening
MESSAGE 'Removing from Llist'
A Remove option from list
OPTIONS«OPTIONS~cOPTION
A And repeat
~LOOP
A End
END:

NNNNNNPFRP PP PR RPRRPRRERE e
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vV BUG
[1] A Called whenever there is an unexpected error
[2] "sxxx UNEXPECTED ERROR OCCURRED IN: ',o14[]SI
[3] "sxxx PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
[4] "xxx WORKSPACE SAVED AS BUG.',o14[]SI
[5] A Tidy up ... reset [LX, untie files ... etc
[6] OSAVE 'BUG.',o14[dSI
[7] "sxxx RETURNING TO DRIVER FOR RESELECTION'
[8] [OSIGNAL 500

Now when the unexpected error occurs, the first trap specification catches it, and the
BUG function is executed in place. Instead of logging the user off as before, an
error 500 issignalled to APL. APL checks its trap specifications, sees that 500
has been set in REPORT as a cut-back, so cuts back to REPORT before branching to
ERR.

Flow Control

Error handling, which employs a combination of all the system functions and var-
iables described, allows us to dynamically alter the flow of control through our sys-
tem, as well as allow us to handle errors gracefully. It is a very powerful facility,
which is simple to use, but is often neglected.
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Index

NET Classes
exploring 194

A

ActiveX control 46
ActiveXControl object 167
aedit User Command 97
APL files 273

APL fonts 268

APL_CODE_E _MAGNITUDE 11

APL COMPLEX AS V12 12
APL_EXTERN_DECF 13
APL_FAST FCHK 13
APL_FCREATE_PROPS C 12
APL_FCREATE_PROPS J 12
aplcore 14,17,54
aplcorename parameter 14, 54
aplk parameter 14,133
aplkeys parameter 14,133
aplnid parameter 14,275
APLScript compiler 42-43
aplt parameter 15, 134
apltrans parameter 15, 134
aplunicd.ini 47-48
Array Editor 33,97,122
assemblies

exploring 194
auto_pw parameter 15,92,142
AutoComplete 90

registry entries 31
AutoFormat parameter 15, 147
Autolndent parameter 15, 147
auxiliary processors 35

B

bridge dll 42-45,47
Browse .Net Assembly dialog box 195
Build runtime application 40

C

CancelKey (AutoComplete) parameter 150
charts

registry entries 31
class constructor 198
Classes

browsing 178
Classic Dyalog mode 241

multiple trace windows 249

single trace window 250
Classic Edition 10, 14,23,28,109, 115,125
ClassicMode parameter 16, 18-19,26-27, 146,
215
CloseAll system operation 110
CMD_POSTFIX parameter 16
CMD_PREFIX parameter 16
collapsing outlines 223,228,233
colour selection dialog 157
colours

registry entries 31
colourscheme parameter 128
Cols (AutoComplete) parameter 150
COM server

in-process 45

out-of-process 45
command line 8
command processor 35-36
CommandFolder parameter 153
CommonKey (AuotComplete) parameter 150
CompleteKey (AutoComplete) parameter 150
component files 274

access control 275

buffering 288

file design 285

internal structure 285

multi-user access 282



306 Dyalog APL/W User Guide

configuration dialog 127

et framework tab 156

autocomplete tab 149

general tab 127

help/dmx tab 137

input tab 133

keyboard shortcuts tab 135

log tab 143

object syntax tab 154

output tab 134

session tab 141

trace/edit tab 145

unicode input tab 130

user commands tab 153

windows tab 138

workspace tab 136
configuration parameters 9
configuring the session 267
confirm_abort parameter 16, 147
confirm_close parameter 16, 146
confirm_fix parameter 16, 146
confirm_session_delete parameter 16
Constructors folder 198
context menu 88
COPY system command 55
Create (session event) 264
Create bound file dialog 107
CreateAplcoreOnSyserror parameter 17
CreateAplCoreonSyserror parameter 58
creating executables 38
CurObj (session property) 65,265
CurPos (session property) 265
Current Object 65
CurSpace (session property) 265

D

Debugging Threads 254
default div parameter 17, 142
default io parameter 17,142
default ml parameter 17, 142
default pp parameter 17, 142
default pw parameter 18
default 1l parameter 18, 142

default_rtl parameter 18, 142
default wx parameter 18, 114,142,155
DefaultHelpCollection parameter 17,137
delay parameter 128
division method 17
DMXOUTPUTONERROR parameter 18,137
DockableEditWindows parameter 18, 146
Docking 83
DoubleClickEdit parameter 18, 147
Dyalog APL DLL 51
classes, instances and cloning 51
workspace management 52
dyalog dIl 42-43
dyalog parameter 10, 14,19
dyalog.chm 19
dyalog.exe.config 156
dyalog32 dll 49
DyalogEmailAddress parameter 19
DyalogHelpDir parameter 19
DyaloglnstallDir parameter 19
dyalognet dll 42-45,47
dyalogprovider dll 42-43
DyalogWebSite parameter 19

E

edit window geometry 19
edit_cols parameter 19,139,212,215
edit_first x parameter 19,215
edit_first y parameter 19, 139,215
edit_offset x parameter 20,139,212,216
edit_offset y parameter 20,139,212,216
edit_rows parameter 19,139,212,215
editor

class treeview 223,234

collapsing outlines 223

edit menu 220

editing classes 232

expanding outlines 223

file menu 218-219

function line numbers 223

invoking 211

outlining 223,227

refactor menu 222
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sections 235

toolbar 217

using 225

view menu 222

windows menu 224
EditorState parameter 20
Enabled (AutoComplete) parameter 149
endsection statement 229,235
Enums 193
environment variables 9-10
ErrorOnExternalException parameter 20
Event (session property) 266
Event Sets 192
event viewer

registry entries 31
executing expressions 91
execution (tracing) 247
exit codes 9, 14
expanding outlines 223,228,233
Export menu item 38
external variables

sharing 37

F

fchk system function 289
File (session property) 266
file extensions 1
file stack size parameter 128
files

registry entries 32
find and replace dialogs 238
Find Objects Tool 202
Font (session property) 266
function line numbers 223

G

GetEnvironment method 10
global assembly cache 44-45,47
greet_bitmap parameter 20

H

Handle (session property) 265

HintObj (session property) 266
History (AutoComplete) parameter 150
history size parameter 20, 144
HistorySize (AutoComplete) parameter 150
hot keys

syntax colouring 159

|

ILDASM 194

IME Configuration 67

index origin 17

inifile parameter 10,21, 128
InitialKeyboardLayout 21
InitialKeyboardLayout parameter 131
InitialKeyboardLayoutInUse parameter 21,
131

InitialKeyboardLayoutShowAll parameter 21,
131

Input (session property) 265

input codes 76

input line 89

input translate table 14

input_size parameter 21, 144

interface with Windows 35
Interoperability 4

interrupt 66

K

keyboard layout

line-drawing 74

traditional 73

unified 71
keyboard shortcuts 63,75

registry entries 33
KeyboardInputDelay parameter 149

L

language bar 90

registry entries 33
line-drawing characters 74
line numbers 223,225
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lines on_functions parameter 22, 128
localdyalogdir parameter 22

Log (session property) 265

log_file parameter 144

log_file inuse parameter 144
log_size parameter 22, 144

logfile parameter 22

logfileinuse parameter 22

M

mapchars parameter 23
maxws parameter 23,34,52-53,136
Metadata 194, 196
Methods folder 200
Microsoft Document Explorer 17
migration level 17
mouse
using in session 64

N

Net asembly 46
Net Classes 194
Net Metadata 183
New method 198

(0]

Object CoClasses 187
Object Properties
COM Properties tab 209
Monitor tab 208
Net Properties tab 210
Properties tab 206
Value tab 207
Objects 189
OLEClIient object 183,186
OLEServer object 167
outlining 223,227
output translate table 15
OverstrikesPopup parameter 24,132

P

page width 18,92
PassExceptionsToOpSys parameter 24,58
pfkey size parameter 24, 144
Popup (session property) 266
Posn (session property) 266
PrefixSize (AutoComplete) parameter 149
print configuration dialog 160
header/footer Tab 163
margins tab 162
printer tab 166
setup tab 160
print precision 17
printing
registry entries 33
private 198
programfolder parameter 24
Properties folder 199
PropertyExposeRoot parameter 24,114,155
PropertyExposeSE parameter 25, 114, 155

Q

gcmd timeout parameter 25
QUADNA workspace 49

R

random link 18
registry entries
run-time installation 49
ResolveOverstrikes parameter 25, 132
response time limit 18
return code 9
Rows (AutoComplete) parameter 149
run-time
applications 42
bound 44
stand-alone 43
workspace based 44
run-time applications 40
run-time dll 42-44, 46-47
run-time exe 42-45,49
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RunAsService parameter 25 session tools 124

tools tools 123

workspace tools 121

S session_file parameter 26, 64, 82,142,264
SALT 151 SessionOnTop parameter 26, 146
SharpPlot Graphics Tools 100

Show trace stack on error 240

ShowFiles (AutoComplete) parameter 150
ShowStatusOnError parameter 26
SingleTrace parameter 26-27, 146

registry entries 33
SaveContinueOnExit parameter 25
SaveLogOnEXxit parameter 25
SaveSessionOnExit parameter 25
section statement 229,235

Serial parameter 26 Size (session property) 266
session sm_cols parameter 26, 140
configuring 63,267 sm_rows parameter 26, 140
file menu 104 SPICE 151,272
help menu 117 sqapl.dll 47-48
options menu 114 sqapl.err 47-48
popup menu 118 sqapl.ini 47-48
session menu 111 State (session property) 267
status bar 125 Status window 83,167
status field styles 125 StatusOnEdit parameter 26, 146
threads menu 116 syntax colouring 158
toolsmenu 115 system error codes 55
value tips 93 system error dialog 24, 54,56
session action menu 112 system exceptions 55
session colour scheme 80 system operations 64,111,269
session log 82,89
session log menu 112 T
session menubar 104
action menu 112 TabStops parameter 15,26, 147
edit menu 109 Threads Tool 251
file Menu 104 TipObj (session property) 267
help menu 117 trace tools 243
log menu 112 trace window geometry 27
options menu 114 trace_cols parameter 27
session menu 111 trace_first x parameter 27,139
threads menu 116 trace_first y parameter 27,139
toolsmenu 115 Trace level wam parameter 27, 146
view menu 110 trace_offset x parameter 27,139
windows menu 110 trace_offset y parameter 27,139
session object 26,63,82, 111 Trace _on_error parameter 27, 146, 240
session statusfields 126 trace_rows parameter 27
session toolbars 120 tracer
edit tools 123 automatic trace 240

object tools 122 break-points 248



310 Dyalog APL/W User Guide

Classic Dyalog mode 241
controlling execution 247
invoking 240
naked trace 240
tracing an expression 240
TraceStopMonitor parameter 28
trap control structure 293
trap system variable 295
treeview 223,234
Type Libraries 175,183

U

underscored characters 71
Unicode and Classic Editions 2
Unicode Edition 10,21,24-25,28,125
UnicodeToClipboard parameter 28,147
URLHighlight parameter 128
UseDefaultHelpCollection parameter 28, 137
User Commands 272

aedit 97
UTIL workspace 37

\%

value tips 93
colourscheme parameter 128
delay parameter 128
registry entries 33
valuetips
registry entries 33
Version
binding version information 108
Version information
for a bound executable 41
view menu
editor 222
session) 110

W

WantsSpecialKeys parameter 28
window expose 18,155

windowrects

registryentries 33
workspace explorer

registry entries 31
workspace integrity check 54
workspace size 23, 34,52
WorkspaceLoaded (session event) 264
wspath parameter 28,36,49, 136

X

XPLookAndFeel parameter 28, 128
XPLookAndFeelDocker parameter 29, 128
XVAR function 37

Y

year 2000 compliance 29
yy_window parameter 29



